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2 InfoPrint  Manager  for  Windows:  Getting Started



Chapter  1.  About  this  publication  

This publication helps you install and begin using InfoPrint® Manager for the 

Windows® Operating System, hereafter called InfoPrint Manager for Windows. It 

also describes how to install and begin using the various client components that 

InfoPrint Manager uses to manage your printing environment. By applying the 

procedures and tasks in this publication, you can set up your minimum InfoPrint 

Manager environment to bring centralized control to your printing environment 

and help you maximize the capabilities of the printers you possess. This 

publication focuses primarily on server and client system software configuration, 

but it also includes information for the IBM® 4159 Model 001 S/390® Parallel 

Channel Emulator Card. 

Note: Only Windows 2000 examples are shown in this book. 

Who should read this publication 

This publication is for the administrator who installs and configures an InfoPrint 

Manager environment. You should have already planned for and prepared your 

system for the installation of InfoPrint Manager by performing the steps described 

in the book InfoPrint Manager for Windows: Introduction and Planning Guide, 

G544–5716. 

Most recent information 

For the most recent information about InfoPrint Manager, go to the InfoPrint 

Solutions Company Web site at http://www.infoprint.com: 

1.   Click Support and downloads. 

2.   Select your software product from the Software support pull-down list and 

click either InfoPrint Manager for AIX® or InfoPrint Manager for Windows. 

3.   Under Manuals and publications, click Manuals. 

4.   Click on the appropriate InfoPrint Manager publication.
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Chapter  2.  The  InfoPrint  publication  library  

For the most current information, see the InfoPrint Solutions Company Web site at 

http://www.infoprint.com 

InfoPrint Manager common publication library 

These publications are common to both InfoPrint Manager for AIX and InfoPrint 

Manager for Windows: 

v   InfoPrint Manager: SAP R/3 Planning and Configuration Guide, S550-1051. For print 

administrators who need to create and configure both the SAP R/3 environment. 

we recommend that users possess a detailed knowledge of a SAP R/3 

environment, as well as administering and maintaining either AIX or Windows 

operating systems. This publication describes how a business enterprise that 

uses SAP R/3 can use either InfoPrint Manager for AIX or InfoPrint Manager for 

Windows to manage its print environment. 

v   InfoPrint Manager: Reference, S550-1052. For print administrators, operators, and 

application programmers with the need to perform command-line functions. 

This publication describes the commands, utilities, transforms, attributes, and 

attribute values associated with InfoPrint. 

v   InfoPrint Manager: PSF and Server Messages, G550-1053. This publication lists the 

PSF and Server messages and explanations from InfoPrint Manager. 

v   InfoPrint Manager Print-on-Demand Feature: Submit Express User’s Guide, S544-5894. 

This publication is for the user who installs, configures, and uses Submit Express 

on a Windows or Macintosh workstation. Although you can use this publication 

for general guidance in using Submit Express, you should use the online Help to 

find more detailed instructions. 

v   InfoPrint Job Ticketer: Job Ticketer User’s Guide, S550-0419. This publication is a 

guide for using the InfoPrint Job Ticketer Web application. This guide provides 

descriptions of tasks and procedures that an end-user needs to know to set up 

their workstation to use the application, and then to create, layout, store, retrieve 

print jobs, and submit the jobs to a print server for printing. 

v   InfoPrint Job Ticketer: Administrator’s Guide, S550-0420. This publication is a guide 

for system administrators who are responsible for the InfoPrint Job Ticketer Web 

application. This guide provides information about the Job Ticketer system 

requirements, installation and configuration, system maintenance, security, and 

problem determination.

InfoPrint Manager for AIX publication library 

InfoPrint Manager for AIX includes publications in PDF format on a CD-ROM 

supplied with the product. You can also download PDF versions of these 

publications or order printed copies of these publications from the following Web 

site: 

http://www.elink.ibmlink.ibm.com/public/applications/publications/cgibin/pbi.cgi 

Note:  

1.   There is a fee for the printed manuals. 

2.   You can use the form number specified for a publication to download a PDF 

version or order a printed version.
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The publications for InfoPrint Manager for AIX are: 

v   InfoPrint Manager for AIX: Installation Instructions, G544-5891. This publication 

provides updated migration and installation information from the instructions 

available in the InfoPrint Manager for AIX: Getting Started manual. 

v   InfoPrint Manager for AIX: Introduction and Planning Guide, G544-5833. This 

publication gives an overview of InfoPrint Manager for AIX, introduces its 

concepts, and helps you prepare to use it. It addresses migration from previous 

versions of the product. Finally, this publication explains the differences between 

the AIX and Windows versions of InfoPrint. 

v   InfoPrint Manager for AIX: Getting Started, G544-5817. This publication helps you 

install and configure InfoPrint Manager for AIX. It focuses primarily on server 

and client system software configuration. 

v   InfoPrint Manager for AIX: Configuration and Tuning Guide, S544-5892. This 

publication provides information about configuring and tuning the InfoPrint 

Manager for AIX, Version 4.2. This book is designed for the InfoPrint Manager 

administrator who needs to understand the topics necessary to configure and 

tune an InfoPrint Manager system. It should help administrators to evaluate, 

develop, and maintain both a logical and hardware configuration for their 

environment. 

v   Guidelines for Installing InfoPrint Manager for AIX 4.2 in an HACMP Configuration, 

G544-5818. This publication helps you install and configure HACMP™ with 

InfoPrint Manager for AIX. It also tells you how to use HACMP with InfoPrint 

Manager for AIX. 

v   InfoPrint Manager for AIX: Using Generalized Fax, S544-5893. This publication 

describes the primary tasks necessary for configuring and using the Generalized 

Fax support that is included with InfoPrint Manager for AIX. This includes 

sending and receiving faxes from an InfoPrint Manager Server. 

v   InfoPrint Manager for AIX: Impositioning Assist, G544-5910. This publication 

describes how commercial print shops can use InfoPrint Manager for AIX to 

make frequent layout changes to signature-based documents with relatively 

static content. As a prerequisite, this solution requires the InfoPrint Manager for 

AIX: Print-On-Demand feature, an InfoPrint 4100 Advanced Function Printing™ 

System, and a third-party impositioning product, such as ScenicSoft Preps. 

v   InfoPrint Manager for AIX: Procedures, G544-5815. This publication describes the 

primary tasks necessary for setting up an InfoPrint environment, submitting 

print jobs, scheduling jobs, and managing the print environment. 

v   PSF Direct Network Configuration Guide for System/370™, S544-5486. For system 

administrators or network specialists responsible for configuring a system for 

Print Services Facility™ (PSF) Direct. PSF Direct is a function of InfoPrint 

Manager for AIX that allows a PSF program (PSF for z/OS®, PSF/390, PSF/400, 

PSF/MVS, PSF/VM, or PSF/VSE) to print remotely, using the SNA LU 6.2 

protocol, on printers supported by InfoPrint. The PSF program sends the print 

data stream directly to the InfoPrint printer. 

v   PSF for AIX: AFP Upload Configuration Guide Using SNA Server/6000, S544-5422. 

For system administrators, this publication describes how to configure AFP™ 

Upload on both AIX (client) and MVS™ (server) to send files to the JES spool on 

the MVS server, using a SNA LU 6.2 protocol. 

v   PSF for AIX: AFP Upload Configuration Guide Using TCP/IP, S544-5423. For system 

administrators, this publication describes how to configure AFP Upload on both 

AIX (client) and MVS (server) to send files to the JES spool on the MVS server, 

using a TCP/IP protocol.
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InfoPrint Manager for Windows publication library 

InfoPrint Manager for Windows includes publications in PDF format on a 

CD-ROM supplied with the product. You can download PDF versions of these 

publications or order printed copies of these publications from the following Web 

site: 

http://www.elink.ibmlink.ibm.com/public/applications/publications/cgibin/pbi.cgi 

Notes:  

1.   There is a fee for the printed manuals. 

2.   You can use the form number specified for a publication to download a PDF 

version or order a printed version.

The publications for InfoPrint Manager for Windows are: 

v   InfoPrint Manager for Windows: Introduction and Planning Guide, G544-5716. This 

publication gives an overview of InfoPrint Manager for Windows, introduces its 

concepts, and helps you prepare to use it. It describes features of this product 

and compares its functions to those of IBM Print Services Facility for OS/2® (PSF 

for OS/2). It addresses migration from PSF for OS/2 at a high level. Finally, this 

publication explains the differences between the AIX and Windows versions of 

InfoPrint. 

v   InfoPrint Manager for Windows: Getting Started, G550-1072. This publication helps 

you install and configure InfoPrint Manager for Windows. It focuses primarily 

on server and client system software configuration, but it also includes 

information for the IBM 4159 Model 001 S/390 Parallel Channel Emulator Card. 

v   InfoPrint Manager for Windows: Procedures, G544-5814. This publication describes 

the primary tasks necessary for setting up an InfoPrint environment, submitting 

print jobs, scheduling jobs, and managing the print environment.
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Part  2. Getting  started  with  server  systems  
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Chapter  3.  Preparing  to  install  InfoPrint  Manager  software  

Before you perform any of the steps documented in this publication, you must 

understand the general features and requirements of InfoPrint Manager for 

Windows. You can find this information in InfoPrint Manager for Windows: 

Introduction and Planning Guide, G544-5716. Consult this publication before 

proceeding with your installation. 

You should perform all network configuration before installing and configuring 

InfoPrint Manager. See “Configuring TCP/IP” for procedures for TCP/IP 

configuration. 

If you plan to use PSF Direct to print from remote host systems (such as MVS, 

iSeries®, or OS/390®), consult the PSF Direct Configuration Guides to establish 

communication between this Windows system and remote hosts. The PSF Direct 

Configuration Guides are available on your publications CD and on the World Wide 

Web at 

 http://www.elink.ibmlink.ibm.com/public/applications/publications/cgibin/pbi.cgi 

  

Note: When you use InfoPrint Manager for Windows to drive one or more 

high-speed printers, performance may be improved if you install it in a separate 

partition, on a separate hard drive, or with a SCSI drive. 

Configuring TCP/IP 

You may need to configure your Windows system to communicate with other 

computers or printers on one or more networks. The following worksheets are 

designed to help you with this configuration. 

Planning for a LAN connection 

First, connect your Windows systems to your local area network (LAN). You can 

perform this task when you install Windows or after you finish the installation. In 

either case, you may find it useful to complete the following worksheet ahead of 

time for each system that is new to your LAN. 

 Table 1. LAN TCP/IP configuration worksheet 

Control Panel Prompt Description Value 

Computer Name  The (NetBIOS) name of this 

computer on the Windows 

network. 

Domain/Workgroup The group of Windows 

computers to which this 

computer belongs. 

Adapter The physical card used to 

connect this system to the 

network. An appropriate 

driver for this card may  need 

to be added. 
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Table 1. LAN TCP/IP configuration worksheet (continued) 

Control Panel Prompt Description Value 

Obtain IP address from DHCP  

server? 

The Dynamic Host 

Configuration Protocol 

(DHCP)  provides a new IP 

address for this system each 

time it is restarted. If DHCP  is 

not in use, a static IP address 

must be assigned. 

__ yes __ no 

Note: It is strongly 

recommended that you 

specify no for DHCP.  

IP Address A dotted-decimal address (for 

example, 9.99.178.17) statically 

assigned to this system. Not  

needed if DHCP  is in use. 

Subnet Mask A dotted-decimal number (for 

example, 255.255.255.0) 

indicating which part of the IP 

address identifies the network 

and which part identifies the 

system. Not  needed if DHCP  

is in use. 

Default Gateway The system used by default to 

allow this network to 

communicate with other 

networks. Not  needed if 

DHCP  is in use. 

DNS  Host Name  The (Internet) name of this 

system recognized by the 

Domain Name  System (DNS). 

If possible, this name should 

be the same as the Windows 

computer name. 

DNS  Domain The Internet domain to which 

this computer belongs. 

DNS  Service Search Order An ordered list of IP 

addresses of DNS  servers. 

These systems are queried to 

resolve Internet names into IP 

addresses. 

Domain Suffix Search Order An ordered list of TCP/IP 

domains to search for a given 

host name. 

Primary WINS  Server The first Windows Internet 

Name  Service (WINS) system 

to query to resolve a Windows 

(NetBIOS) system name into 

an IP address. 

Secondary WINS  Server The second WINS  system to 

query. 

Enable DNS  for Windows 

Resolution? 

DNS  may  be used to resolve 

Windows (NetBIOS) names 

into IP addresses. 

__ yes __ no 

Enable LMHOSTS Lookup? LMHOSTS files statically 

associate Windows system 

names to IP addresses. 

__ yes __ no 
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Table 1. LAN TCP/IP configuration worksheet (continued) 

Control Panel Prompt Description Value 

Scope ID The set of IP addresses 

assignable for a Windows 

domain is a called a scope. 

Enable IP Forwarding? IP Forwarding allows data to 

be forwarded on a 

multi-homed system. 

__ yes __ no

  

Planning for a printer network connection 

You may wish to create a separate network of printers with higher bandwidth 

connectivity. In this case, you must configure an additional network adapter on 

each InfoPrint Manager for Windows server system that controls printers on the 

independent printer network. Use the following worksheet to assist in this 

configuration. For additional information about setting up a separate printer 

network, refer to the Administrator Procedure Using Multiple Network Adapter 

Cards. 

Note: This worksheet is specifically designed for use with Windows 2000 or 

Windows XP, but it will assist you in performing the necessary TCP/IP 

configuration on all Windows systems. 

 Table 2. Printer Network TCP/IP configuration worksheet 

Control Panel Prompt Description Value 

Adapter The physical card used to 

connect this system to the 

printer network. An 

appropriate driver for this 

card may  need to be added. 

IP Address A dotted-decimal address 

(for example, 9.99.178.17) 

statically assigned to this 

system on the printer 

network. Required for 

printer network 

participation. 

Subnet Mask A dotted-decimal number 

(for example, 255.255.255.0) 

indicating which part of the 

IP address identifies the 

network and which part 

identifies the system. 

Required for printer network 

participation. 

Default Gateway The printer network should 

not require communication 

with another network. All  

communication with the 

printers is mediated by 

InfoPrint Manager. 

none
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Server software prerequisites 

The primary software prerequisite for the InfoPrint Manager for Windows server 

software is one of the following Microsoft® operating systems: 

v   Windows 2000 Professional (Service Pack 4) 

v   Windows 2000 Server (Service Pack 4) 

v   Windows XP Professional (Service Pack 1 or higher) 

v   Windows Server 2003 Standard Edition

Note: Windows operating systems have strict limitations on the number of 

connections. Ensure that an adequate version of Windows is used on your 

InfoPrint Manager Server to meet your connection requirements. 

Before migrating to InfoPrint Manager 2.2 

If you are migrating from a previous level of InfoPrint Manager, it is strongly 

recommended that you back up your InfoPrint Manager for Windows install 

directories, any directories that have been moved out from under the install 

directory since the initial installation of the product, and the Windows registry. 

Directories that have been moved out from under the install directory can be 

identified through the InfoPrint Manager Management Console (Start → Programs → 

Infoprint Manager → Management Console). From the Management Console, go to 

Edit → Service Configuration.... Check all paths listed on the displayed panel to 

determine if any are not in the base install directory. Make note of any paths that 

are not in the base install directory. 

This backup is required if you want to remove the new version from your system 

and restore InfoPrint Manager to its previous state. 

Note: We suggest that you test the migration on a non-commercial system before 

installing it in a commercial environment. 

Backing up your InfoPrint Manager for Windows install 

directories 

To back up your system, complete these steps: 

1.   Stop job submissions to the InfoPrint Manager Server from all of your locations. 

2.   Complete printing all jobs, if possible, or delete them. 

3.   Close the InfoPrint Manager Administration and Operations GUIs, including 

those on your remote systems, if they are open. 

4.   Shut down the InfoPrint Manager Server. Using the InfoPrint Manager 

Management Console, go to File → Stop Server. 

5.   Clean up segment files. Using the InfoPrint Manager Management Console, go 

to Debug → Clean Up Leftover Input Manager Files, and close the 

Management Console. 

6.   Use your local backup procedures to backup the install directories, any 

directories that have been moved out from under the install directories, and the 

Windows registry. The following key and sub-keys must be restorable: 

HKEY_LOCAL_MACHINE\SOFTWARE\IBM\Infoprint Manager.
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Note: In a multi-server environment, all servers must be backed up and upgraded 

at the same time, including AIX servers. 

After migrating to InfoPrint Manager Version 2.2 

Once you have completed the installation, you can update your transform 

configuration files and migrate any desired optional features. 

The lpdmap.txt file included 

InfoPrint Manager for Windows now includes a lpdmap.txt file that is installed in 

install_path\var\pd\lpd. Before the file is installed, InfoPrint Manager makes a 

backup copy of the existing lpdmap.txt file. If you have modified your version of 

the lpdmap.txt file, you must merge the changes from the backup copy into the 

lpdmap.txt file. 

Updating transform configuration files 

As part of the install process, your existing transform configuration files and user 

exits are automatically zipped and backed up into the path <install 

path>\var\pdbk\samples.zip. 

For your reference, this list provides the default full-path names for six commonly 

modified transform configuration files: 

v   c:\Program Files\IBM\Infoprint Manager\pcl2afp\pcl2afp.cfg 

v   c:\Program Files\IBM\Infoprint Manager\pcl2afp\pcl2afpd.cfg 

v   c:\Program Files\IBM\Infoprint Manager\ps2afp\ps2afp.cfg 

v   c:\Program Files\IBM\Infoprint Manager\ps2afp\ps2afpd.cfg 

v   c:\Program Files\IBM\Infoprint Manager\ps2afp\3160d.cfg

After installing the latest InfoPrint Manager version, you can edit the 

newly-installed files to add your customized changes into the new configuration 

files that reside in the c:\Program Files\Infoprint directory. 

Note: Because the new configuration files may have different source material, you 

should not copy the backed-up files over the new configuration files. 

Migrating optional InfoPrint Manager features 

Any optional features of previous versions of InfoPrint Manager that are installed 

on the system are removed when the base server software is migrated to Version 

2.2. This is done because optional features of previous versions may be 

incompatible with the Version 2.2 server. The use of previous version options with 

a Version 2.2 server is not supported. To load Version 2.2 options, insert the 

CD-ROMs that contain features you want to install. 

Preparing to reinstall 

At some point, you may need to reinstall InfoPrint Manager. You might be 

upgrading to a new version or reinstalling the current version because of a 

problem. Try to install without uninstalling first, so that your configuration 

information is not lost. If that does not work, uninstall and reinstall using the same 
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installation directory. When you do, the objects you created will still exist, but any 

post-installation configuration, especially in multi-server environments, will 

probably be lost. 

Note:  

1.   You must have Administrative Privilege to install or uninstall InfoPrint 

Manager for Windows. If you try to uninstall the product without 

administrative privilege, the following message is issued: 

Setup Installation Error: Setup has detected Uninstallshield is in use, 

please close Uninstallshield and restart setup (Error 432). 

A similar message is issued at install if you do not have administrative 

privilege. 

2.   You must use the same userid to reinstall InfoPrint Manager for Windows as 

was used to install it initially. 

3.   Be sure to close the InfoPrint Manager Administration GUI, the InfoPrint 

Manager Operations GUI, and the InfoPrint Manager Management Console 

before installing any PTF or reinstalling InfoPrint Manager to avoid problems 

with files that need to be replaced.
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Chapter  4.  Installing  InfoPrint  Manager  server  software  

These are the steps for the initial installation of InfoPrint Manager for Windows 

Version 2.2 on your server. For instructions on applying service, refer to “Installing 

service updates for InfoPrint Manager clients” on page 22. 

1.   Log in as the Administrator user. 

Note: You must have Administrative Privilege to install or uninstall InfoPrint 

Manager for Windows. 

2.   Insert the Infoprint Manager for Windows Base Server CD-ROM into your 

CD-ROM drive. The install program starts automatically. You can choose to 

view a readme file before starting the install. 

3.   Select the Install Infoprint Manager Server button. 

4.   The license agreement displays. Read the license agreement and then click the 

Accept button. 

5.   Follow the instructions on the installation screens to install the program. You 

may enter the destination directory and other necessary settings. 

6.   After you have installed InfoPrint Manager for Windows, the installation 

program asks if you want to reboot your system. The default answer to this 

question is Yes because InfoPrint Manager will not function properly until the 

system is rebooted. When you click OK or press Enter, your system reboots, 

and the InfoPrint Manager service will start automatically. 

7.   If you are installing optional features, refer to “Installing optional features on 

an InfoPrint Manager system” on page 19 for instructions. 

8.   Install the most recent service update if appropriate. Refer to “Accessing the 

latest information and fixes” on page 20 for information and instructions about 

where to find product updates. Then follow the installation steps in “Installing 

service updates for InfoPrint Manager clients” on page 22.

Note:  If you receive Run-Time Error 5006, go to: http://
support.installshield.com/kb/view.asp?articleid=Q111253 for resolution. This is 

a known Macrovision InstallScript problem. 

The following software components are now installed on your system: 

v   InfoPrint Manager server 

v   InfoPrint Manager Management Console 

v   InfoPrint Manager Administration GUI 

v   InfoPrint Manager Operations GUI 

v   InfoPrint Notifications Server 

v   IBM TCP/IP Network Port Monitor 

v   InfoPrint Manager LPD service 

v   MVS Download

We strongly recommend that you verify the connection from your InfoPrint 

Manager for Windows server system to an actual destination. To do this, you must 

first create an actual destination as described in Chapter 10, “Creating actual 

destinations,” on page 65. 
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Installing on non-English operating systems 

InfoPrint Manager for Windows detects what language your operating system runs 

in by checking the Regional Settings of your system. When possible, message files, 

such as server and destination log messages and error messages, that match that 

language are loaded. When the messages are not available in the same language, 

English message files are installed. However, if non-English message files are 

installed and you then change the Regional Settings to English (U.S.), you will 

receive some, but not all, of your messages in English. We recommend that you do 

not change the Regional Settings after you have installed InfoPrint Manager. 

Running InfoPrint Manager with double-byte languages 

If you want to run InfoPrint Manager with a double-byte language, you must 

configure your multi-lingual system so that the double-byte language is the default 

language. 

Specifying your language for the InfoPrint Manager server 

with a Windows Multi-Language Version system 

Use this procedure to specify your country’s language for the InfoPrint Manager 

Server when you are using a Windows Multi-Language Version (MLV) System: 

1.   On the system that your InfoPrint Manager Server runs on, open the InfoPrint 

Manager Management Console1 and select File → Stop Server. 

2.   Set up a new domain user account that the InfoPrint Manager service will run 

under as follows: 

a.   Log on to the domain that InfoPrint Manager operates in as a domain 

administrator. 

b.   Use User Manager for Domains to create a domain user account that 

InfoPrint Manager will run under. 

Important: Make the user a member of the Domain Administrators group 

and change the user’s primary group from Domain Users to Domain 

Administrators. It is recommended that you select Password never expires 

so you don’t have to change the password and update all of your servers 

on a regular basis. 

c.   Give the domain user the following user rights: Act as part of the operating 

system, Create permanent shared objects, and Log on as a service.
3.   Log off the domain. 

4.   Grant the same user rights to the new domain user on the system that InfoPrint 

Manager is installed on: 

a.   Log on the system that the InfoPrint Manager is installed on as a user who 

is a member of the Domain Administrators group. 

b.   Use the local User Manager to give the domain user that you created in 2 

the following user rights on that system: Act as part of the operating 

system, Create permanent shared objects, and Log on as a service.
5.   Log off the system. 

6.   Change the regional settings for the new domain user to the appropriate 

language: 

a.   Log on the system as the domain user you created in 2. 

1. To start the  InfoPrint  Manager  Management  Console,  open  the  Start menu  and click Programs  → Infoprint  Manager  → 

Management  Console. 
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b.   Select Start → Settings → Control Panel. 

c.   Double-click the Regional Settings icon. 

d.   Select the appropriate language. 

e.   Click OK.
7.   Log off the system. 

8.   Log on as a user who is a member of the Administrators group for that system 

and complete these steps: 

a.   Open the InfoPrint Manager Management Console and select Edit → Service 

Account/Domain. 

b.   Enter the name of the domain that the InfoPrint Manager is installed on and 

the user name and password from 2 on page 18. 

c.   Click OK.
9.   On the system that your InfoPrint Manager Server runs on, open the InfoPrint 

Manager Management Console and select File → Start Server.

Uninstalling InfoPrint Manager for Windows 

To remove InfoPrint Manager from a system, follow these steps: 

1.   Determine if any directories have been moved out from under the install 

directory since the initial installation. You can do this through the InfoPrint 

Manager Management Console (Start → Programs → Infoprint Manager → 

Management Console). From the Management Console, go to Edit → Service 

Configuration.... Check all paths listed on the displayed panel to determine if 

any are not in the base install directory. Make note of any paths that are not in 

the base install directory. 

2.   Uninstall the product. Go to Start → Programs → Infoprint Manager → Uninstall 

Infoprint Manager for Windows. Follow all instructions as directed. 

3.   Restart the computer. 

4.   Delete the install directory. If any directories were moved out from the under 

the InfoPrint Manager install directory (as identified in step 1), delete those as 

well.

Installing optional features on an InfoPrint Manager system 

After installing InfoPrint Manager on your server, you can install any desired 

optional features, such as the SAP Print Feature or the PPFA Feature. Each feature 

CD has an installation program similar to the InfoPrint Manager server installer. 

Insert the appropriate Infoprint Manager for Windows Version 2.2 feature CD into 

the CD-ROM drive. The install program starts automatically; follow the 

instructions to complete the installation. If you are planning on installing the 

InfoPrint Job Ticketer feature, do not install the Print-on-Demand feature. 

If you have already installed a service update to InfoPrint Manager and you are 

now installing an optional feature for the first time, install it from the Version 2.2 

CD-ROM for that feature first, and then install the service update for the feature 

from the PTF CD-ROM. 
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Installing the InfoPrint Job Ticketer  

After the Infoprint Manager server software has been completely installed, insert 

the Infoprint Manager Web Server CD-ROM into your CD-ROM drive. The install 

program starts automatically. 

You will be asked for the Domain Name System (DNS) name. Enter the DNS name 

of your server machine. 

Note: If you enter the DNS name incorrectly or if the DNS name of your server 

machine changes, you must uninstall the InfoPrint Manager Web Server and 

reinstall the InfoPrint Manager Web Server, the Print-on-Demand feature, and all of 

your web applications. 

After the InfoPrint Manager Web Server software has been completely installed: 

1.   Insert the Infoprint Manager Print-on-Demand Disk 1 CD-ROM into your 

CD-ROM drive. The install program starts automatically. 

2.   Select the Yes, install Infoprint Job Ticketer checkbox. 

3.   Follow the instructions on the installation screens to install the program. You 

may enter the destination directory and other necessary settings.

Accessing the latest information and fixes 

You can find download fixes for InfoPrint Manager for Windows from the 

InfoPrint Solutions Company Web site at

http://www.infoprint.com 

You can find updated documentation for InfoPrint Manager for Windows from the 

following Web site: 

 http://www.elink.ibmlink.ibm.com/public/applications/publications/cgibin/pbi.cgi 

  

In order to obtain additional support for InfoPrint Manager for Windows, you 

need to purchase a support contract. Please contact your local marketing team for 

more information on how to obtain this support. Terms and conditions for support 

vary by country and geography. 

If you are in the U.S., you may call 1-888-426-4343 to set up a SupportLine contract 

for InfoPrint Manager for Windows. After a SupportLine contract is established, 

you may request technical assistance by calling 1-800-237-5511. When you call this 

number, you will be asked to provide your customer number, operating system 

(for example, 2000 or XP), name of the failing product (InfoPrint Manager for 

Windows), and a brief description of the problem. Please have this information 

available when you place a call for technical assistance. 
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Installing service updates for InfoPrint Manager and optional features 

Before installing any PTF, it is strongly recommended that you back up your 

InfoPrint Manager for Windows install directories, any directories that have been 

moved out from under the install directory since the initial installation of the 

product, and the Windows registry. Refer to “Backing up your InfoPrint Manager 

for Windows install directories” on page 14 for a description of the steps involved 

in backing up your system. 

Follow these steps to install a service update to the InfoPrint Manager server: 

1.   Log in as the Administrator user. 

2.   Insert the Infoprint Manager for Windows PTF CD-ROM into your CD-ROM 

drive. The install program will start automatically. 

3.   Select the Install Infoprint Manager Server button. 

4.   The license agreement displays. Read the license agreement and then click the 

Accept button. 

5.   Follow the instructions on the installation screens to install the update. The 

destination directory and other necessary settings will be obtained 

automatically based on your initial installation. 

Note: The service update install program may ask if you wish to update 

additional features at this time. If you click Yes to continue, you can follow the 

screen prompts to install the updates when the features install are complete, the 

InfoPrint Manager service update installation resumes. If you choose not to 

install the update at this time, you can install it later from the main installation 

menu on the CD. 

6.   After you have installed InfoPrint Manager for Windows, the installation 

program asks if you want to reboot your system. The default answer to this 

question is Yes because InfoPrint Manager will not function properly until the 

system is rebooted. When you click OK or press Enter, your system reboots, 

and the InfoPrint Manager service will start automatically. 

To access all changes as they are released in PTFs, ensure that the InfoPrint 

Manager Server is at the same level or at a higher level of service than the 

InfoPrint Manager Administration GUI and the InfoPrint Manager Operations GUI. 

Otherwise, you may receive error messages like: 5010-625 Cannot recognize 

attribute.... For this to occur, the InfoPrint Manager Administration GUI or the 

InfoPrint Manager Operations GUI would have to be running on a different 

workstation than the InfoPrint Manager Server. This might occur if you install a 

new version of a GUI on a workstation and point to a downlevel InfoPrint 

Manager Server. 

Follow these steps to install a service update to the PPFA Feature or the SAP Print 

or the Pad Features: 

1.   Log in as the Administrator user. 

2.   Insert the Infoprint Manager for Windows PTF CD-ROM into your CD-ROM 

drive. The install program will start automatically. 

3.   Select the Product Feature Updates button. 

4.   Select the feature you want to update and follow the instructions on the 

installation screens. The destination directory and other necessary settings will 

be obtained automatically based on your initial installation.
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Installing service updates for InfoPrint Manager clients 

Follow these steps to install a service update to an InfoPrint Manager client 

component: 

1.   Insert the Infoprint Manager for Windows Common Clients PTF CD-ROM into 

your CD-ROM drive. The install program starts automatically. 

2.   Select the client program you wish to update. 

3.   Follow the instructions on the installation screens to install the update. The 

destination directory and other necessary settings will be obtained 

automatically based on your initial installation.

Uninstalling a service update 

To remove a PTF from a system and restore InfoPrint Manager to an unconfigured 

state, follow these steps: 

1.   Determine if any directories have been moved out from under the install 

directory since the initial installation. You can do this through the InfoPrint 

Manager Management Console (Start → Programs → Infoprint Manager → 

Management Console). From the Management Console, go to Edit → Service 

Configuration.... Check all paths listed on the displayed panel to determine if 

any are not in the base install directory. Make note of any paths that are not in 

the base install directory. 

2.   Uninstall the product. Go to Start → Programs → Infoprint Manager → Uninstall 

Infoprint Manager. Follow all instructions as directed. 

3.   Restart the computer. 

4.   Delete the install directory. If any directories were moved out from the under 

the InfoPrint Manager install directory (as identified in step 1), delete those as 

well. 

5.   Install the InfoPrint Manager product. Follow the directions as specified. 

6.   Install any required PTFs to get the product to the desired level.
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Chapter  5.  Working  with  the  Windows  XP  Service  Pack  2 and  

Windows  2003  Service  Pack  1 Firewalls  

The Windows XP Service Pack 2 and Windows 2003 Service Pack 1 both include a 

Windows Firewall that provides a protective boundary that monitors and restricts 

information that travels between your computer and a network or the Internet. 

This provides a line of defense against someone who might try to access your 

computer from outside the Windows Firewall without your permission. Windows 

Firewall considers an “unsolicited request” any attempt to connect to your 

computer from the Internet or from the network. Every time your computer gets 

an “unsolicited request”, the Windows Firewall blocks that connection. If you 

choose to unblock a connection, Windows Firewall keeps track of it by creating an 

exception, so you will not be notified about it in the future. 

When Windows XP Service Pack 2 or Windows 2003 Service Pack 1 is installed on 

your system and the Windows Firewall is turned on, most programs will not be 

allowed to accept unsolicited communications unless you choose to list those 

programs as exceptions. Because firewalls restrict communication between your 

computer and network, you might need to adjust settings for some other programs 

that prefer an open connection. You can make an exception for these programs or 

services, so that they can communicate through the Windows Firewall. 

If you are running the InfoPrint Manager server on a Windows XP operating 

system with Service Pack 2 or a Windows 2003 operating system with Service Pack 

1, you can configure your Windows Firewall in one of two ways: 

v   Turn the Windows Firewall off. 

v   Define an exception for a program or service, in this case, one of the supported 

InfoPrint Manager components.

Notes:  

1.   Turning the Windows Firewall off may cause security issues in your network. 

2.   Defining an exception for a program or a service is recommended over opening 

a port.

Working  with the Windows Firewall 

To work with the Windows Firewall on the InfoPrint Manager for Windows server: 

1.   Go to Start → Control Panel → Windows Firewall, and the Windows Firewall 

dialog appears. 
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Notes:  

a.   When the Windows Firewall is active, the Firewall pop-up windows 

appears every time an unsolicited request is received by your computer 

from the network or Internet. These pop-up windows ask you to allow 

access to programs or services that are not yet on the Exceptions list. If you 

choose to allow them access, the exception is saved in the exception list, 

and from that moment, all requested from that program or service are 

accepted. 

b.   Microsoft recommends that you define a program or service exception, 

rather than opening a port.
2.   Leave the On (recommended) radio button selected to use the Windows 

Firewall, or click on the Off (not recommended) radio button to turn off the 

Windows Firewall. 

3.   Click on the Exceptions tab to add or remove the programs and services for 

which you want to change the access to your computer through the Internet or 

a network. Make sure that you deselect Don’t allow exceptions as shown in 

Figure 1. 

 

  

Figure 1. Windows Firewall dialog box
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a.   You may either use the Windows Firewall pop-up windows or the 

Windows Firewall Exceptions tab to give these programs or services access: 

v   If you are running the InfoPrint Manager server, define an exception for 

the pdservice.exe and the notifyd.exe. 

v   If you are running the InfoPrint Manager IPP Gateway, define an 

exception for the ippgw.exe. 

v   If you are running the InfoPrint Manager LPD service, define an 

exception for the lpd.exe. 

v   If you are running InfoPrint Manager MVS Download receivers, define an 

exception for the mvsprsd.exe. 

v   If you are running DPF Host Receivers, define an exception for the 

aindpfhr.exe. 

v   If you are running PSF Direct Host Receivers, consult your 

Communications program documentation for information on SNA. 

v   If you have installed the InfoPrint Manager SAP Print feature: 

–   And you are running the SAP Callback processes, define an exception 

for the sapcbd.exe. 

–   If your SAP system is running on HP-UX or Sun Solaris, define an 

exception for rshd.exe.

  

Figure 2. Windows Firewall Exceptions tab
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v   If you have installed the InfoPrint Job Ticketer from the InfoPrint 

Manager Print-on-Demand feature, define an exception for the 

install_path\ipmws\java\bin\java.exe .
b.   Define an exception for File and Printer Sharing for these situations: 

v   If you are using Hot Folders or the Windows Gateway to accept jobs 

from other machines. 

v   If you are using the Submit Express or Job Ticketer clients from the 

InfoPrint Manager: Print-on-Demand Feature. 

v   If you are using interoperating InfoPrint Manager servers.
4.   After a program or a service is added to the Exceptions list, you can edit and 

change the scope of the exception to use IP trust and allow clients to connect to 

the server from any computer, subnet network, or specific IP/mask by clicking 

the appropriate radio button. 

 

5.   To create a security log from the Windows Firewall, click on Settings on the 

Security Logging section of the Windows Firewall Advanced tab. 

 

  

Figure 3. Windows Firewall Change Scope dialog box
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6.   The Log Settings dialog appears. 

 

  

Figure 4. Windows Firewall Advanced tab
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The default log is c:\Windows\pfirewall.log, and it identifies what connections 

were dropped or successful, depending on the custom settings that you select. 

7.   To restore the default settings of the firewall, go to Advanced Tab on the 

Windows Firewall dialog and click the Restore Defaults button (see Figure 4 

on page 27).

  

Figure 5. Log Settings dialog
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Chapter  6.  Installing  necessary  hardware  

It may be necessary to install and configure some additional hardware to enable 

communication between your InfoPrint Manager server systems and your printing 

devices. 

The IBM 4159 Model 001 S/390 Parallel Channel Emulator Card 

If you are not planning to use channel-attached printers, you can go to the next 

chapter. 

In addition to a description of the IBM 4159 card, this section contains the 

following information: 

v   “Preparing to install the IBM 4159 PCI card” on page 33 describes the steps to 

recreate the IBM 4159 diagnostics diskette if it has been misplaced. 

v   “Installing the IBM 4159 Model 001 S/390 Parallel Channel Emulator Card” on 

page 33 describes the procedure for installing the IBM 4159 that includes the 

following topics: 

–   “Attaching the Bus/Tag Interface cable” on page 34 

–   “Testing the card” on page 35 

–   “Installing more than one IBM 4159 card” on page 37 

–   “Testing the printer connection” on page 38 

Note: Read and follow the information about installing the card in the order 

that it is presented.

The IBM 4159 Model 001 S/390 Parallel Channel Emulator Card is a single board 

solution for connecting PCI-based Windows 2000 systems to S/390 

channel-attached control units equipped with an IBM plug-compatible bus/tag 

interface. The IBM 4159 card is for use with InfoPrint Manager for Windows only. 

The IBM 4159 consists of a single full-length PCI board and a bus/tag interface 

cable. It contains all logic necessary to drive the bus/tag channel. The IBM 4159 

card comes in two sizes: long and short. While these cards may appear to be 

different, they are functionally identical. 

Figure 6 on page 30 and Figure 7 on page 31 show the outlines of the IBM 4159 

cards. 
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A 80–pin connector 

B Reset switch 

C IRQ/ACTV LEDs 

D 10–pin utility connector 

E Assembly number label 

F Serial number label 

G ISA retainer

Figure 6. IBM 4159 Model 001 S/390 Parallel Channel Emulator Card diagram (long card)
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The included bus/tag interface cable is attached to the IBM 4159 card with an 

80-pin connector on the bracket. The opposite end of this cable has standard bus 

and tag style connectors. 

 

6.9”

3.9”

A

B C D E F
  

A 80–pin connector 

B Serial number label 

C Assembly number label 

D 10–pin utility connector 

E IRQ/ACTV LEDs 

F Reset switch

Figure 7. IBM 4159 Model 001 S/390 Parallel Channel Emulator Card diagram (short card)

 

Chapter 6. Installing necessary hardware  31



The IBM 4159 has the following limitations: 

v   Each IBM 4159 supports at most 8 printers. However, if you are using the card 

to attach high-speed printers (such as an InfoPrint 4000 or an InfoPrint 4100), 

you should use one card per printer. 

v   You should plan to install the IBM 4159 in a long PCI slot. As a result, the 

number of long PCI slots you have available on your Windows 2000 system 

determines how many IBM 4159 cards you can install, up to a maximum of 8 

cards. Many computers have fewer than 8 long PCI slots. 

v   The IBM 4159 supports data streaming at either 3.0 Mb per second or 4.5 Mb per 

second. All printers connected to a computer must be configured for the same 

data streaming rate. 

v   The IBM 4159 supports only block multiplex data transfers.

What comes with the IBM 4159 card 

The IBM 4159 Card is a separately orderable part for use with InfoPrint Manager 

for Windows only. Contact your InfoPrint Solutions Company Sales Representative 

to order a card or cards. When the card arrives, the box contains the following 

items: 

1.   4159 Card 

2.   10’ Bus/Tag Interface cable (Y-cable) 

3.   Multi-language Read Me First sheet that directs you to this book. 

4.   Bus terminator 

5.   Tag terminator 

6.   Bootable diagnostics diskette 

7.   Emulator loopback (wrap plug) connectors 

  

Figure 8. Front panel with 80-pin connector
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8.   Service Label

Preparing to install the IBM 4159 PCI card 

Before attempting to install the IBM 4159, you must install the InfoPrint Manager 

server code onto the Windows 2000 system as described in Chapter 4, “Installing 

InfoPrint Manager server software,” on page 17. (If you have only channel-attached 

printers in your environment, you must install the IBM 4159 prior to performing 

any object configuration within InfoPrint Manager.) 

Creating a diagnostics diskette for the IBM 4159 

If you are unable to find the diagnostics diskette that accompanied your IBM 4159 

card, you may create one on any system where the InfoPrint Manager for 

Windows server software is installed. You should create the diagnostic diskette 

before you install the IBM 4159 card, so that you have it available when you test 

the card. To create a diagnostics diskette, follow these steps: 

1.   From the Start menu, select the Run option. 

2.   Type poldiagd in the Open: field. 

3.   Click OK. A window displays. 

4.   Make sure that the drive letter displayed corresponds to the drive letter of your 

floppy disk drive. 

5.   Insert a blank 1.44 MB floppy diskette into the drive. 

6.   Click OK. 

7.   If an error message displays, diagnose and try this procedure again. 

8.   If the message ″Operation completed with no error″ appears, click the Quit 

button to close the application.

You may now use this diagnostics diskette to diagnose your IBM 4159 card as 

described in “Testing the card” on page 35. 

Installing the IBM 4159 Model 001 S/390 Parallel Channel 

Emulator Card 

 1.   Remove all removable media (CD-ROMs, floppy disks, cartridge disks, and so 

forth) from system drives. 

 2.   Shutdown, power down, and unplug the server/host PC. 

 DANGER

Prior to installation of the IBM 4159, the server/host PC must be powered 

down and unplugged to avoid electrical shocks to the user and damage 

to the card or PC.

 3.   Remove the covers from the server/host PC. 

 4.   Select a full length PCI slot. 

Notes:  

a.   A single full-length 32-bit PCI slot on the motherboard is required for 

installation of the long card. The short version of the card may fit in PCI 

slots that are not full-length. 

b.   The PCI slot must support bus-mastering adapters. 

c.   Some motherboards have heat sinks or other components that may 

obstruct proper installation of the IBM 4159. By design, the long card 
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version of the IBM 4159’s circuit board has a bare corner to allow the card 

to fit in the grooves of many CPU heat sinks.
 5.   For the selected slot, remove the metal bracket plate located on the back of the 

PC. 

 6.   Slide the IBM 4159 into the slot and push firmly to ensure the contact pins are 

well seated. Never force the board into place. 

 CAUTION: 

Proper static control precautions must be taken to avoid damage to the 

circuit board. 

 7.   Look at the base of the card, where it has been inserted into the slot. If you 

can see any of the gold pins on the card, it is not seated properly. Pull the 

card out and check the position of the retaining bracket on the card. You may 

need to adjust the bracket so the card fits properly. Insert it again, pushing 

firmly and making sure that the gold pins are not visible. 

 8.   When the card is seated, replace the bracket screw to ensure proper 

grounding. 

 9.   Check the base of the card again to make sure that none of the gold pins are 

visible. (Cards occasionally become unseated when you reattach the bracket 

screw.) If the card has become unseated, unscrew the bracket screw, reseat the 

card, and carefully reattach the bracket screw. 

10.   Replace the covers on the server/host PC. 

11.   Plug in the server/host PC. 

12.   Place the Service Label that came with the IBM 4159 in a conspicuous place 

that will be easy to find in the future, so that the information is close at hand 

if you need to call service. We recommend attaching this label to the side of 

your server or some other obvious location. 

Attaching the Bus/Tag Interface cable 

CAUTION: 

Power down the server/host PC before connecting or disconnecting the Bus/Tag 

Interface cable. 

The IBM 4159 is provided with a Bus/Tag Interface cable to convert from the 

80-pin connector on the PCI card to standard bus and tag connectors. This interface 

cable matches the impedance specification for standard channel cables and may be 

attached directly to a control unit or extended with standard bus and tag cables. 

Standard channel terminators (included) must be installed at the last control unit, 

which is at the opposite end of the cables from the IBM 4159. 
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To attach the Bus/Tag Interface cable to the IBM 4159 PCI card: 

1.   Squeeze the two release tabs on the 80-pin cable connector. 

2.   Push the cable onto the mating connector of the PCI card. A slight rocking 

while pushing may be helpful. 

3.   Release the two tabs when firmly seated. 

4.   Now pull on the connector (without squeezing the tabs) to ensure the cable is 

latched in place.

Testing the card 

To verify proper installation, the card diagnostics provided should be run before 

attaching the card to a control unit. The card diagnostics are supplied with the IBM 

4159 on a bootable 3.5-inch floppy diskette. If you cannot locate the diagnostic 

diskette that was supplied with the card, see “Creating a diagnostics diskette for 

the IBM 4159” on page 33. 

Note: This diagnostic program should only be run as directed. Do not attempt to 

run the diagnostic program under Windows 2000. You must boot from the floppy 

to run diagnostics. 

To perform the diagnostic, you must first attach the included emulator loopback 

(wrap plug) connectors to the bus/tag connectors on the interface cable. To do this, 

follow these steps: 

  

Figure 9. Bus/Tag Interface cable assembly
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1.   Inspect all connectors to ensure no pins are bent or damaged. 

2.   Attach the tag connector on the Bus/Tag Interface cable to the tag connector on 

the wrap plug as follows: 

v   Join the connectors by hand. 

v   Use a flat-head screwdriver to incrementally tighten the screw on the back of 

the interface cable tag. 

v   Do not simply tighten the screw. Alternate between tightening the screw and 

pushing the connectors together by hand. This will ensure a uniform 

connection across all pins and reduce the chances of damaging the 

connectors.
3.   Repeat the previous step to connect the bus connector on the Bus/Tag Interface 

cable to the bus connector on the wrap plug.

To run the diagnostic program, follow these steps: 

 1.   If you have disabled the floppy drive as a boot device in the system BIOS, 

restore the floppy drive as the primary boot device. 

 2.   Insert the diagnostics diskette in the floppy drive. 

 3.   Restart the system. After a period of time, a window will display 

summarizing the results of initial diagnostics. 

 4.   Review the summary. If there are no errors, continue with step 5. If there are 

errors, the IBM 4159 card may be seated improperly. To check, do the 

following: 

a.   Power down the server/host PC. 

b.   Remove the cover from the PC. 

c.   Look at the base of the card. If you can see any of the gold pins, the card 

is not seated properly. Remove the card and reseat it so that you cannot 

see the pins. You may have to move the retaining bracket on the card or 

try it in a different slot to seat it properly. 

d.   Replace the cover on the PC. 

e.   Turn the PC back on and re-start the diagnostics test from step 3.
 5.   Press any key to continue with additional diagnostics. The following menu 

displays: 

Diagnostic test options are: 

  

0. Return to DOS 

1. Run all internal tests 

2. Run all internal tests and loopback tests 

Test number? _ 

 6.   Type 2 and press the Enter key to test all board functions including the 80-pin 

to tag/bus cable and channel driver/receivers. The tests will run continuously 

until you stop it by pressing any key or until an error is detected. 

 7.   If a red error message displays, write down the contents of the error message 

and contact InfoPrint customer support. 

 8.   After at least ten test cycles, press any key to stop the test. If no error 

messages display, the test was a success. 

 9.   Press any key to return to the menu. 

10.   Type 0 and press Enter to return to DOS. 

11.   Remove the diagnostic diskette from the floppy drive. 

12.   Power down the server/host PC. 
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13.   Remove the emulator loopback connectors from the Bus/Tag Interface cable 

by alternating between unscrewing and gently pulling the connectors apart by 

hand. 

14.   Attach the loopback connectors to the Bus/Tag Interface cable for future use 

by looping the end of the black plastic lanyard on the loopback connector 

around the 10 foot cable of the Bus/Tag Interface cable and snapping it 

closed. 

15.   Store the diagnostic floppy disk in a safe place. It may be needed to diagnose 

communication problems in the future.

Important: You should install and test all IBM 4159 cards to be installed in a 

system prior to establishing connections to any control units (printing devices). 

This is highly recommended because slot numbers may change if additional IBM 

4159 cards are added later. This may make channel destinations defined in 

InfoPrint Manager invalid. See “Installing more than one IBM 4159 card” for more 

information. 

Installing more than one IBM 4159 card 

If only one IBM 4159 card is installed in a system, the slot number assigned to it 

will always be 1. If, however, more than one IBM 4159 card is installed in a single 

system, Windows 2000 assigns a slot number to each card. To determine which slot 

number has been assigned to which card, follow this procedure: 

 1.   Install each IBM 4159 card as instructed in “Installing the IBM 4159 Model 001 

S/390 Parallel Channel Emulator Card” on page 33. 

 2.   Test each card as instructed in “Testing the card” on page 35. 

 3.   Attach the tag connector on the Bus/Tag Interface cable to the supplied Tag 

Terminator as follows: 

v   Inspect all connections to ensure that no pins are bent or damaged. 

v   If connecting directly to the printing device, tighten the screws on the 

interface cable’s connectors. 

v   If connecting to a channel cable, use the screws on that cable’s connectors. 

v   Alternate between gradually tightening the screws and pushing the 

connectors together by hand.
 4.   Repeat the previous step to connect the bus connector on the Bus/Tag 

Interface cable to the supplied Bus Terminator. 

 5.   Remove the PC covers, so you can see the LEDs on the installed IBM 4159 

cards. 

 6.   Power up the Windows 2000 system. 

 7.   Open a DOS command prompt (by selecting Programs and then Command 

Prompt from the Start menu on Windows 2000). 

 8.   Type the following command and watch the channel cards while pressing the 

Enter key: 

sense 1 00 

The amber LED on one of the cards will flash off and then on again. This card 

resides in slot 1. 

 9.   If you do not see which LED flashed, you must repeat this entire procedure 

from the beginning (including powering your system off and then on). 

10.   If none of the lights flash, do the following: 

a.   Power off your PC and printer. 

b.   Power on your PC and printer. 
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c.   When the printer gets back to the Ready state, issue the sense command 

from step 8 on page 37 again and watch for the LED to flash.

The system will number the channel slots in the order in which they are physically 

attached to the system. Therefore, the channel card located closest to the card 

identified in slot 1 will be in slot 2. The next channel card located closest to slot 2 

will be in slot 3, and so on. 

We recommend labeling each card with its associated slot number for future 

reference. When you have labeled all the slots, complete the following steps: 

1.   Shutdown and power off the server/host PC. 

2.   Remove the Bus and Tag Terminators from all the Bus/Tag Interface cables by 

alternating between unscrewing and gently pulling the connectors apart by 

hand. 

3.   Replace the covers on the server/host PC.

Testing the printer connection 

After verifying that each of your IBM 4159 cards is operational as described in 

“Testing the card” on page 35, you should verify the connection between each IBM 

4159 and every connected printer. Follow this procedure for each channel card you 

have installed: 

1.   Power off all devices attached to the channel. 

2.   Connect the bus and tag connectors to the appropriate connections on the 

channel cable that is attached to the control unit (printing device). You may 

also connect directly to a control unit if it is located near the server system. 

v   Inspect all connections to ensure that no pins are bent or damaged. 

v   If connecting directly to the printing device, tighten the screws on the 

interface cable’s connectors. 

v   If connecting to a channel cable, use the screws on that cable’s connectors. 

v   Alternate between gradually tightening the screws and pushing the 

connectors together by hand.
Terminators are supplied to terminate the bus and tag connections in a channel 

device chain. It is very important that all channel chains are properly 

terminated. Contact your InfoPrint customer engineer if you need help 

connecting and configuring your printing devices. 

3.   Power on the Windows 2000 system. 

If you installed the card on a Windows 2000 system, the Found New Hardware 

wizard appears at this point. Follow these instructions to complete the wizard: 

a.   On the first panel of the wizard, click Next. 

b.   On the second panel, select Other Devices from the list and click Next. 

c.   On the Select a Driver panel, click Have Disk. 

d.   In the Install from disk dialog, click Browse. 

e.   Navigate to <install_path>\bin, where <install_path> is the directory where 

you installed InfoPrint Manager. 

f.   In that directory, find the ibm4159.inf file and select it, then click Open. 

g.   In the Install from disk dialog, click OK. 

h.   On the Select a Driver panel, select the S/390 Parallel Channel Emulator 

and click Next. 

i.   A dialog will appear to ask you if you want to update the driver. Click Yes. 

j.   On the Start Device Driver Installation panel, click Next. 
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k.   On the Completing the Found New Hardware Wizard panel, click Finish.
4.   Power on all devices attached to the channel. 

5.   Open a DOS command prompt. 

6.   Type the following command: 

sense SlotNumber DeviceAddress 

where SlotNumber is the slot number assigned to the card by Windows 2000, 

and DeviceAddress is the two-character hexadecimal address of the control unit. 

(If you have only one IBM 4159 in the system, this value is always “1.” If you 

are installing more than one channel card, see “Installing more than one IBM 

4159 card” on page 37 for information on how to determine the slot number 

assigned to each card.) 

7.   Press Enter. Confirm that the device type and sense response values are 

displayed. 

8.   If an error message displays instead, fix the indicated problem, and try this 

procedure again. 

9.   Repeat steps 1 through 8 of this procedure for each printer attached to the 

channel card.
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Chapter  7.  InfoPrint  interfaces  tasks  

This section lists the tasks you can complete with the InfoPrint Manager 

Administration and Operations GUIs and the InfoPrint Manager Management 

Console. You use the InfoPrint Manager Administration and Operations GUIs for 

most of your day-to-day InfoPrint Manager tasks, while you use the InfoPrint 

Manager Management Console for tasks that must be performed on the InfoPrint 

Manager server system. 

For more information on the tasks listed here, refer to the online help systems in 

the InfoPrint Manager Administration and Operations GUIs and the InfoPrint 

Manager Management Console. The InfoPrint Manager Administration GUI and 

the InfoPrint Manager Operations GUI help systems also include tutorials to help 

you become acquainted with the GUIs and the tasks you may need to perform. To 

access the tutorials, launch one of the InfoPrint Manager GUIs and select Help → 

Tutorials. 

For information on installing and starting the InfoPrint Manager Administration 

and Operations GUIs, see Chapter 15, “InfoPrint Manager GUI software,” on page 

99. 

Tasks  you perform using the InfoPrint Manager Administration 

interface 

Printer tasks: 

v   Create or copy a printer (except Windows Gateway or PSF Direct only printers) 

v   Move a printer 

v   Delete a printer 

v   Create, copy, and modify job and document defaults 

v   Change logical destinations 

v   Check the status of a printer 

v   Enable a printer 

v   Disable a printer 

v   Space a PSF printer 

v   Resume a printer 

v   Stop or pause a PSF or InfoPrint Color printer 

v   Change media for a PSF, BSD, InfoPrint Color, or Passthrough printer 

v   Change the AFP resource information 

v   Change AFP color options 

v   Change job batch 

v   Change job routing 

v   Change tuning 

v   View or change printer properties 

v   Determine the media supported in the server 

v   Associate a medium with a physical printer 

v   Set or modify notification for an actual destination 
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v   Set or modify notification for default jobs 

v   Specify the default form definition for a PSF printer 

v   Specify the default input tray and output bin for a PSF printer 

v   Map  output-bin names to output-bin numbers 

v   Force messages from a printer 

v   Configure BSD printers that do not support the -Z flag 

v   Filter on actual destinations 

v   Display actual destinations 

v   Monitor printers 

v   Specify job batches ready for a printer 

v   Associate resource-context objects with an actual destination 

v   Associate auxiliary sheets with a PSF printer 

v   Activate auxiliary sheets for accounting or auditing information 

v   Associate input and output data user-exit programs with an actual destination 

v   Change the job classes that the printer can accept 

v   Change the job forms that the printer can use2

Other Destination tasks: 

v   Create an actual destination (email, fax, or print optimizer) 

v   Create or copy an actual destination (SAPconnect) 

v   Move a destination 

v   Delete a destination 

v   Create, copy, and modify job and document defaults 

v   Change logical destinations 

v   Check the status of a destination 

v   Enable a destination 

v   Disable a destination 

v   Resume a destination 

v   Stop or pause a destination 

v   Change the AFP resource information 

v   Change job batch 

v   Change job routing 

v   View or change destination properties 

v   Set or modify notification for a destination 

v   Set or modify notification for default jobs 

v   Force messages from a destination 

v   Filter on actual destinations 

v   Display actual destinations 

v   Monitor actual destinations 

v   Specify job batches ready for a destination 

v   Associate resource-context objects with an actual destination 

v   Activate auxiliary sheets for accounting or auditing information 

v   Associate input and output data user-exit programs with an actual destination 

v   Change the job classes that the destination can accept 

v   Change the job forms that the destination can use2
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Job tasks: 

v   Check the status of a queued or retained job 

v   Hold a job 

v   Release a job1 

v   Pause a job 

v   Resume a job 

v   Interrupt a printing job 

v   Change the media for a job 

v   Change the number of copies to print 

v   Change the priority of a job 

v   Change the retain time for a job 

v   Make a job first (promote a job) 

v   Move a job to a destination (reorder a job) 

v   Move a job to an actual destination 

v   Delete (cancel) a job 

v   Delete and retain a job 

v   View a job log 

v   View a job ticket 

v   Search for a job 

v   View or change job properties 

v   Display queued or retained jobs in the server 

v   Request a specific actual destination for a job 

v   Set or modify notification for a job 

v   Monitor jobs 

v   List all jobs for an actual destination or a queue 

v   Adjust the print quality of a job 

v   Set a job-batch value for a job 

v   Resubmit a retained job 

v   Select the pages of a job that you want to print 

v   Change the AFP resource information 

v   Change the AFP color options 

v   Change the job class 

v   Change the forms used for the job2

Queue tasks: 

v   Create a queue 

v   Delete a queue 

v   Check status of a queue 

v   Filter on queues 

v   Monitor queues 

v   Pause and resume a queue 

v   Keep failed jobs 

v   View or change queue properties

Logical destination tasks: 

v   Create or copy a logical destination 
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v   Move a logical destination 

v   Delete a logical destination 

v   Copy and modify job and document defaults 

v   Change the actual destinations fed by a logical destination 

v   Enable a logical destination 

v   Disable a logical destination 

v   View or change logical destination properties 

v   Filter on logical destinations 

v   Display logical destinations 

v   Associate a default job or default document 

v   Monitor logical destinations 

v   Specify the location of resources 

v   Specify printer driver names 

v   Adjust print quality in a default document 

v   Set or modify notification for default jobs

Server tasks: 

v   Show all servers currently running in the namespace 

v   View or change server properties 

v   Set or modify notification for a server

Transform tasks: 

v   Create a transform 

v   Copy a transform 

v   Show transforms in all servers currently being monitored 

v   Delete a transform 

v   View or change transform properties 

v   Associate a sequence of transforms with an actual destination

Miscellaneous tasks: 

v   Open windows (Main Window, Printers Window, Other Destinations Window, 

Logical Destinations Window, Jobs Window, Retained Jobs Window, Queues 

Window) 

v   Check error messages 

v   Update interface windows 

v   Customize the appearance of the interface 

v   Add and remove menu items and toolbar buttons 

v   Sort details views and tree views 

v   Change primary InfoPrint server connection 

v   Filter your view (destinations, queues, or servers) 

v   Access Help topics and tutorials

Notes:  

1.   Selected jobs are released in the same order that they are listed in the interface. 

2.   When you add a form in the interface, it only shows up in the list of available 

forms after a job has been run with that specific form. 
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For example, if you associate the form Letter with Job 1, Letter will not 

display in the Printer → Change Forms or Job → Change Forms drop-down lists 

until after Job 1 has completed.

Tasks  you perform using the InfoPrint Manager Operations interface 

Printer tasks: 

v   Check the status of a printer 

v   Enable a printer 

v   Disable a printer 

v   Space a PSF printer 

v   Resume a printer 

v   Stop or pause a PSF or InfoPrint Color printer 

v   Change media for a PSF, BSD, InfoPrint Color, or Passthrough printer 

v   Change job routing 

v   Display actual destinations 

v   Monitor printers 

v   Change the job classes that the printer can accept 

v   Change the job forms that the printer can use2

Other Destination tasks: 

v   Check the status of a destination 

v   Enable a destination 

v   Disable a destination 

v   Resume a destination 

v   Stop or pause a destination 

v   Change job routing 

v   Display actual destinations 

v   Monitor destinations 

v   Change the job classes that the destination can accept 

v   Change the job forms that the destination can use2

Job tasks: 

v   Check the status of a queued or retained job 

v   Hold a job 

v   Release a job1 

v   Pause a job 

v   Resume a job 

v   Interrupt a printing job 

v   Change the media for a job 

v   Change the number of copies to print 

v   Change the priority of a job 

v   Change the retain time for a job 

v   Make a job first (promote a job) 

v   Move a job to a destination (reorder a job) 

v   Move a job to an actual destination 
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v   Delete (cancel) a job 

v   Delete and retain a job 

v   View a job log 

v   View a job ticket 

v   Search for a job 

v   View or change job properties 

v   Display queued or retained jobs in the server 

v   Display retained jobs in the server 

v   Request a specific actual destination for a job 

v   Set or modify notification for a job 

v   Monitor jobs 

v   List all jobs for an actual destination or a queue 

v   Adjust the print quality of a job 

v   Set a job-batch value for a job 

v   Resubmit a retained job 

v   Select the pages of a job that you want to print 

v   Change the AFP resource information 

v   Change the AFP color options 

v   Change the job class 

v   Change the forms used for the job2

Queue tasks: 

v   Filter on queues 

v   Monitor queues 

v   Pause and resume a queue

Server tasks: 

v   Show all servers currently running in the namespace

Miscellaneous tasks: 

v   Open windows (Main Window, Printers Window, Other Destinations Window, 

Jobs Window, Retained Jobs Window, Queues Window) 

v   Check error messages 

v   Update interface windows 

v   Customize the appearance of the interface 

v   Add and remove menu items and toolbar buttons 

v   Sort details views and tree views 

v   Change primary Infoprint server connection 

v   Filter your view (destinations, queues, or servers) 

v   Access Help topics and tutorials

Note:  

1.   Selected jobs are released in the same order that they are listed in the interface. 

2.   When you add a form in the interface, it only shows up in the list of available 

forms after a job has been run with that specific form. 
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For example, if you associate the form Letter with Job 1, Letter will not 

display in the Printer → Change Forms or Job → Change Forms drop-down lists 

until after Job 1 has completed.

Tasks  you perform using the Management Console 

Server tasks: 

v   Start or stop the InfoPrint Manager server 

v   Check server status 

v   View or filter the server log 

v   Save the view of the server log that is currently displayed as a text file 

v   Check the percentage of server filespace used 

v   Set the InfoPrint Manager server to start automatically when the system starts 

up

Server Configuration tasks: 

v   Change the user account that the server runs under 

v   Change the password associated with the user account that the server runs 

under 

v   Change the domain that the InfoPrint Manager server operates in 

v   View or modify InfoPrint Manager directory structure, resource search path 

information, and the shared file folder location 

v   View or modify the ports that the server communicates on 

v   Change the hostname or IP address that InfoPrint Manager uses after you have 

changed it on your system

DPF tasks: 

v   Create, view, modify, or delete a DPF host receiver 

v   Start, stop, pause, or resume a DPF host receiver 

v   Cancel a DPF print job that’s currently downloading 

v   Obtain printer characteristics 

v   Find a specific DPF resource in the DPF Resource database 

v   Delete a DPF resource

PSF Direct tasks: 

v   Create, modify, or delete destinations that are used exclusively by PSF Direct 

v   Create, view, modify, or delete a PSF Direct host receiver

Destination tasks: 

v   View the status and attributes of InfoPrint destinations 

v   Migrate a Windows printer into an InfoPrint destination 

v   Create, view, modify, or delete a Windows Gateway Printer 

v   Prevent some users or groups from submitting jobs to a particular destination

MVS  Download tasks: 

v   View MVS Download receiver information 

v   Create or delete MVS  Download receivers 

v   Start or stop MVS Download receivers 
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v   Delete orphaned files 

v   Open the destination control file so you can edit it 

v   Resubmit a job that failed in processing by the exit program SAP Callback 

Process tasks:

SAP Callback Process tasks: 

v   View SAP Callback Process 

v   Add SAP Callback Process 

v   Change SAP Callback Process 

v   Delete SAP Callback Process 

v   Start SAP Callback Process 

v   Stop SAP Callback Process

Troubleshooting tasks: 

v   Capture system information to provide to InfoPrint Service 

v   Manage server tracing 

v   Manage PSF destination tracing 

v   View PSF destination logs 

v   Reset communications between the InfoPrint Manager server and other servers 

v   Create or clear namespace 

v   Manage DPF host receiver tracing 

v   Show DPF host receiver drive information 

v   Recreate DPF resources database 

v   Control MVS  Download Tracing

Security tasks: 

v   View InfoPrint Access Control Lists (ACLs) and the InfoPrint users and groups 

who have permissions associated with them 

v   Add or delete InfoPrint member/group of InfoPrint ACL 

v   Modify InfoPrint member/group permissions in InfoPrint ACL 

v   Create, view, modify, or delete InfoPrint security groups and their members

Input Manager tasks: 

v   Change Input Manager settings 

v   Clean up leftover Input Manager files

Miscellaneous tasks: 

v   Start up one of the other InfoPrint Manager GUIs 

v   Specify which view of the InfoPrint Manager GUI to launch from the 

Management Console 

v   Print a test job 

v   Enable or disable IPP Gateway 

v   Enable or disable notification server 

v   Add a Windows port 

v   Specify how often you want the information displayed in the Management 

Console to be updated 

v   Update the information currently displayed in the Management Console 

v   View help for error and informational messages 

 

48 InfoPrint  Manager  for  Windows:  Getting  Started



v   Enable/disable the InfoPrint Manager LPD

Starting the InfoPrint Manager Management Console 

To start the InfoPrint Manager Management Console, click the Windows Start 

button and select Programs → Infoprint Manager → Management Console. 

 

Chapter 7. InfoPrint  interfaces tasks 49



50 InfoPrint  Manager  for  Windows:  Getting  Started



Chapter  8.  Understanding  printer  drivers,  port  monitors,  

windows  gateway  printers,  and  passthrough  printers  

Before you decide which type of InfoPrint actual destination to create, you should 

first understand the following terms and concepts. Figure 1: InfoPrint Manager 

print data stream flow illustrates how these items can fit into your InfoPrint 

Manager system. 

Printer driver 

Software that accepts the output of your applications and converts it into a 

data stream that the printer can understand. Most printers come with one 

or more drivers that you can install and use; the printer documentation 

provides more specific infomation about the capabilities of the drivers. The 

driver you use determines what data stream is sent to the printer. In 

InfoPrint Manager, the driver may process the data before it is placed on 

the print spool. 

Port monitor 

Software that controls how the data stream that is generated by the printer 

driver gets to the printer. If your printer is local- or parallel-attached to 

your system, you use a local port monitor; if your printer is attached over 

TCP/IP, you may use a TCP/IP port monitor. InfoPrint Manager includes 

two port monitors: the InfoPrint port monitor that sends print data to the 

InfoPrint Manager spool and the IBM TCP/IP Network Port Monitor. 

Note: For more information on the IBM TCP/IP Port Monitor, see the 

readme file located in the <systemroot>\system32 directory; for example 

C:\winnt\system32.

Port A Windows entity that represents a particular output device or target. The 

data stream that the driver creates is sent to the printer through a port. A 

port is always created with and controlled by a specific port monitor. 

InfoPrint Manager creates ports that use the InfoPrint port monitor when it 

needs them. You may have to create some ports yourself (such as a port 

that uses the IBM TCP/IP Network Port Monitor), but you should never 

have to create an InfoPrint port. 

Windows printer 

The combination of a printer driver and a port. You can create a Windows 

printer using the Windows Add printer wizard. A Windows printer 

receives print data, sends it through the printer driver to create the data 

stream that you want to use, then sends the data stream to an output 

device (printer) or target through the port. InfoPrint Manager sometimes 

creates Windows printers under the covers and names them IPM-<actual 

destination name>. You will be able to see these printers in the Windows 

Printers window, but you should never open and modify them from there. 

Windows shared printer 

A Windows printer that is defined so that a remote Windows user can 

send print jobs to it. When a user on the network uses the Windows Add 

printer wizard to create a network printer on his or her desktop, the 

wizard provides a list of the Windows shared printers that are available. In 

InfoPrint Manager, a Windows gateway printer is a type of Windows 

shared printers.

 

© Copyright  InfoPrint  Solutions  Company  1998, 2007 51



Windows gateway printers 

A Windows gateway printer is a Windows shared printer that you create on your 

InfoPrint Manager system. Then, users can add that printer to their desktops and 

submit jobs to it. The gateway submits the jobs to the specified InfoPrint 

destination to be printed. 

Important: InfoPrint Manager manages this Windows shared printer for you; you 

should never modify the port monitor or port configuration of this printer by 

opening it from the Start → Settings → Printers window. 

You create a Windows gateway printer on the InfoPrint Manager server system 

using the Management Console. Select Edit → New → Windows Gateway Printer to 

open the Create Gateway Printer dialog. In the dialog: 

v   Specify a share name for the Windows gateway printer. The share name is the 

name that users will see in the Add Printer wizard when they look for the 

printer. 

v   Select the InfoPrint destination that the gateway will send jobs to. 

IPM
Spool

Infoprint Port Monitor

Port Monitor

Infoprint Port Monitor

Port

Port

Passthrough Printer
(IPM-Actual Destination)

Port

Generic Text/Only Driver

Printer Driver-for target printerPrinter Driver-for target Printer

Windows Gateway Printer

Share Name: Gate 1

Select Printer

Network Connection to
Windows Gateway Printer

ClientServer

To: Gate 1

Set by Administrator or User

Set by Infoprint Manager

  

Figure 10. InfoPrint Manager print data stream flow
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Note: You must create this destination before you create the Windows gateway 

printer. Refer to Chapter 9, “Understanding Destination Support Systems (DSS),” 

on page 55 and Chapter 10, “Creating actual destinations,” on page 65 for more 

information about creating destinations. 

v   Select the printer driver that generates a datastream that corresponds to the 

destination or destinations that the jobs may be printed on.

InfoPrint Manager associates the selected driver with the InfoPrint port monitor to 

create a Windows printer. 

Passthrough printers 

When you want to create a Passthrough printer, you first use the Management 

Console to create a port that the Passthrough printer will use. When you create 

this port, you must select a port monitor that supports the attachment type for 

your printer. For example, if your printer is local– or parallel-attached, choose the 

Local Port; if your printer is TCP/IP attached, use a TCP/IP port monitor designed 

for that printer. 

Note: For most IBM TCP/IP attached printers, you can use the IBM TCP/IP 

Network Port Monitor. However, if you want to send PDF jobs to a printer that 

accepts the PDF data stream, you will have to use a different port monitor. 

Then you use the InfoPrint Manager Administration GUI to create the Passthrough 

printer, specifying the port you just created. 

To see a list of the ports that are available on your system, complete the following: 

1.   Click the Windows Start button and select Settings → Printers. 

2.   In the Printers window, select File → Server Properties, and in the Print Server 

Properties window, click the Ports tab.

InfoPrint Manager automatically creates a Windows printer (named IPM-<actual 

destination name>) that uses the port you named, along with the Generic / Text 

Only printer driver. The Generic / Text Only driver is considered a passthrough 

driver because it does not change the data stream it receives. If you send 

PostScript to it, it sends the same PostScript to the printer. 

Important: InfoPrint Manager manages this Windows printer for you; you should 

never modify it directly by opening it from the Start → Settings → Printers window.
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Chapter  9.  Understanding  Destination  Support  Systems  (DSS)  

The software that the actual destination uses to send jobs to the output device is 

called the destination support system (DSS). InfoPrint Manager for Windows 

supports the following DSSs: 

PSF DSS 

The PSF DSS permits InfoPrint Manager to use the IBM Print Services 

Facility (PSF) printing subsystem. You can use the PSF DSS to submit print 

jobs to output devices that accept the Intelligent Printer Data Stream 

(IPDS) or the PCL data stream. The PSF DSS accepts print jobs in a variety 

of data streams and transforms them into IPDS™ or PCL before sending 

them to the output device. The PSF DSS is the most flexible DSS. It 

provides a single point of control and tracking for print jobs. 

 The way InfoPrint Manager communicates with the output device depends 

on the type of actual destination. For PSF DSS actual destinations, it also 

depends on the attachment type. (See “Understanding attachment types for 

PSF actual destinations” on page 57.) 

Passthrough DSS 

The Passthrough DSS permits InfoPrint Manager for Windows to use the 

Windows print-spooling subsystem. This DSS supports non-IPDS (such as 

PostScript or PCL) printers using standard Windows ports and port 

monitors. 

 Before you create an InfoPrint Manager Passthrough printer (also known 

as a Passthrough actual destination), you must perform these tasks: 

v   Attach the printer device as specified by its documentation 

v   Use the InfoPrint Manager Management Console to create a Windows 

port to communicate with the printer device (see “Passthrough printer” 

on page 74 for details) 

v   Install the Windows Generic/Text Only Driver from the Windows CD

BSD  DSS 

The BSD DSS permits InfoPrint Manager to use remote printers or printing 

subsystems. InfoPrint Manager sends jobs submitted to BSD physical 

printers as separate print requests to a remote print queue. 

 InfoPrint Manager typically uses the lpr command to send jobs to a printer 

device or to another system. The target can be any device or system that 

supports the lpd protocol and that connects to the network with TCP/IP. 

 Refer to the printer configuration documentation of the remote device or 

system for details on how to set up a remote queue. 

IPP DSS 

InfoPrint Manager uses the IPP DSS to communicate with printers that are 

Internet Print Protocol (IPP) enabled. This DSS allows InfoPrint Manager to 

access a printer by means of a Uniform Resource Indicator (URI) string.

If  you send intelligent printer data stream (IPDS) to your printer, you should create 

PSF printers. Check Table 6 on page 59 to see which attachment type to create. 

Otherwise, the type of destination you create primarily depends on where your 

print jobs are coming from. The appropriate DSS is different for each of the 

following job submitters: 
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v   PC-based applications 

v   A host system (through PSF Direct) 

v   Both PC-based applications and a host system (through PSF Direct, DPF, or MVS  

Download)

Refer to the following sections for assistance in making the decision. 

Selecting a DSS for printing from PC-based applications or a host 

system using IP Printway 

If you do not use PSF Direct, DPF, or MVS  Download to submit jobs, use Table 3 to 

see which type of destination fits your needs. 

 Table 3. Selecting a DSS  for printing from PC-based applications 

If the data 

stream that 

your 

applications 

send to 

InfoPrint 

Manager is: 

PostScript, PCL, or any non-IPDS datastream PostScript, PCL (versions 

4, 5, 5c and 6), or any 

non-IPDS datastream 

and the data 

stream that 

you send to 

this printer is: 

the same that the application sends to 

InfoPrint Manager 

PCL4, PCL5, PCL5c, 

PPDS¹, IPDS 

and your jobs 

are going to 

be sent to a 

printer: 

through a 

Windows 

defined port 

using a 

command 

such as lpr 

that is IPP 

enabled 

that is attached to your 

InfoPrint Manager system 

in any of the ways listed 

in Table 6 on page 59. 

Create this 

kind of actual 

destination: 

Passthrough² BSD IPP PSF 

Note:  

1.   You can only print PPDS on a non-Windows system, for example, by sending the PPDS 

data stream to an AIX  system. 

2.    If you are printing PCL  data to a Windows-defined printer, you may  want to consider 

creating a PSF (other-driver or command) destination instead. A Passthrough 

destination uses fewer processing resources, but a PSF destination provides much more 

functionality, such as accounting and automatic data stream transforms.
  

Selecting a DSS for printing only from host systems using PSF Direct 

If you send print jobs to your printers from a host system using PSF Direct and 

you do not plan to allow job submission to those destinations through any other 

paths (such as the IPP gateway), use Table 4 to see which type of destination fits 

your needs. 

 Table 4. Selecting a DSS  for printing from host systems using PSF Direct 

If the data stream that you send to 

your printer is: 

IPDS PCL or PPDS¹ 
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Table 4. Selecting a DSS  for printing from host systems using PSF Direct (continued) 

Create this type of actual 

destination: 

PSF Direct only (TCP/IP- 

or channel-attached) 

PSF Direct only 

(non-IPDS) 

Note: This destination 

type is equivalent to a 

PSF command 

destination. 

Note: You can only print PPDS on a non-Windows system, for example, by sending the 

PPDS data stream to an AIX  system.
  

Selecting a DSS for printing using MVS Download, DPF, or from a 

combination of PC-based applications and host systems 

If you will be sending jobs to this destination from both PC-based applications and 

host systems using PSF Direct, DPF, or MVS Download, use Table 5 to see which 

type of destination fits your needs. 

 Table 5. Selecting a DSS  for printing using MVS Download, DPF,  or from a combination of 

PC-based applications and host systems 

If the data 

stream that your 

host system and 

applications 

send to 

InfoPrint 

Manager is: 

AFP,  ASCII, DBCS  ASCII, line data, 

PCL4, PCL5, PCL5c, PS, PDF,  IPDS 

(through PSF Direct or DPF)1 

PCL4, PCL5, 

PCL5c and PCL6 

PS only 

and the data 

stream that you 

send to your 

printer is: 

IPDS PCL4, PCL5, or 

PCL5c or PPDS2 

PCL  PS 

Create this kind 

of actual 

destination: 

PSF (TCP/IP or 

channel) 

PSF (other driver 

or command) 

PSF (other driver 

or command) 

OR any of the 

destination types 

listed in Table 3 

on page 56 

One  of the 

destination types 

listed in Table 3 

on page 56. 

Note:  

1.    PSF Direct and DPF  can only submit jobs to PSF printers. MVS  Download can submit 

jobs to any of the printer types listed. 

2.   You can only print PPDS on a non-Windows system, for example, by sending the PPDS 

data stream to an AIX  system
  

Understanding attachment types for PSF actual destinations 

The attachment type for an actual destination defines how the printer device 

attaches to the Windows system and communicates with InfoPrint Manager for 

Windows. Based on the printer device, the attachment type is one of the following: 

TCP/IP 

The printer device communicates using IPDS and attaches to the Windows 

system through the TCP/IP network. To create the actual destination, you 

must specify the Internet Protocol (IP) address of the printer device and 

the port number through which InfoPrint Manager communicates with the 
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device. The port number for TCP/IP-attached printers is an integer from 

5001 to 65535. For printers attached using the i-data 7913 IPDS Printer 

LAN Attachment, you must use 5001 as the port number. 

Note: If you have trouble connecting with a printer, you may want to 

increase the number of connection retries. To do this, you can edit the 

Registry on your Windows server and set the TcpMaxDataRetransmissions 

TCP value to ’8’ instead of the default of ’5’. To edit the registry, you 

should use the Microsoft document TCP/IP and NBT Configuration 

Parameters for Windows (Q120642), which is available in an HTML version 

from their Web site at

http://support.microsoft.com/ 

You can access this document by searching on the document number 

(Q120642).

Channel 

The Intelligent Printer Data Stream (IPDS) printer device attaches to the 

Windows system through an IBM 4159 Model 001 S/390 Parallel Channel 

Emulator Card (with S/390 bus/tag cables). Before creating the actual 

destination, you must identify the number of the slot that contains the card 

and the hexadecimal control unit address of the printer device. 

Note: If you plan to attach printers through an IBM 4159 Model 001 S/390 

Parallel Channel Emulator Card, consider the following limitations: 

v   Each IBM 4159 supports at most 8 printers. However, if you are using 

the card to attach high-speed printers (such as an InfoPrint 4000 or an 

InfoPrint 4100), you should use one card per printer. 

v   You should plan to install the IBM 4159 in a long PCI slot. As a result, 

the number of long PCI slots you have available on your Windows 2000 

system determines how many IBM 4159 cards you can install, up to a 

maximum of 8 cards. Many computers have fewer than 8 long PCI slots. 

v   The IBM 4159 supports data streaming at either 3.0 Mb per second or 4.5 

Mb per second. All printers connected to a computer must be configured 

for the same data streaming rate. 

v   The IBM 4159 supports only block multiplex data transfers.

Command 

Before you create a PSF command actual destination, you must attach the 

printer device as specified by its documentation. If you are using this 

device for converting data to PCL to print on a PCL printer, ensure that 

you review “Processing concerns when using the PCL Secondary” on page 

61. 

Other-Driver 

The PCL printer device communicates using TCP/IP or attaches directly to 

the Windows system through a parallel or serial port. To create the actual 

destination, you must specify the port associated with a port monitor 

needed to operate the PCL printer. If you are using this device for 

converting data to PCL to print on a PCL printer, ensure that you review 

“Processing concerns when using the PCL Secondary” on page 61.

Use  Table 6 on page 59 to determine the appropriate attachment type for PSF 

actual destinations. 
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Table 6. Selecting an attachment type for PSF actual destinations 

If you are sending this data 

stream to the printer: 

IPDS IPDS PCL4, PCL5, 

PCL5c or 

PPDS 

PCL4, PCL5, 

PCL5c or 

PPDS 

and you are going to attach 

the printer to the system 

where InfoPrint Manager is 

running this way: 

over the 

TCP/IP 

network 

using the IBM 

4159 Model 

001 S/390 

Parallel 

Channel 

Emulator 

Card 

over the 

TCP/IP 

network OR 

directly 

attaching it 

through a 

parallel or 

serial port 

over the 

TCP/IP 

network 

using a 

command 

such as lpr to 

submit jobs to 

it 

Select this attachment type: TCP/IP Channel Other-driver 

Note: You 

may  not use a 

PSF 

Other-driver 

destination 

with PSF 

Direct. 

Command 

Note: You 

must use a 

Command 

destination 

with PSF 

Direct.

  

To configure a PSF-other Driver printer to not transform certain input data 

formats, you use the Manager Administration GUI to perform the following 

configuration task. After you create the PSF Other-Driver attached printer with the 

Create Printer Wizard, you must go into the Printer Properties notebook for the 

printer and modify the Formats to RIP at destination field to configure your 

actual destination for passthru PCL and PostScript® jobs. The Formats to RIP at 

destination field can be found on the Document tab of the Printer Properties 

notebook when all the available properties are displayed. It may be necessary to 

click the Show More button to display all the printer properties. 

Highlight both PCL and the PostScript (or only one of the two, depending upon 

what data types your actual destination supports natively) from the Formats to 

RIP at destination list of possible values, and click on the Add>> button. 

You can specify other values besides PCL and PostScript because you may have a 

destination that can accept them directly. For example, your printer may accept 

ASCII.  

Note: As the following sections indicate, you must avoid specifying particular 

Manager attributes to ensure that jobs are not transformed. 

Document attributes that cause a job to be transformed 

Please note that the following document attributes negate the Document Formats 

Ripped at Destination setting and force jobs to be transformed. For more 

information on these attributes, see InfoPrint Manager: Reference. 

v   base-printer 

v   carriage-control-type 

v   chars 

v   color-mapping-table 

v   convert-to-ebcdic 

v   data-fidelity-problem-reported 

v   default-printer-resolution 

v   document-finishing 
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v   explicit-page-placement 

v   font-fidelity-action 

v   font-processing-messages 

v   font-resolution 

v   form-definition 

v   halftone 

v   image-fit 

v   image-length 

v   image-out-format 

v   image-width 

v   input-exit 

v   input-tray-select 

v   job-terminate-message-count 

v   jog-between-job-copies 

v   maximum-messages-printed 

v   maximum-transform-pages-ahead 

v   mvs-segment-id 

v   new-line-option 

v   new-line-option-data-encoding 

v   number-up 

v   other-transform-options 

v   output-appearance 

v   output-bin 

v   output-format 

v   overlay 

v   overlay-back 

v   overlay-front 

v   page-definition 

v   page-media-select 

v   page-select 

v   resource-context 

v   resource-context-font 

v   resource-context-form-definition 

v   resource-context-overlay 

v   resource-context-page-definition 

v   resource-context-page-segment 

v   resource-context-user 

v   resource-exit 

v   reverse-page-order 

v   scanner-correction 

v   screen-frequency 

v   segment-file-size 

v   shared-formdef 

v   shift-out-shift-in 

v   start-on-new-sheet 

v   table-reference-characters 

v   transform-message-file-name 

v   transform-output-file-name 

v   x-image-shift 

v   x-image-shift-back 

v   y-image-shift 

v   y-image-shift-back
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Job attributes that cause a job to be transformed 

The following job attributes negate the Document Formats Ripped at Destination 

setting and force the jobs to be transformed. For more information on these 

attributes, see InfoPrint Manager: Reference. 

v   delete-segment-list 

v   job-finishing 

v   job-rip-action 

v   optimize-for-multiple-copies 

v   tape-exit 

v   tape-format 

v   tape-labeled 

v   tape-max-block-size 

v   tape-rewind-before 

v   tape-rewind-unload

PSF header sheet attributes that cause a job to be 

transformed 

These attributes could effect header sheet generation, so they also negate the 

Document Formats Ripped at Destination setting and force jobs to be 

transformed. For more information on these attributes, see InfoPrint Manager: 

Reference. 

v   account-text 

v   address1-text 

v   address2-text 

v   address3-text 

v   address4-text 

v   building-text 

v   department-text 

v   mvs-class 

v   mvs-destination 

v   mvs-forms 

v   name-text 

v   node-id-text 

v   programmer-text 

v   room-text 

v   subject-text 

v   title-text 

v   user-id-text

Processing concerns when using the PCL Secondary 

InfoPrint Manager uses the PCL Secondary when PSF receives data and converts it 

to PCL for printing on a PCL printer. You use the PCL Secondary whenever you 

submit jobs through either a PSF Other-driver printer that does not set the 

document-formats-ripped-at-destination attribute or through a PSF Command 

printer. The following describes concerns that are specific to jobs sent through the 

PCL Secondary. 

There are specific limitations that must be observed when sending jobs through the 

PCL Secondary: 

v   InfoPrint Manager only supports printing the following data streams as output 

of the PCL Secondary: 
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–   PPDS 

–   PCL4 

–   PCL5 

–   PCL5c
v   The PCL Secondary only: 

–   Produces PCL image data when there is image in the data sent to it. 

–   Converts on a job basis and does not save AFP resources (whether fonts, 

overlays, or page segments) from previous jobs on the PCL printer.
v    The PCL Secondary does not support: 

–   Running parallel PCL Secondaries to transform jobs into PCL format, unless 

you create and print to different actual destinations. 

–   Using any printer-resident resources (see “How the PCL Secondary uses 

fonts” on page 63). 

–   Reusing printer resources (including fonts) in subsequent jobs. 

–   Selecting output bins. 

–   Using custom media sizes.

Configuring trays for PCL Secondary printers 

Mapping input bin numbers between the PCL Secondary and the printer is 

different than mapping input bins between IPDS printers and the printer. For an 

IPDS printer, InfoPrint Manager gets the available bins from the printer. For the 

PCL Secondary, you must configure the bins you want to use because InfoPrint 

Manager cannot query the printer and must mimic an IPDS printer to capture 

formatting information: 

 Table 7. Sample input bin mappings 

AFPDS bin #1 tray #1 

AFPDS bin #2 tray #4
  

The PCL Secondary has limitations that apply to input bins that may limit your 

ability to perform certain tasks. Because it supports an older version of the IPDS 

Load Copy Control (LCC) command, the PCL Secondary is limited in what it can 

do with copies. When printers support the older version of the LCC command, 

IPDS uses an Execute Order Homestate Select Input Media Source (XOH-SIMS) 

command each time a medium map changes. The PCL Secondary’s older version 

of the LCC command limits you to specifying one input bin for each LCC 

command. Because each XOH-SIMS command overrides the previous one, you 

cannot specify multiple copies of each page from different bins on the PCL printer. 

For a complete example of how this works, see the psf-tray-characteristics actual 

destination attribute description in the InfoPrint Manager: Reference. 

For example, if you were to try and print a job with a form definition that specifies 

multiple input bins for each page, you might be able to print successfully using an 

IPDS printer that supports these specifications, but be unable to print that same job 

to a PCL printer through the PCL Secondary. With the printer using the PCL 

Secondary, InfoPrint Manager uses an XOH-SIMS command each time the form 

definition changes the medium map. 
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How the PCL Secondary uses fonts 

The PCL Secondary supports only two types of fonts: 

1.   300 pel AFP fonts 

2.   Relative-Metric AFP fonts

You must install one of these two font types on your system so they can be used 

by the PCL Secondary. 

Because the PCL Secondary transfers data to the PCL printer character-by-character 

during job processing, you cannot examine the PCL data the same way you might 

examine standard text or PCL data. As a result, you cannot scan the output data 

for certain text strings. 

Also, the PCL Secondary can neither communicate with the printer to see if the job 

completes printing nor query fonts on the printer after the print command has 

been issued. 

Troubleshooting printing to the PCL Secondary 

The following provides potential answers to problems that can result from using 

the PCL Secondary through InfoPrint Manager: 

The graphics in my PCL file do not print, and I receive errors with the output. 

You may have submitted a file with graphics as either PCL4 or PPDS 

output. Neither of these data streams support graphics. To ensure that the 

Sense Type Model (STM) IPDS command created by the PCL Secondary 

generates the Graphics Command-Set Vector, you should print the output 

as either PCL5 or PCL5c data.
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Chapter  10.  Creating  actual  destinations  

For help in selecting the type of actual destination to create, see Chapter 9, 

“Understanding Destination Support Systems (DSS),” on page 55. 

The InfoPrint Manager Administration and InfoPrint Manager Operations 

Graphical User Interfaces (GUIs) are applications that let you easily manage your 

InfoPrint objects. Both GUIs are installed with the InfoPrint Manager server and 

can also be installed on remote systems that use the Windows operating systems. 

The interface you use depends on whether you want the printer to be driven 

through an InfoPrint Manager queue or exclusively by a remote host system 

through PSF Direct. The driven by InfoPrint Manager Administration GUI provides 

wizards to help you create several types of actual destinations to be driven by 

InfoPrint Manager. The InfoPrint Manager Management Console provides support 

for creating printers to be driven exclusively by PSF Direct. It also provides 

support for creating InfoPrint gateways, which allow users to submit jobs to 

InfoPrint Manager even if they do not have InfoPrint Select installed. 

This chapter assumes that you have started the InfoPrint Manager interfaces and 

you are comfortable using them. See Chapter 7, “InfoPrint interfaces tasks,” on 

page 41 for information on the tasks you can perform with the InfoPrint Manager 

interfaces. 

Note: Even if all printers in your environment are driven exclusively by host 

systems through PSF Direct, you should initially set up one printer to be driven by 

InfoPrint Manager. You can use this printer to verify that InfoPrint Manager is 

functioning properly. 

Creating a destination driven by InfoPrint Manager 

Use the InfoPrint Manager Administration GUI to create these types of actual 

destinations. The InfoPrint Manager Administration GUI provides wizard support 

for creating the following types of printers: 

v   “PSF TCP/IP printer” on page 68 

v   “PSF Channel printer” on page 69 

v   “PSF Command printer” on page 70 

v   “PSF Other-Driver printer” on page 72 

v   “Passthrough printer” on page 74 

v   “BSD printer” on page 76 

v   “IPP printer” on page 78

When you use the wizard to create any of the PSF printers (PSF TCP/IP, PSF 

Channel, PSF Command, or PSF Other), the wizard sets default values for some of 

the attributes of the printer. The attributes and their associated default values are 

listed below. 

media-supported 

Only set when the printer is not an SNMP printer. Default values vary 

depending on the printer model you select. 
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Table 8. Default printer values using the wizard 

Printer Values 

InfoPrint 70 v   letter (8.5 x 11 inch) 

v   legal (8.5 x 14 inch) 

v   ledger (11 x 17 inch) 

v   executive (7.25 x 10.5 inch) 

v   folio (8.5 x 13 inch) 

v   statement (5.5 x 8.5 inch) 

v   A3 (297 x 419 mm)  

v   A4 (210 x 297 mm)  

v   A5 (148 x 210 mm)  

v   jis-b4-white (257 x 364 mm) 

v   jis-b5-white (182 x 257 mm) 

v   8.5 x 12.4 inch 

v   9 x 11 inch 

v   12 x 18 inch 

InfoPrint 1116, InfoPrint 1120, InfoPrint 1125, 

InfoPrint 1130, InfoPrint 1140, InfoPrint 

Color 1220, InfoPrint Color 1228 

v   letter (8.5 x 11 inch) 

v   legal (8.5 x 14 inch) 

v   executive (7.25 x 10.5 inch) 

v   folio (8.5 x 13 inch) 

v   statement (5.5 x 8.5 inch) 

v   A4 (210 x 297 mm)  

v   A5 (148 x 210 mm)  

v   jis-b5-white (182 x 257 mm) 

v   7.75 inch envelope (98 x 191 mm) 

v   9 inch envelope (98 x 225 mm) 

v   Commercial #10 envelope (104.8 x 241.3 

mm)  

v   C5 envelope (169 x 229 mm)  

v   B5 envelope (176 x 250 mm)  

v   DL envelope (110 x 220 mm)  

InfoPrint 1145 v   letter (8.5 x 11 inch) 

v   legal (8.5 x 14 inch) 

v   executive (7.25 x 10.5 inch) 

v   folio (8.5 x 13 inch) 

v   statement (5.5 x 8.5 inch) 

v   ledger/tabloid (11 x 17 inch) 

v   A3 (297 x 419 mm)  

v   A4 (210 x 297 mm)  

v   A5 (148 x 210 mm)  

v   jis-b5-white (182 x 257 mm) 

v   jis-b4-white (257 x 364 mm) 

v   Universal 
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Table 8. Default printer values using the wizard (continued) 

Printer Values 

InfoPrint 2000 AFP  v   letter (8.5 x 11 inch) 

v   legal (8.5 x 14 inch) 

v   ledger/tabloid (11 x 17 inch) 

v   manual (9 x 12 inch) 

v   A3 (297 x 419 mm) 

v   A4 (210 x 297 mm) 

v   B4 

v   RA3  

v   RA4  

v   8 x 10 inch 

v   8 x 10.5 inch 

v   8.5 x 10 inch 

v   12 x 18 inch 

v   14 x 17 inch 

v   14 x 18 inch 

v   letter-tab (9 x 11 inch) 

v   a4-tab (8.86 x 11.69 inch) 

v   legal-tab (9 x 14 inch) 

All  other printer models v   letter (8.5 x 11 inch) 

v   legal (8.5 x 14 inch) 

v   tabloid (11 x 17 inch) 

v   ledger (11 x 17 inch) 

v   A3 (297 x 419 mm) 

v   A4 (8.27 x 11.69 inch) 

v   jis-b4-white (257 x 364 mm)  

v   jis-b5-white (182 x 257 mm)
  

sides-supported 

Only set when the printer is not an SNMP printer. Set to 1 and 2 

plexes-supported 

Only set when the printer is not an SNMP printer. Set to simplex and 

tumble. 

printer-resolutions-supported 

Set to 240, 300, 480, and 600.

If  you are running with the Basic InfoPrint Manager GUI, InfoPrint Manager sets 

the defaults shown in Table 9 also. 

 Table 9. Basic InfoPrint Manager Administration GUI  defaults for PSF printers 

Attribute Default values 

printer-resolutions-ready 600 

booklet-fold (set only for InfoPrint 4000) down 

optimize-for-multiple-copies (set only for 

InfoPrint 4000) 

true 

start-sheets-supported job-ticket 

printer-start-sheet job-ticket 

form-definition F100D 

accounting-exit accounting-log
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PSF TCP/IP printer 

Create a PSF actual destination to represent an Intelligent Printer Data Stream™ 

(IPDS) printer. Use the TCP/IP attachment type for an IPDS printer that PSF 

controls directly through TCP/IP. 

Before creating a PSF TCP/IP printer, complete the following worksheet. 

 Table 10. PSF TCP/IP printer worksheet 

Wizard Prompt Description Value 

Name  The name for the actual 

destination object (8 

character limit). 

Note: This name is 

case-sensitive. 

Server The InfoPrint server that 

controls this actual 

destination. By default, the 

server name is the same as 

the name of the system 

where the server is installed. 

Note: This name is 

case-sensitive. 

Model Select the printer model from 

the pull-down list in the 

InfoPrint Manager 

Administration GUI.  If the 

printer you are working with 

is not in the pull-down list, 

enter the name as it appears 

on the printer. 

TCP/IP address The dotted-decimal IP 

address used to access this 

printer. 

TCP/IP port The port used by the printer 

for communication. The 

InfoPrint 1000 family of 

printers uses port 9100. Most 

other printers default to port 

5001. The value you use here 

must match the value set at 

the printer. 

Logical destination The logical destination that 

directs jobs to this actual 

destination. 

Note: This name is 

case-sensitive. 

__ Default __ Other: 

Logical destination’s server The InfoPrint server that 

contains the logical 

destination. 

Note: This name is 

case-sensitive. 
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Table 10. PSF TCP/IP printer worksheet (continued) 

Wizard Prompt Description Value 

Queue The queue that holds jobs 

destined for this actual 

destination. 

Note: This name is 

case-sensitive. 

__ Default __ Other:

  

To create this type of printer, use the Create Printer Wizard in the InfoPrint 

Manager Administration GUI. (On the menu bar, click Printer → Create → PSF → 

TCP/IP.) 

Note: If TCP/IP is not shown in the Printer → Create → PSF menu, use Printer → 

Add/Remove Menu Items to add it. 

Table 10 on page 68 provides the information that the wizard prompts for. For 

assistance, refer to the InfoPrint Manager Administration GUI online help. 

If you did not enable the printer with the Create Printer Wizard, use the InfoPrint 

Manager Administration GUI to enable it. 

PSF Channel printer 

Create a PSF actual destination to represent an IPDS printer on a Windows 2000 

system. Use the channel attachment type for an IPDS printer that PSF controls 

directly through an IBM 4159 Model 001 S/390 Parallel Channel Emulator Card. 

Before creating a PSF channel printer, complete the following worksheet. 

 Table 11. PSF Channel printer worksheet 

Wizard Prompt Description Value 

Name  The name for the actual 

destination object (8 

character limit). 

Note: This name is 

case-sensitive. 

Server The InfoPrint server that 

controls this actual 

destination. The server name 

is the same as the name of 

the system where the server 

is installed. 

Note: This name is 

case-sensitive. 

Model Select the printer model from 

the pull-down list in the 

InfoPrint Manager 

Administration GUI.  If the 

printer you are working with 

is not in the pull-down list, 

enter the name as it appears 

on the printer. 
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Table 11. PSF Channel printer worksheet (continued) 

Wizard Prompt Description Value 

Channel device address The two-digit hexadecimal 

control-unit address assigned 

to the physical print device 

hardware. Consult printer 

documentation for 

instructions on how to 

determine this value. 

Channel slot number The system slot number 

where the channel card is 

installed. If more than one 

channel card is installed, 

consult “Installing more than 

one IBM 4159 card” on page 

37 to determine the correct 

value. Otherwise, the default 

value of “1” is appropriate. 

Logical destination The logical destination that 

directs jobs to this actual 

destination. 

Note: This name is 

case-sensitive. 

__ Default __ Other: 

Logical destination’s server The server that contains the 

logical destination. 

Note: This name is 

case-sensitive. 

Queue The queue that holds jobs 

destined for this actual 

destination. 

Note: This name is 

case-sensitive. 

__ Default __ Other:

  

To create this type of printer, use the Create Printer Wizard in the InfoPrint 

Manager Administration GUI. (On the menu bar, click Printer → Create → PSF → 

Channel.) 

Note: If the Channel is not shown in the Printer → Create → PSF menu by default, 

use Printer → Add/Remove Menu Items to add it. 

Table 11 on page 69 provides the information as prompted by the wizard. For 

assistance, refer to the InfoPrint Manager Administration GUI online help. 

If you did not enable the printer with the Create Printer Wizard, use the InfoPrint 

Manager Administration GUI to enable it. 

PSF Command printer 

Use the command attachment type for a PCL printer that receives data streams 

transformed by PSF from a print command. 
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Before creating a PSF Command printer, complete the following worksheet. 

 Table 12. PSF command printer worksheet 

Wizard Prompt Description Value 

Name  The name for the actual 

destination object (8 

character limit). 

Note: This name is 

case-sensitive. 

Server The InfoPrint server that 

controls this actual 

destination. The server name 

is the same as the name of 

the system where the server 

is installed. 

Note: This name is 

case-sensitive. 

Model Select the printer model from 

the pull-down list in the 

InfoPrint Manager 

Administration GUI.  If the 

printer you are working with 

is not in the pull-down list, 

enter the name as it appears 

on the printer. 

SNMP  TCP/IP address The dotted-decimal IP 

address used to access this 

printer. This value is used 

only for SNMP  printers. 

Device The AIX  device name. This is 

not applicable for Windows. 

Leave blank. 

Printer command The command string used to 

send a job to the appropriate 

Windows printer. For 

example, lpr -S serverName 

-P printerName. 

Note: This command is 

case-sensitive. 

Data stream The data stream expected by 

the printing device (for 

example, PCL5 or PCL 6). 

Logical destination The logical destination that 

directs jobs to this actual 

destination. 

Note: This name is 

case-sensitive. 

__ Default __ Other: 

Logical destination’s server The InfoPrint server that 

contains the logical 

destination. 

Note: This name is 

case-sensitive. 

Queue The queue that holds jobs 

destined for this actual 

destination. 

Note: This name is 

case-sensitive. 

__ Default __ Other: 
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Table 12. PSF command printer worksheet (continued) 

Wizard Prompt Description Value 

Note: Prior to using this worksheet to create your InfoPrint Manager actual destination, 

you may  need to use the standard Windows Add  Printer Wizard to make the printer 

available.
  

To create this type of printer, use the Create Printer Wizard in the InfoPrint 

Manager Administration GUI. (On the menu bar, click Printer → Create → PSF → 

Command.) 

Note: If the Command is not shown in the Printer → Create → PSF menu, use 

Printer → Add/Remove Menu Items to add it. 

Table 12 on page 71 provides the information as prompted by the wizard. For 

assistance, refer to the InfoPrint Manager Administration GUI online help. 

If you did not enable the printer with the Create Printer Wizard, use the InfoPrint 

Manager Administration GUI to enable it. 

PSF Other-Driver printer 

Create a PSF other-driver actual destination to represent a PCL printer that receives 

data streams transformed by PSF through a Windows port monitor. 

Note: The InfoPrint Manager Administration GUI calls a PSF other-driver actual 

destination or printer, a PSF other printer. 

Before you create a PSF other-driver printer, you must create a Windows port that 

InfoPrint Manager will use to communicate with the printer. Use the InfoPrint 

Manager Management Console to create a Windows port with these steps: 

1.   Click the Windows Start button and select Programs → Infoprint Manager → 

Management Console. 

2.   Select Edit → New → Windows Port. 

3.   In the Create Windows Port dialog, select the appropriate port monitor for 

your printing environment from the pull-down list and click OK. 

For example, if you are using an InfoPrint network-attached workgroup printer, 

such as the InfoPrint 20, as a non-IPDS printer, you should use the IBM 

TCP/IP Network Port Monitor. 

Note: The port monitor that you select determines the next dialog to appear.

Before  creating a PSF other-driver printer, complete the following worksheet. 

 Table 13. PSF other-driver printer worksheet 

Wizard Prompt Description Value 

Name  The name for the actual 

destination object (8 

character limit). 

Note: This name is 

case-sensitive. 
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Table 13. PSF other-driver printer worksheet (continued) 

Wizard Prompt Description Value 

Server The InfoPrint server that 

controls this actual 

destination. The server name 

is the same as the name of 

the system where the server 

is installed. 

Note: This name is 

case-sensitive. 

Model On either a Windows or an 

AIX  server, select the printer 

model from the pull-down 

list in the InfoPrint Manager 

Administration GUI.  

If the printer you are 

working with is not in the 

pull-down list, enter the 

name as it appears on the 

printer; or if the printer is 

SNMP-enabled, you can 

select Set by SNMP  printer. 

SNMP  TCP/IP address The dotted-decimal IP 

address used to access this 

printer. This value is used 

only for SNMP  printers. 

Device or Windows port 

name 

The name of the output 

device that the selected 

actual destination represents. 

Printer command The printer command that 

submits a job to this remote 

destination. 

On a Windows system, leave 

this column blank. 

Data stream The data stream output by 

PSF when a job is 

transformed. 

Logical destination The logical destination that 

directs jobs to this actual 

destination. 

Note: This name is 

case-sensitive. 

__ Default __ Other: 

Logical destination’s server The InfoPrint server that 

contains the logical 

destination. 

Note: This name is 

case-sensitive. 

Queue The queue that holds jobs 

destined for this actual 

destination. 

Note: This name is 

case-sensitive. 

__ Default __ Other:

  

To create this type of printer, use the Create Printer Wizard in the InfoPrint 

Manager Administration GUI. (On the menu bar, click Printers → Create → PSF → 

Other.) 
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Note: If Other is not shown in the Printer → Create → PSF menu, use Printer → 

Add/Remove Menu Items to add it. 

Table 13 on page 72 provides the information that the wizard prompts for, When a 

PSF Other-Driver printer is created, a Windows Passthrough printer is created 

automatically. Therefore, the Windows Generic/Text printer driver is required. If 

you have not installed the Windows Generic/Text Printer driver before, you must 

install it by following the installation instructions in ″Passthrough printer″. 

Refer to the InfoPrint Manager Administration GUI online help for more 

assistance. 

If you did not enable the printer with the Create Printer Wizard, use the InfoPrint 

Manager Administration GUI to enable it. 

Passthrough printer 

Create a Passthrough actual destination to represent a printer that receives 

untransformed data streams through a Windows port monitor; for example, to 

send PostScript data to a PostScript printer or to send PCL data to a PCL printer 

without transforming it. When creating a Passthrough printer, the sides actual 

destination attribute must be set to the default duplexing value set on the printer. 

Note: By default, the Passthrough DSS supports only the following data streams: 

v   ASCII 

v   iso-6429 

v   PCL 

v   PostScript 

v   PPDS 

v   simple-text (text)

To  create a Passthrough actual destination, complete the following four steps. 

1.   Install the Windows Generic/Text Only printer driver. 

a.   Use the Windows Add Printer Wizard to create a local printer. 

b.   When you have to choose a port, select FILE:. 

c.   When you have to choose the manufacturer and model of the printer, select 

Generic from the list of manufacturers and Generic/Text Only from the list 

of models. 

d.   Finish the wizard, selecting not to share the printer and not to print a test 

page. 

e.   When you are finished, you can delete the printer; the driver will still be 

installed.
2.   Attach the printer device as specified by its documentation. 

3.   Define a Windows port. 

If you already have a Windows port defined, you are ready to create your 

Passthrough printer. If you need to create a Windows port, use the InfoPrint 

Manager Management Console to create a Windows port to communicate with 

the printer device as follows: 

a.   Open the Start menu and click Programs → Infoprint Manager → 

Management Console. 

b.   Select Edit → New → Windows Port. 
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c.   In the Create Windows Port dialog, select the appropriate port monitor for 

your printing environment from the pull-down list and click OK. 

v   If you are using an InfoPrint 1000 family printer (InfoPrint 1116, 1120, 

1125, 1130, 1140, 1145, 1220, or 1228), use the Lexmark TCP/IP Network 

Port Monitor. If the Lexmark TCP/IP Network Port Monitor doesn’t 

appear on the list, you must install it from the CD-ROM that came with 

your printer first. 

v   If you are using another InfoPrint network-attached workgroup printer, 

such as the InfoPrint 20, use the IBM TCP/IP Network Port Monitor.

Note:  The port monitor that you select determines the next dialog to 

appear. 

d.   Fill in the information that the dialog requires and click OK.
4.   Create a Passthrough printer by completing the worksheet Table 14 and using 

the Create Printer Wizard in the InfoPrint Manager Administration GUI. (On 

the menu bar, click Printer → Create → Passthrough.) 

Note: If Passthrough is not shown in the Printer → Create menu, use Printer → 

Add/Remove Menu Items to add it. 

Table 14 provides the information as prompted by the wizard. For assistance, 

refer to the InfoPrint Manager Administration GUI online help. 

If you did not enable the printer with the Create Printer Wizard, use the 

InfoPrint Manager Administration GUI to enable it. 

To print a test page, see Chapter 14, “Printing a test job,” on page 95.

 Table 14. Passthrough destination worksheet 

Wizard Prompt Description Value 

Name  The name for the actual 

destination object. For 

example, the name you will 

use for the passthrough 

printer you just attached. 

Note: This name is 

case-sensitive. 

Server The server that controls this 

actual destination. The server 

name is the same as the 

name of the system where 

the server is installed. 

Note: This name is 

case-sensitive. 
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Table 14. Passthrough destination worksheet (continued) 

Wizard Prompt Description Value 

Windows port name The name of the Windows 

port to assign to this 

destination. Enter the 

Windows port name that you 

want to use exactly as it 

appears to Windows. To 

determine what ports exist 

on your server, open the 

Start menu and click Settings 

→ Printers. On the Printers 

dialog, click on the File menu 

and click on Server 

Properties. The Print Server 

Properties dialog box 

appears where you can click 

on the Ports to display the 

list of available ports. 

TCP/IP address The dotted-decimal IP 

address used to access this 

printer. This value is used for 

SNMP  printers only. 

Logical destination The logical destination that 

directs jobs to this actual 

destination. 

Note: This name is 

case-sensitive. 

__ Default __ Other: 

Logical destination’s server The InfoPrint server that 

contains the logical 

destination. 

Note: This name is 

case-sensitive. 

Queue The queue that holds jobs 

destined for this actual 

destination. 

Note: This name is 

case-sensitive. 

__ Default __ Other:

  

BSD printer 

Create a BSD actual destination when you need to configure a terminating 

transform at the actual destination or when no other DSS is suitable. The BSD DSS 

gives you less control of the printer and reports less accurate job status than the 

other DSSs. 

Before creating a BSD printer, complete the following worksheet. 

 Table 15. BSD printer worksheet 

Wizard Prompt Description Value 

Name  The name for the actual 

destination object. 

Note: This name is 

case-sensitive. 
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Table 15. BSD printer worksheet (continued) 

Wizard Prompt Description Value 

Server The InfoPrint server that 

controls this actual 

destination. The server name 

is the same as the name of 

the system where the server 

is installed. 

Note: This name is 

case-sensitive. 

SNMP  TCP/IP address The dotted-decimal IP 

address used to access this 

printer. This value is used 

only for SNMP  printers. 

Printer command The command to issue to 

submit a job to this remote 

destination. Typically, this is 

a call to the lpr command. 

For example, lpr -S 

serverName -P printerName. 

Note: This command is 

case-sensitive. 

Data stream The data stream expected by 

the printed device (for 

example, PCL5 or PCL6). 

Logical destination The logical destination that 

directs jobs to this actual 

destination. 

Note: This name is 

case-sensitive. 

__ Default __ Other: 

Logical destination’s server The InfoPrint server that 

contains the logical 

destination. 

Note: This name is 

case-sensitive. 

Queue The queue that holds jobs 

destined for this actual 

destination. 

Note: This name is 

case-sensitive. 

__ Default __ Other:

  

To create this type of printer, use the Create Printer Wizard in the InfoPrint 

Manager Administration GUI. (On the menu bar, click Printer → Create → BSD.) 

Note: If BSD is not shown in the Printer → Create menu, use Printer → 

Add/Remove Menu Items to add it. 

Table 15 on page 76 provides the information as prompted by the wizard. For 

assistance, refer to the InfoPrint Manager Administration GUI online help. 

Note: When you use the lpr command with a BSD actual destination, the printer 

prints only single-document jobs. If you send a BSD actual destination a 

multiple-document job, only the last document in the job prints.
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If you did not enable the printer with the Create Printer Wizard, use the InfoPrint 

Manager Administration GUI to enable it. 

IPP printer 

Create an IPP actual destination to represent a printer that supports the Internet 

Printing Protocol (IPP). The printer must have an assigned uniform resource 

indicator (URI). When creating an IPP printer, the sides actual destination attribute 

must be set to the default duplexing value set on the printer. 

Before creating an IPP printer, complete the following worksheet. 

 Table 16. IPP destination worksheet 

Wizard Prompt Description Value 

Name  The name for the actual 

destination object. This is the 

printer URL, for example, 

np17.prtrm4.bldr.infoprint.com. 

Note: This name is 

case-sensitive. 

Server The server that controls this 

actual destination. The server 

name is the same as the name 

of the system where the server 

is installed. 

Note: This name is 

case-sensitive. 

URL  The universal resource locator 

(URL)  for this destination. 

TCP/IP address The dotted-decimal IP address 

used to access this printer. 

This value is used for SNMP  

printers only. 

Logical destination The logical destination that 

directs jobs to this actual 

destination. 

Note: This name is 

case-sensitive. 

__ Default __ Other: 

Logical destination’s server The InfoPrint server that 

contains the logical 

destination. 

Note: This name is 

case-sensitive. 

Queue The queue that holds jobs 

destined for this actual 

destination. 

Note: This name is 

case-sensitive. 

__ Default __ Other:

  

To create this type of printer, use the Create Printer Wizard in the InfoPrint 

Manager Administration GUI. (On the menu bar, click Printer → Create → IPP.) 

Note: If IPP is not shown in the Printer → Create menu, use Printer → 

Add/Remove Menu Items to add it.
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Table 16 on page 78 provides the information as prompted by the wizard. For 

assistance, refer to the InfoPrint Manager Administration GUI online help. 

If you did not enable the printer with the Create Printer Wizard, use the InfoPrint 

Manager Administration GUI to enable it. 

Creating a PSF Direct Only destination 

To create a PSF Direct Only actual destination, you must run the InfoPrint 

Manager Management Console as described in “Starting the InfoPrint Manager 

Management Console” on page 49. The InfoPrint Manager Management Console 

provides support for creating the following types of printers to be driven 

exclusively by PSF Direct: 

v   “PSF Direct Only TCP/IP printer” 

v   “PSF Direct Only channel printer” on page 80 

v   “PSF Direct Only non-IPDS printer” on page 80

PSF Direct Only TCP/IP printer 

If you want to set up a TCP/IP-attached printer to accept jobs only from 

mainframe host systems, you should first complete the following worksheet. 

 Table 17. PSF Direct Only TCP/IP printer worksheet 

Management Console 

Prompt 

Description Value 

Destination The name for the actual 

destination object (8 

character limit). 

Note: This name is 

case-sensitive. 

TCP/IP Internet Address The dotted-decimal IP 

address used to access this 

printer. 

TCP/IP Port Number The port used by the printer 

for communication. The 

InfoPrint 1000 family of 

printers uses port 9100. Most 

other InfoPrint printers use 

port 5001. 

Connection Timeout Number of seconds that the 

server will try to establish a 

connection with the 

destination before 

terminating the PSF Direct 

session. 

Intervention Timer Number of seconds that the 

server will wait for a 

problem at the printer (for 

example, “Printer out of 

paper”) to be resolved before 

canceling a job. 

  

Use the InfoPrint Manager Management Console to create the actual destination. 

For assistance, refer to the Management Console online help. 
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PSF Direct Only channel printer 

If you want to set up a channel-attached printer on a Windows 2000 system to 

accept jobs only from mainframe host systems, you should first complete the 

following worksheet. 

 Table 18. PSF Direct Only channel printer worksheet 

Management Console 

Prompt 

Description Value 

Destination The name for the actual 

destination object (8 

character limit). 

Note: This name is 

case-sensitive. 

Channel Device Address The two-digit hexadecimal 

control-unit address assigned 

to the physical print device 

hardware. Consult printer 

documentation for 

instructions on how to 

determine this value. 

Channel Slot Number The system slot number 

where the channel card is 

installed. If more than one 

channel card is installed, 

consult “Installing more than 

one IBM 4159 card” on page 

37 to determine the correct 

value. Otherwise, the default 

value of “1” is appropriate. 

Intervention Timer Number of seconds that the 

server will wait for a 

problem at the printer (for 

example, “Printer out of 

paper”) to be resolved before 

canceling a job. 

  

Use the InfoPrint Manager Management Console to create the actual destination. 

For assistance, refer to the Management Console online help. 

PSF Direct Only non-IPDS printer 

This type of printer is a streamlined command printer. If you want to set up a 

non-IPDS printer to accept jobs only from mainframe host systems, you should 

first complete the following worksheet. 

 Table 19. PSF Direct Only non-IPDS printer worksheet 

Management Console 

Prompt 

Description Value 

Destination The name for the actual 

destination object (8 

character limit). 

Note: This name is 

case-sensitive. 
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Table 19. PSF Direct Only non-IPDS printer worksheet (continued) 

Management Console 

Prompt 

Description Value 

Data Stream The data stream expected by 

the printing device (PCL4, 

PCL5, PCL5C, or PPDS). 

Command to Print The command used to 

submit jobs to this 

destination. 

Note: This command is 

case-sensitive. 

Printer Memory The amount of memory 

available on the printer itself. 

  

Use the InfoPrint Manager Management Console to create the actual destination. 

For assistance, refer to the Management Console online help. 

Important Note: All printers created through the Management Console are not 

visible to the server and are not viewable using the Administration and 

Operations GUIs.
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Chapter  11.  Working  with  files  larger  than  2 gigabytes  

With InfoPrint Manager, a file that is larger than 2 gigabytes is considered a large 

file. 

This section includes: 

v   Which job submission clients are supported 

v   Which output methods are supported 

v   Which document formats are supported 

v   Which output formats are supported

Job submission clients supported 

 Client Windows AIX  

pdpr with AIX, Linux®, and 

Windows 

Supported Supported 

pdpr with HP-UX  and Sun 

Solaris 

Not  Supported Not  Supported 

hot folders Supported Supported 

InfoPrint Select Not  supported Not  supported 

Submit Express Not  supported Not  supported 

InfoPrint Job Ticketer Not  supported Not  supported 

IPP Gateway Not  supported Not  supported 

Windows Gateway Not  supported Not  supported
  

Output methods supported 

The output methods that support large files include: 

v   The PSF DSS is the only DSS that supports large files. PSF DSS attachments that 

support large files include: 

 Client Windows AIX  

TCP/IP Supported Supported 

Channel Supported N/A 

Command Supported Not  supported 

Other Supported Not  supported
  

Note:  

1.   The reverse-page-order actual destination and document/default document 

attributes are not supported for large files. 

2.   Jobs that will be processed by the Transform subsystem will support files 

greater than 2 gigabytes in size as long as the command that is being called 

has support for files greater than 2 gigabytes in size.
v    PSF Direct
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InfoPrint Manager document formats support for greater than 2 

gigabyte files 

 Document format Windows AIX  

MOD:CA  Supported Supported 

PostScript (see Notes® 1 and 

2) 

Supported Supported 

PCL  (see Note 1) Supported Supported 

PDF  Not  supported Not  supported 

Line data Supported Supported 

XML Not  supported Not  supported 

Xerox Not  supported Not  supported 

SAP  Not  supported Not  Supported 

PPML Not  supported Not  supported 

TIFF, JPEG, GIF  Not  supported Not  supported 

ASCII  Not  supported Not  supported 

Notes:  

1.   Embedded PostScript and PCL  objects in AFPDS  are not supported if the ps2afp or 

pcl2afp transform produces AFP  output that is greater than 2 gigabytes. 

2.   If you use the ps2afp transform stand-alone (command line with the -o option), it does 

not support files that are greater than 2 gigabytes in size.
  

InfoPrint Manager output format support for greater than 2 gigabyte 

files 

 Output format Windows AIX  

Booklet print Not  supported Not  supported 

Booklet print with integrated 

cover 

Not  supported Not  supported 

Side-by-side copies Not  supported Not  supported 

Slit-and-merge Supported Supported 

Simple-n-up Supported Supported
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Chapter  12.  Preparing  InfoPrint  Manager  to connect  to your  

host  system  

InfoPrint Manager provides various methods to configure printing from host 

systems. The most powerful methods are: PSF Direct, Distributed Print Function 

(DPF), and MVS Download. If you have not decided which method is best for 

your operation, refer to the InfoPrint Manager for Windows: Introduction and Planning 

Guide for descriptions and comparisons of the methods. You need to know which 

method you plan to use before you can create the connection between InfoPrint 

Manager and the host. 

All three of the InfoPrint Manager host printing options use host receivers to link 

the server to the host. There are three types of host receivers, one for each host 

printing method. Each type of receiver performs different functions. 

v   PSF Direct host receiver 

Accepts print jobs from a PSF on your host system and sends them to a PSF 

Direct destination without putting them into a queue. 

v   DPF host receiver 

Downloads print jobs and their resources from a PSF on your host system and 

submits them to an InfoPrint Manager PSF printer to be printed. To the host PSF, 

the DPF host receiver looks like a TCP/IP-attached IPDS printer, so you can 

submit jobs to it as you would to that type of printer. 

If your host operating system is MVS or VSE, the DPF host receiver stores all of 

the DPF Resources it receives in the DPF Resources database. If you have the 

Save resources function of the receiver turned on, all resources that were 

marked public on the host are shown in the DPF Resources view of the 

Management Console. Additional information about the Save resources function 

is available in the online help in the Management Console and in the InfoPrint 

Manager for Windows: Introduction and Planning Guide. 

v   MVS  Download receiver 

Receives print files and JCL parameters from the MVS host. The receiver applies 

a Destination Control File (DCF) to the JCL parameters and generates a 

corresponding list of InfoPrint parameters. The list of InfoPrint parameters is 

then passed to the MVS  Download Exit Program (or Exit) so InfoPrint Manager 

can process the job. 

The Exit is responsible for performing some action on the received file. Two 

sample exits are provided with InfoPrint Manager: one written in Microsoft 

Visual C++ Version 6.0 and one written in Microsoft Visual Basic Version 6.0. 

Both samples perform the same action: submit the file to InfoPrint Manager 

using pdpr and log any errors. The sample exits also stop the MVS  Download 

receiver if the pdpr fails. 

Note: MVS Download receivers don’t download AFP resources along with print 

jobs; AFP resources must already be available to InfoPrint Manager.

After you have created your actual destinations, use the appropriate procedure 

below to create the right type of host receivers on your InfoPrint Manager server. 

v   “Before you create a PSF Direct host receiver” on page 86 

v   “Before you create a DPF host receiver” on page 87 

v   “Before you create an MVS  Download host receiver” on page 91

 

© Copyright  InfoPrint  Solutions  Company  1998, 2007 85



Troubleshooting  host receivers 

All host receivers write their error messages to the server message log. If you start 

to have trouble with host printing, check the server error log for host receiver 

problems first. To see the server message log, open the Management Console and 

click the Server Log item in the left pane. 

Before you create a PSF Direct host receiver 

When you create a PSF Direct host receiver, you have to specify which InfoPrint 

Manager actual destination the host receiver will send jobs to. If you have not 

already created the actual destinations you need, refer to Chapter 10, “Creating 

actual destinations,” on page 65. 

Notes:  

1.   You must use the PSF DSS with PSF Direct. 

2.   If you currently use PSF Direct in PSF for OS/2, refer to the InfoPrint Manager 

for Windows: Introduction and Planning Guide for instructions on collecting the 

information you need from your OS/2 system. You can use the printer 

information that you collect to help create your InfoPrint Manager actual 

destinations.

Creating a PSF Direct host receiver 

1.   Complete the following configuration worksheet. 

Note: If you currently use PSF Direct in PSF for OS/2, refer to the InfoPrint 

Manager for Windows: Introduction and Planning Guide for instructions on 

collecting the information you need from your OS/2 system. 

 Table 20. PSF Direct host receiver worksheet 

Management Console 

Prompt 

Description Value 

SNA  logical unit alias name The local alias of the name 

used to start an SNA  

conversation with this host 

receiver. 

Actual destination name The name of the associated 

actual destination object. 

Note: This name is 

case-sensitive. 

Description Text to describe this receiver 

(optional). 

Inactivity limit Number of seconds to wait 

for jobs from a connected 

host before disconnecting. 

Device busy limit Number of seconds for host 

systems to wait for the 

printer to become available 

when it is in use by other 

print processes. 

  

2.   Open the InfoPrint Manager Management Console and select Edit → New → PSF 

Direct Host Receiver. 
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Refer to the Management Console help system if you need further information. 

3.   Use the information from the worksheet to complete the dialog and click OK. 

4.   To finish setting up your PSF Direct system, refer to the appropriate PSF Direct 

configuration guide for information about configuring your host system and 

configuring IBM SecureWay® Communications Server for Windows. The 

following configuration guides are available on your Publications CD-ROM and 

on the InfoPrint Solutions Company Web site: 

v   Configuring PSF Direct for an iSeries System 

v   Configuring PSF Direct for the 3174 Communications Controller 

v   Configuring PSF Direct for the 3172 Communications Controller 

v   Configuring PSF Direct for the 37xx Communications Controller

Before you create a DPF host receiver 

When you create a DPF host receiver, you have to specify which InfoPrint Manager 

actual destination the host receiver will send jobs to. If you have not already 

created the actual destinations you need, refer to Chapter 10, “Creating actual 

destinations,” on page 65. 

Notes:  

1.   You must use the PSF DSS with DPF. 

2.   If you have interoperating InfoPrint Manager servers, the actual destination 

that the host receiver submits jobs to and the logical destination that the actual 

destination is associated with must reside on the same server. 

3.   If you currently use DPF in PSF for OS/2, refer to the InfoPrint Manager for 

Windows: Introduction and Planning Guide for instructions on collecting the 

information you need from your OS/2 system. You can use the printer and 

spool information that you collect to configure your InfoPrint Manager actual 

destination.

DPF working directories 

Each DPF host receiver must have two working directories associated with it; one 

for jobs and one for resources. These directories can only be used by one host 

receiver and should be reserved exclusively for that host receiver; they should not 

be used by any other programs or for any other purpose. 

When you create a DPF host receiver, InfoPrint Manager will fill in default 

directory paths for the working directories. If you accept those directories, 

InfoPrint Manager will create them for you. However, if you want to store your 

resources somewhere else (for example, on a different hard drive or a different 

partition), you must create the directory yourself, before you create the host 

receiver. 

If you create your own directories, it is recommended that you create one directory 

named after the receiver, then two subdirectories inside it, one named Jobs and 

one named Resources. For example, if you plan to name your host receiver 

hr_ip4000, you would create a directory named hr_ip4000, then create the Jobs 

and Resources subdirectories under it. When you create your host receiver, you 

would type E:/hr_ip4000/Jobs for the Jobs directory and E:/ hr_ip4000/Resources 

for the Resources directory. 
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Creating a DPF host receiver 

1.   Complete the following configuration worksheets. Only the PSF actual 

destination and Port number values are required to create a receiver; if you’re 

not sure what to fill in for the rest of the items, you can accept the defaults and 

change the values in the receiver later. 

Note: If you currently use DPF in PSF for OS/2, refer to the InfoPrint Manager 

for Windows: Introduction and Planning Guide for instructions on collecting the 

information you need from your OS/2 system. 

 Table 21. DPF  host receiver worksheet 

Management Console 

Prompt 

Description Value 

Logical unit alias name The local alias of the name 

used to start an SNA  

conversation with this host 

receiver. Because DPF  

connects to InfoPrint 

Manager over TCP/IP 

instead of SNA,  you will not 

use the LU alias, however, 

knowing it will help you 

figure out the TCP/IP 

connection. 

PSF actual destination The name of the actual 

destination object that this 

receiver will send jobs to. 

Note: This name is 

case-sensitive. 

Port number The port that the host 

receiver will use to 

communicate with the host 

system. 

Description Text to describe this receiver 

(optional). 

Submission priority The relative importance of 

jobs submitted by this 

receiver. 1 is the highest 

priority; 100 is the lowest 

priority. 

Default: 50 

Inactivity limit Number of seconds to wait 

for jobs from a connected 

host before disconnecting. 

When the inactivity timer 

runs out, the receiver drops 

the connection with the host 

system. If the timer is set to 

9999, it will never run out. 

Default: 9999 
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Table 21. DPF  host receiver worksheet (continued) 

Management Console 

Prompt 

Description Value 

Save resources If Save resources is selected, 

the DPF  host receiver 

acknowledges the 

public/private settings on 

the DPF  resources that are 

downloaded with print jobs. 

Resources that were  marked 

public on the host are stored 

in the DPF  Resources 

Database for reuse later. 

Resources that were  marked 

private cannot be reused. If 

Save resources is not 

selected, all DPF  resources 

that are downloaded are 

considered private. 

__ yes __ no 

Obtain printer characteristics 

at start up 

If selected, the receiver 

checks the printer settings 

every time the receiver 

connects to a host PSF and 

communicates any changes 

to the host system. 

__ yes __ no 

Suppress start sheets Select to turn off the start 

sheets that InfoPrint 

Manager generates. 

__ yes __ no 

Suppress end sheets Select to turn off the trailer 

sheets that InfoPrint 

Manager generates. 

__ yes __ no 

Suppress separator sheets Select to turn off the 

separator sheets that 

InfoPrint Manager generates. 

__ yes __ no 

Jobs directory The directory that the host 

receiver stores print jobs in 

until they are printed. Refer 

to “DPF working directories” 

on page 87 for more 

information. 

Resources directory The directory that the host 

receiver stores job resources 

in. Refer to “DPF working 

directories” on page 87 for 

more information. 

  

 Table 22. DPF  host receiver class set up worksheet 

Receiver 

Class Copies Start page Disposition Retention Period 

__ v   Print 

__ v   Retain 

__ v   Print then 

Retain 

v   ___ Forever 

v   ___ Days 

v   ___ Hours 
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Table 22. DPF  host receiver class set up worksheet (continued) 

Receiver 

__ v   Print 

__ v   Retain 

__ v   Print then 

Retain 

v   ___ Forever 

v   ___ Days 

v   ___ Hours 

__ v   Print 

__ v   Retain 

__ v   Print then 

Retain 

v   ___ Forever 

v   ___ Days 

v   ___ Hours 

__ v   Print 

__ v   Retain 

__ v   Print then 

Retain 

v   ___ Forever 

v   ___ Days 

v   ___ Hours 

__ v   Print 

__ v   Retain 

__ v   Print then 

Retain 

v   ___ Forever 

v   ___ Days 

v   ___ Hours

  

2.   Open the InfoPrint Manager Management Console and select Edit → New → 

DPF Host Receiver. 

3.   Use the information from the worksheet to complete the dialog. Make sure you 

click Class Set Up to configure your receiver classes with the information from 

Table 22 on page 89. Click OK when you are finished. 

Refer to the Management Console help system if you need further information. 

Important: The first time you try to start this receiver and connect to your host 

system, make sure that the printer that it will submit jobs to is powered ON 

and is available. 

4.   Refer to “Settings on your host system” to create a printer that will submit jobs 

to this host receiver from your host system.

Settings on your host system 

To your host system, the DPF host receiver looks like a PSF TCP/IP printer. Use 

the appropriate guidelines below to define a TCP/IP printer in your host PSF. 

Before you begin, make sure you know: 

v   The IP address of the system that your InfoPrint Manager server is installed on. 

v   The port number that you assigned to the DPF host receiver when you created 

it.

Keep in mind that various PSF and TCP/IP settings will affect the performance of 

your printing system. Refer to the documentation for your host PSF to learn more  

about the parameters and settings that are available. 

PSF for z/OS 

Refer to Print Services Facility for z/OS: Customization (S544-5622) for information 

and instructions about defining a TCP/IP printer. When you have to enter the IP 

address of the printer, enter the IP address of your InfoPrint Manager server 

instead. When you define the printer, the port defaults to 5001; if your host 

receiver uses port 5001, you will not have to change it on your host system. 
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PSF/VM 

Define a Group 4 printer, using the IP address of your InfoPrint Manager server 

for the IPADDR keyword value and the port number of the DPF host receiver for 

the PORTNO keyword value. 

Additional information about TCP/IP support and defining a Group 4 printer is 

available on the InfoPrint Solutions Company Web site at http://
www.infoprint.com/. 

PSF for VSE 

Edit the PSF Startup job so that you use the IP address of your InfoPrint Manager 

server for the IPADDR parameter and the port number of the DPF host receiver 

for the PORTNO parameter. If your DPF host receiver uses port 5001 (the default 

port in PSF for VSE), you do not have to specify a value for the PORTNO 

parameter. 

Additional information about TCP/IP support for PSF for VSE is available on the 

InfoPrint Solutions Company Web site at http://www.infoprint.com/. 

PSF for iSeries 

Use the CRTDEVPRT (Create Device Description (Printer)) command to define a 

TCP/IP printer on your iSeries system. Use the IP address of your InfoPrint 

Manager server for the RMTLOCNAME value and the port that your DPF host 

receiver uses for the PORT value. For example, the following command defines a 

printer that can send IPDS data to a DPF host receiver using the TCP/IP protocol, 

assuming that the DPF host reciever uses port 5005, and the IP address of the 

InfoPrint Manager server is 9.34.746.882. 

CRTDEVPRT DEVD(IPMDPF) DEVCLS(*LAN) TYPE(*IPDS) MODEL(0) LANATTACH(*IP) 

AFP(*YES) PORT(5005) FONT(11) RMTLOCNAME(’9.34.746.882’) TEXT(’Sample 

InfoPrint Manager DPF printer writer’) 

Before you create an MVS Download host receiver 

When you create an MVS Download receiver, you have to specify which InfoPrint 

Manager actual destination the host receiver will send jobs to. If you have not 

already created the actual destinations you need, refer to Chapter 10, “Creating 

actual destinations,” on page 65. 

Creating an MVS Download receiver 

1.   Complete the following configuration worksheet. 

Note: Once you create an MVS Download receiver, you cannot change any of 

its attributes. If you are not certain which options to select or which DCF and 

Exit to use, skip to step 4. Create your MVS  Download receivers after you have 

reviewed the rest of the MVS Download configuration information.
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Table 23. MVS  Download host receiver worksheet 

Management Console 

Prompt 

Description Value 

Port Number The port assigned for 

communication with z/OS or 

MVS.  This value must be the 

same as the port assigned 

during configuration of the 

host system. 

Target Destination Name  The InfoPrint Manager 

logical destination to which 

jobs are routed from this 

receiver by default. This 

default may  be overridden 

with the appropriate z/OS or 

MVS job parameters and 

printer control file settings. 

In sample destination control 

file supplied with InfoPrint 

Manager, the value of MVS 

keyword DEST overrides 

whatever value you specify 

here. 

Note: This name is 

case-sensitive. 

Print Control File The file that contains the 

appropriate attributes for 

jobs submitted to this 

receiver. You may  use the 

default file, or you may  

point to a customized 

version of this default file. 

Exit Program Name  The program that processes 

jobs submitted to this 

receiver from the host and 

passes the jobs to the 

requested InfoPrint Manager 

destination. Typically, the 

default program 

o390dsubm.exe is used. 

Retain command files Indicate whether to save the 

command files for jobs that 

do not print correctly. 

__ yes __ no 

Process one file at a time Indicate whether InfoPrint 

Manager should wait for a 

previous job to complete 

before starting to process the 

next job. 

__ yes __ no

  

2.   Open the InfoPrint Manager Management Console and select Edit → New → 

MVS  Download Receiver. 

3.   Use the information from the worksheet to complete the dialog and click OK. 

Refer to the Management Console help system if you need further information. 

4.   To complete your MVS Download configuration, refer to InfoPrint Manager for 

Windows: Procedures, available on your Publications CD-ROM, and on the 

InfoPrint Solutions Company Web site at http://www.infoprint.com
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Chapter  13.  Synchronizing  InfoPrint  Manager  with  an  InfoPrint  

4000  or  an  InfoPrint  4100  

The cutter-trimmer-stacker (CTS) is a post-processing device used with high speed 

printers for paper handling. Perform the following procedure with the help of your 

InfoPrint service engineer (SE) to ensure that your InfoPrint 4000 or InfoPrint 4100 

and the CTS support the same media. 

1.   Use either InfoPrint Manager GUI to specify the media that the actual 

destination representing the InfoPrint 4000 or the InfoPrint 4100 supports. 

a.   Open the InfoPrint Manager GUI. 

b.   Click the InfoPrint 4000 or InfoPrint 4100 printer object in the tree window 

to select it. 

c.   Select Printer → Change Media to open the Change Media dialog. 

d.   Associate each tray with an appropriate media. Click Help for more 

information.
2.   On the printer, define forms that correspond to the media you specified in the 

previous step. Consider the settings in the following table as an example: 

 Medium Name  Printer_Form Name  Printing_Form Description 

letter na letter 2–up letter (8.5 by 11) 

legal na legal 2–up legal (8.5 by 14) 

ledger ledger 1–up (11 by 17)
  

3.   Set up the CTS for the dimensions required by the supported media. For 

example, to support ledger-sized paper, set up the CTS for an 11–inch cut 

width and a 14–inch cut length. The CTS may support a limited set of cut 

lengths and only one center slitting option.
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Chapter  14.  Printing  a test  job  

To submit a test job to a printer driven by InfoPrint Manager, you must first run 

the InfoPrint Manager Management Console. Then follow these steps: 

1.   Select Print Test Job from the Debug menu. The Print Test Job dialog box 

opens. 

2.   Select the type of test job (AFP, PCL, PostScript, or ASCII) and the target 

destination. 

3.   Click OK.

This should produce printed output on the destination device. If it does not, you 

may wish to check the status of the job in the InfoPrint Manager Administration 

GUI. 

If you have created a PSF Direct Only destination, the only way to submit a test 

job is through PSF on the host system. All versions of PSF include suitable test 

jobs. Consult your host PSF documentation for details on submitting test jobs. 
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Part  3. Getting  started  with  client  systems  
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Chapter  15.  InfoPrint  Manager  GUI  software  

When you install the InfoPrint Manager Server, you automatically install the 

standard InfoPrint Manager GUIs: the InfoPrint Manager Administration GUI and 

the InfoPrint Manager Operations GUI. You can also install two additional GUIs: 

the Basic InfoPrint Manager Administration GUI and the Basic InfoPrint Manager 

Operations GUI. The Operations GUIs provide a subset of the functionality 

available in the Administration GUIs. (The Basic GUIs are installed with the 

Print-on-Demand feature, or you can install them from the Infoprint Manager: 

Common Clients CD-ROM, LCD4-1917.) 

You can also install the interfaces on a suitable Windows system. The system does 

not need to have the InfoPrint Manager server software installed. 

Follow the procedures in this section if you want to use InfoPrint Manager GUI 

software to administer or control your InfoPrint Manager server from a remote 

system. 

Preparing to install the GUIs 

With PTF UO04346, both InfoPrint Manager GUIs require the IBM 32-bit Runtime 

Environment for Windows, Java 2 Technology Edition, Version 1.4.22, at the 

appropriate build level. This is the only supported level of the Runtime 

Environment for running the InfoPrint Manager GUIs. If you have a previous 

version of the InfoPrint Manager GUIs, you do not need to uninstall them before 

you install the new Runtime Environment and the new GUIs. 

Important: Since the install process for InfoPrint Select requires a reboot, if you 

plan to install one or both of the InfoPrint Manager GUIs as well as InfoPrint 

Select, you may wish to install the GUI(s) first. 

v    To verify that you have the correct version of the Runtime Environment 

installed, follow these steps: 

1.   Type java -fullversion at an MS-DOS command line. 

2.   Verify that output from the command contains the following text: 

J2RE 1.4.2 IBM Windows 32 build cn142-20060824 (SR6) 

or 

J2RE 1.5.0 IBM Windows 32 build pwi32dev-20060511 (SR2) 

v    If necessary, follow these steps to install the required Runtime Environment: 

1.   Insert the Infoprint Manager: Common Clients CD-ROM, LCD4-1917, into 

the drive. The install program will start automatically. 

2.   Select the Infoprint Manager Clients button, and then select the Java™ 

Runtime Environment 1.4.2 or 1.5.0 button. 

3.   Provide information as prompted by the installation program. When the 

installer asks if you want to install the Runtime Environment as the system 

Java Virtual Machine (JVM), answer Yes.

2. When  you work  with the  InfoPrint  Manager  GUIs  on the  InfoPrint  Server, you use  Version 1.4.2 Service Release 6; and when  you 

work  with the  InfoPrint  Manager  GUIs  on an InfoPrint  Client, you can use  Version 1.4.2 Service Release 6 or Version 5.0  Service 

Release 2. Both  versions  are available on the  Infoprint  Common  Clients CD. 
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v    When the installation is complete, verify that you have the correct version of 

the Runtime Environment installed: 

1.   Type java -fullversion at an MS-DOS command line. 

2.   Verify that the output from the command contains the following text: 

J2RE 1.4.2 IBM Windows 32 build cn142-20060824 (SR6) 

or 

J2RE 1.5.0 IBM Windows 32 build pwi32dev-20060511 (SR2) 

Using the basic view of the GUI 

The basic view of the InfoPrint Manager GUI is a simplified version of the GUI 

that shows jobs assigned to printers without displaying queues. The basic printing 

environment is generally appropriate for commercial print shops printing large 

runs of image data (usually in PostScript or TIFF format). 

In a basic printing environment, InfoPrint Manager assigns jobs to printers through 

early binding. Early binding is much like standing in a checkout line at a 

supermarket. Once you pick a line, you “bind” yourself to it, no matter what 

happens. Whether the cashier has a problem with the cash register (much like a 

paper jam occurring in the physical printer) or the customer in front of you 

requires a few price checks (much like adding new forms to the server), the only 

way to change your position is to physically move to another line (much like 

manually moving a job from one print queue to another). 

If you have not installed the Print-on-Demand feature and want to use the basic 

view of the InfoPrint Manager GUI, complete the following steps in the standard 

view of the GUI: 

v   Create a queue named <servername>-default-queue, where <servername> refers 

to the name of the server you are using, and attach up to ten printers. 

1.   Select Queue → Create. 

2.   Enter <servername>-default-queue in the Name field. 

3.   Click OK to create the queue.
v    Specify early binding as the default. 

1.   Select the <servername>-default-queue. 

2.   Select Queue → Properties to open the Queue Properties notebook. 

3.   In the General tab, click Yes in the Preassign jobs to actual destination field. 

4.   Click OK or Apply to make the change.

Note: By default, the basic server saves the output files from jobs converted to 

raster image patterns. If you want this behavior, use the GUI to set the value of the 

attribute to true by selecting Server → Properties. In the General tab of the Server 

Properties notebook, make sure that the Save ripped files field is set to Yes. 

Installing the Operations GUI 

If you are reinstalling or updating an existing version of the InfoPrint Manager 

Operations GUI, close all instances of the InfoPrint Manager Administration GUI 

and InfoPrint Manager Operations GUI that are running on this system before you 

continue with the installation to avoid problems with files that need to be replaced. 
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Ensure that the InfoPrint Manager Server is at the same level or at a higher level of 

service than the InfoPrint Manager Operations GUI. Otherwise, you may receive 

error messages like: 5010-625 Cannot recognize attribute .... 

Follow these steps to install the InfoPrint Manager Operations GUI software. 

1.   Insert the Infoprint Manager: Common Clients CD-ROM, LCD4-1917, into the 

drive. The install program starts automatically. 

2.   Select Install Infoprint Manager Clients → Infoprint Manager GUIs, and then 

select the Operations GUI button. 

3.   Follow the instructions on the installation screens, paying attention to the 

following guidelines: 

v   The InfoPrint Manager Operations GUI is the recommended version. You can 

also choose to use the Basic version. See “Using the basic view of the GUI” 

on page 100 for more information. 

v   The InfoPrint Manager Operations GUI requires approximately 24 MB of 

space on your hard drive, whether you install one view or both. 

v   If you are installing over a previous version of InfoPrint Manager GUI 

software or you have already installed another GUI, a window will appear 

that gives you the option to modify the current installation. Select the 

Modify button, and leave the checkboxes checked for the components that 

are already installed. 

v   If you are installing over a previous version of the InfoPrint Manager GUI 

software, click yes for any questions about replacing files. If you will be 

using this GUI to work with an InfoPrint Manager for Windows server, you 

do not need to change any of the selections from the default values. 

v   You should install the DCE version of the InfoPrint Manager GUIs only if 

you will be using them to work with the DCE version of InfoPrint Manager 

for AIX. 

v   If you change your system language, the interface displays properly in the 

new language.

Installing the Administration GUI 

If you are reinstalling or updating an existing version of the InfoPrint Manager 

Administration GUI, close all instances of the InfoPrint Manager Administration 

GUI and InfoPrint Manager Operations GUI that are running on this system before 

you continue with the installation to avoid problems with files that need to be 

replaced. 

Ensure that the InfoPrint Manager Server is at the same level or at a higher level of 

service than the InfoPrint Manager Administration GUI. Otherwise, you may 

receive error messages like: 5010-625 Cannot recognize attribute .... 

Follow these steps to install the InfoPrint Manager Administration GUI software. 

1.   Insert the Infoprint Manager Common Clients CD-ROM into the drive. The 

install program will start automatically. 

2.   Select Install Infoprint Manager Clients → Infoprint Manager GUIs, and then 

select the Administration GUI button. 

3.   Follow the instructions on the installation screens, paying attention to the 

following guidelines. 
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v   The InfoPrint Manager Administration GUI is the recommended version. You 

can also choose to use the Basic version. See “Using the basic view of the 

GUI” on page 100 for more information. 

v   The InfoPrint Manager Administration GUI requires approximately 24 MB of 

space on your hard drive, whether you install one view or both. 

v   If you are installing over a previous version of InfoPrint Manager GUI 

software or you have already installed another GUI, a window will appear 

that gives you the option to modify the current installation. Select the 

Modify button, and leave the checkboxes checked for the components that 

are already installed. 

v   If you are installing over a previous version of the InfoPrint Manager GUI 

software, click yes for any questions about replacing files. If you will be 

using this GUI to work with an InfoPrint Manager for Windows server, you 

do not need to change any of the selections from the default values. 

v   You should install the DCE version of the InfoPrint Manager GUIs only if 

you will be using them to work with the DCE version of InfoPrint Manager 

for AIX. 

v   If you change your system language, the interface displays properly in the 

new language.

Starting the GUIs 

When you first run the InfoPrint Manager GUI, you must provide the host name 

or IP address that the InfoPrint Manager server communicates with client systems 

through. You can specify a port number; the default port number is 6874 if you do 

not specify one. 

For the most recent information about InfoPrint Manager, visit the InfoPrint 

Information Center at www.infoprint.com/infocenter. 

Note: If you receive a communication error when using Windows XP with Service 

Pack 2 or Windows 2003 with Service Pack 1, you may have to include java.exe on 

the Exceptions tab of the Windows Firewall dialog. 

Starting from the GUI icons 

To launch any of the InfoPrint Manager GUI programs, double-click on one of the 

following icons. 

 Table 24. The InfoPrint Manager GUI  icons. The text above the icons is the difference 

between the GUI  icons. 

Administration InfoPrint Operations InfoPrint 

  

Basic Administration InfoPrint Basic Operations InfoPrint 
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Starting the GUIs 

To launch the GUIs, double-click the appropriate icon on your desktop. For 

example, to launch the InfoPrint Manager Operations GUI, double-click the 

Operations Infoprint icon on your desktop. 

If the icon is not on the desktop, click the Windows Start button and select 

Programs → Infoprint Manager → Administration Infoprint to launch the InfoPrint 

Manager Administration GUI or Programs → Infoprint Manager → Operations 

Infoprint to launch the InfoPrint Manager Operations GUI. 

Note: If you open the GUI and the colors look strange (they may appear in a plaid 

pattern), minimize the GUI and then maximize it. The colors should return to 

normal. This problem is most common on Windows systems running in 256 colors 

(8–bit color). To prevent the problem, you can increase the color depth of your 

system to 16 or 24–bit color. 

Starting the special version of the Operations GUI 

The special version of the InfoPrint Manager Operations GUI allows you to lock 

the Operations GUI configuration file. This means that you can customize the 

Operations GUI configuration and then ensure that the configuration remains 

unchanged from session to session. The changes made during each session are not 

saved when the GUI is closed. 

The special version is installed when the InfoPrint Manager Operations GUI is 

installed. However, no icon will be installed on your desktop. 

To invoke the special version from the AIX command line, enter: 

ipguiadvs 

To invoke the special version from Windows, you must navigate to the path where 

the GUI is installed. By default, that path is C:\Program Files\IBM\Infoprint 

GUI and invoke the StandardOperSBC shortcut. 

Uninstalling the GUIs 

To uninstall the InfoPrint Manager GUIs, follow these steps: 

1.   Click the Windows Start button and select Settings → Control Panel. 

2.   Double-click the Add/Remove Programs icon. 

3.   Select Infoprint Manager Administration GUI or Infoprint Manager 

Operations GUI. 

4.   Click the Change/Remove button. 

5.   Click on the Remove button and then the next button 

6.   Follow the instructions on the InstallShield Uninstaller screens that display.

Note: If you want to uninstall both the JRE and the GUIs, make sure you uninstall 

the GUIs first. If you uninstall the JRE first, the GUIs cannot be uninstalled since 

the uninstall process for the GUIs is a Java uninstall process that requires a version 

of JRE to run.
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Chapter  16.  InfoPrint  Manager  Print-on-Demand  software  

The Print-on-Demand feature provides an easy to use graphical user interfaces for 

print submission in commercial print environments including job ticketing, 

automated impositioning, assembling of print jobs, and finishing. The InfoPrint 

Manager Print-on-Demand feature works with two clients: 

v   InfoPrint Submit Express 

v   InfoPrint Job Ticketer

The exact functions that are available depend on which client you will be using. 

Submit Express 

InfoPrint Submit Express is the standard client that comes with the 

Print-on-Demand feature of InfoPrint Manager and provides a variety of functions 

for the Print-on-Demand environment. For more information about Submit Express 

and the Print-on-Demand feature of InfoPrint Manager, see InfoPrint Manager 

Print-on-Demand Feature: Submit Express User’s Guide. 

Note: InfoPrint Submit Express replaces the InfoPrint Submit for Windows and 

Macintosh clients. 

InfoPrint Job Ticketer  

InfoPrint Job Ticketer is the new web based submission client used in the 

Print-on-Demand environment. It also comes with the Print-on-Demand feature of 

InfoPrint Manager. InfoPrint Job Ticketer is a unified solution for the creation, 

submission, and management of print jobs with focus on the commercial segment 

of the printing business. For more information, see the InfoPrint Job Ticketer: User’s 

Guide and the InfoPrint Job Ticketer: Administrator’s Guide. 
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Chapter  17.  Using  InfoPrint  Select  to  submit  a job  

InfoPrint Select allows you to submit and track jobs from a Windows workstation 

to a destination that is managed by InfoPrint Manager. Through InfoPrint Select, 

you can submit jobs to InfoPrint Manager from word processors, spreadsheets, and 

other desktop applications. You can print from applications or from the DOS 

command line. 

InfoPrint Select client allows you to: 

v   Specify AFP and other InfoPrint job attributes when submitting a job to the 

server 

v   Cancel and hold jobs within a queue 

v   Check the status of destinations before submitting jobs

For  more information on these specific functions, see “Printing from applications” 

on page 123 and consult the help system provided with InfoPrint Select. 

This section contains procedures for using InfoPrint Select on the Windows 

platform. The following topics are covered: 

v   “Installing InfoPrint Select” 

v   “Configuring your InfoPrint Manager server to work with InfoPrint Select” on 

page 110 

v   “Creating InfoPrint Select printers” on page 114 

v   “Printing from applications” on page 123 

v   “Commands you can use with Select” on page 125

  

Installing InfoPrint Select 

Before you install InfoPrint Select, consider these conditions: 

v   You must have administrative privileges in order to install InfoPrint Select. 

v   If you plan to install one or both of the InfoPrint Manager GUIs as well as 

InfoPrint Select, the sequence of the installs is important. Since InfoPrint Select 

may require a system reboot, you may wish to install the InfoPrint Manager 

GUI(s) first. 

v   If you want to enable other users that do not have administrator privileges to 

print using InfoPrint Select, then install Select in a folder where those users have 

read/write access. Do not install InfoPrint Select into the Program Files folder. 

v   You must adjust the configuration of the InfoPrint Manager Server in order for 

InfoPrint Select to function properly. See “Configuring your InfoPrint Manager 

server to work with InfoPrint Select” on page 110.

Follow these steps to install InfoPrint Select on a Windows system from the 

Infoprint Manager: Common Clients, LCD4-1917, CD-ROM: 

1.   Insert the Infoprint Manager Common Clients CD-ROM into the drive. 

2.   Select the Install Infoprint Products button, and then select the Infoprint Select 

button. 

3.   Follow the instructions on the installation screens to install the program. 
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4.   Enter the installation path. The default installation path is C:\Program 

Files\IBM\Infoprint Select. 

5.   Specify the name for the application program folder to install InfoPrint Select 

shortcuts. The default folder name is Infoprint Select. 

6.   Enter the host name or IP address for the InfoPrint Manager Server in the 

Host: entry field and the socket number that the InfoPrint Manager Server uses 

for client communication in the Socket: entry field on the Environment 

Variable Settings window. The default socket number is 6874. Click the Next 

button to continue with the InfoPrint Select installation. 

7.   After you have installed InfoPrint Select, the installation program asks if you 

want to reboot your system. The default answer to this question is Yes because 

InfoPrint Select will not function properly until the system is rebooted. When 

you click OK or press Enter, your system reboots.

Installing InfoPrint Select in silent mode 

InfoPrint Select can be installed using silent mode. Silent mode eliminates the 

normal user interface and uses default values or response file values for all 

required inputs. This mode is generally used by System Administrators to push the 

installation onto their users’ systems. 

Use one of these commands from the command line or an automated script to 

install InfoPrint Select in silent mode: 

InfoprintSelect.exe -quiet 

This method uses: 

v   No response file 

v   All the defaults 

v   Installs, repairs, or upgrades your installation of InfoPrint Select

Note: This method displays the splash screen and an initial progress bar.

InfoprintSelect.exe /s 

This method uses the response file embedded with the 

InfoprintSelect.exe. 

InfoprintSelect.exe /s /f1"c:\setup.iss" 

This method uses a response file named setup.iss, which can be one of 

the samples provided, a modified version of a sample, or your own 

response file created with the /r option. 

InfoprintSelect.exe /s /f1"c:\setup.iss" /f2"c:\output.log" 

This method uses a response file named setup.iss and logs the activity. If 

the installation is successful, the following text appears in the output.log: 

ResultCode=0. The setup.iss can be one of the samples provided, a 

modified version of a sample, or your own response file created with the 

/r option.

Notes:  

1.   To create your own response file, invoke the installer in record mode: 

InfoprintSelect.exe /r  

This produces a response file named setup.iss based on the inputs used 

during installation. To locate this newly created response file, search your 

system for setup.iss. 
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2.   InfoprintSelect.exe is located in the \win\InfoprintSelect folder of the 

Common Client CD-ROM.

After you have installed InfoPrint Select, sample response files can be found in 

Select_install_dir\Install_Samples. You can copy and modify these sample files 

as appropriate: 

1.   setup.iss, which is a sample response file used to install InfoPrint Select 

2.   setup_repair.iss, which is a sample response file used to repair an installation 

of InfoPrint Select 

3.   setup_upgrade.iss, which is a sample response file used to upgrade a previous 

version of InfoPrint Select 

4.   setup_remove.iss, which is a sample response file used to remove an 

installation of InfoPrint Select

Upgrading InfoPrint Select 

Follow these steps to upgrade InfoPrint Select on a Windows system from the 

Infoprint Manager: Common Clients, LCD4-1917, CD-ROM: 

1.   Insert the Infoprint Manager Common Clients CD-ROM into the drive to run 

the upgrade program. 

2.   Follow the instructions on the screens to upgrade the program. 

3.   After upgrading your InfoPrint Select version, the program asks if you want to 

reboot your system. The default answer to this question is Yes because the new 

version of InfoPrint Select will not function properly until the system is 

rebooted. When you click OK or press Enter, your system reboots.

Selecting enhanced or standard InfoPrint Select 

Once you have successfully installed InfoPrint Select, you must determine whether 

you want the enhanced version of the client. If you apply the enhanced Select, 

users can enter job and document attributes with print jobs if the printer to which 

they send the job is a Select printer. You may decide not to provide this ability to 

end users since it requires an understanding of how to use attributes. 

If you want to apply the enhanced InfoPrint Select, perform the following action: 

Click the Start button on your Windows system and select Programs → Infoprint 

Select → Activate Job Settings dialog. 

This action ensures that you can access the dialog panels that allow you to specify 

InfoPrint job attributes when submitting a job to the server. 

Removing enhanced InfoPrint Select 

If you activate the enhanced InfoPrint Select and later decide that you would 

prefer to go back to the earlier version of InfoPrint Select, you can deactivate the 

enhanced InfoPrint Select by accessing the Job Settings window and checking the 

Do not display this dialog again check box. 

Uninstalling InfoPrint Select 

To uninstall InfoPrint Select, follow these steps: 

1.   From the Start menu, select Settings → Control Panel. 
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2.   Double-click the Add/Remove Programs icon. 

3.   Select Infoprint Select. 

4.   Click Remove.

Note: Click the button only once, then wait for at least 30 seconds before you 

do anything else. If you do not wait for the first panel of the uninstaller to 

appear, it may get lost behind other windows. If you do not see the first panel 

of the uninstaller after 30 seconds, press and hold the Alt key, then press the 

Tab key to bring the window to the front. 

5.   Follow the instructions on the screen.

Configuring your InfoPrint Manager server to work with InfoPrint 

Select 

In order for InfoPrint Select to submit print jobs to InfoPrint Manager properly, 

you must configure each InfoPrint Manager logical destination or actual 

destination to accept jobs from InfoPrint Select. Use the InfoPrint Manager 

Administration GUI as described in the following procedure to configure logical 

and actual destinations correctly. If you want to use the command line instead of 

the GUI, use the pdset command to set the client-driver-names attribute. 

Printing to actual destinations: In order to submit jobs to actual destinations, the 

logical-destinations-assigned attribute must be set for the actual destination. 

1.   Log on to a system that has the InfoPrint Manager Administration GUI 

installed on it as a user with administrator privileges. 

Note: To be able to complete this procedure, you must have the authority to 

use the pdenable, pddisable, and pdset commands. If you do not have that 

authority, your user id must be added to the access control lists (ACLs) on your 

InfoPrint Manager server. 

2.   Launch the InfoPrint Manager Administration GUI. 

3.   Select one of the actual or logical destinations that will receive print jobs from 

InfoPrint Select by clicking on it once. 

4.   On the menu bar, click Actual or Logical and select Properties. 

5.   In the Properties notebook, click the Drivers tab. 

Note: If you do not see the Drivers tab, click Show more, then click the 

Drivers tab. 

6.   In the New value field next to Windows client drivers, type the name of one 

of the print drivers that users will use to submit jobs in conjunction with 

InfoPrint Select. 

7.   Click Add >>. 

8.   Click OK.

Select support for Windows 2000 Server and Windows 2003 Server 

Select will be supported on the following versions of Windows 2000 and Windows 

2003: 

v   Windows Server 2000 Standard Edition with Service Pack 4 or higher 

v   Windows Server 2003 Standard Edition with Service Pack 1 or higher
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Note: Select is not supported on any 64 bit versions of Windows. 

Using InfoPrint Select in a Windows Terminal  Server (WTS) 

Environment 

InfoPrint Select may be used in a Windows Terminal Server Environment, however, 

some functions should be disabled by the administrator. The following items need 

to be considered for use by WTS  clients: 

1.   Enhanced InfoPrint Select cannot be used and should be disabled. 

2.   Error messages should be disabled. 

3.   The Select Notification client should be disabled or administrators need to 

assign a unique Select Notification port to each user.

Enhanced InfoPrint Select 

By default, enhanced InfoPrint Select is disabled for each client. However, if 

Enhanced InfoPrint Select is enabled on a WTS  client, the Job Settings dialog that 

may appear after a job submission will not be displayed in the client session 

console, but will be displayed in the main server console. Any files that are 

submitted using Enhanced InfoPrint Select will not print until OK is clicked on the 

Job Settings dialog of the main server console. All jobs submitted after the first 

one will not print until OK is clicked on the Job Settings dialog of the main server 

console. Therefore the ability for clients to enable Enhanced InfoPrint Select should 

be disabled. 

InfoPrint Select Error Messages 

When errors are detected upon submission of a job, an error message is usually 

displayed. Jobs submitted by WTS  clients, however, will not display this message 

in the client session console, but will display the message on the main server 

console. The file will not print until OK is clicked from the main server console. 

Therefore, Select error messages should be suppressed. When error messages are 

suppressed, files that fail submission to the InfoPrint Manager server for any 

reason will be deleted from the Windows spool for the printer. An option is 

available to pause the failed job, but if the option is used then the administrator 

will need to periodically check for failed jobs and take the appropriate action to 

avoid filling up the disk on the server. 

Select Notifications 

By default, the installation of InfoPrint Select adds the Select Notification program 

to the Startup directory of all users. The default installation will not work on WTS 

clients. You can choose to either disable Select Notifications for your users or you 

can configure and manage the Select notification ports for each user to allow each 

user to use Select Notifications. If you wish to allow each user to use Select 

Notifications, each user will need to be assigned a unique TCP/IP port on the WTS  

server. The administrator must ensure that each user has a unique port assigned. If 

two users are assigned the same port, one user will get all notification messages 

for both users. The other user will receive no notification messages. 

WTS  Server Configuration 

After InfoPrint Select is installed, perform the following procedures. All of the 

procedures must be completed from an administrator userid. 
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Select.ini file 

Select creates a .ini file for each userid to store that user’s settings. The file is 

generated the first time Select is invoked by each user if it does not already exist. 

The file is stored in <Select_install_path>\<userid>\Select.ini. The WTS  

administrator should create or modify the existing file for all users. The file should 

look like the following: 

[User Preferences] 

Notification Port=5157 

Use default .att file=0 

Default .att file= 

[Submission Window] 

Suppress=1 

[Job Recovery] 

Pause jobs if submission fails=0 

Suppress submission errors=1  

The key settings are: 

v   Notification Port=5157 - Must be set to a unique port number if Notifications are 

being used. If Select Notifications are not being used, it does not need to be 

changed. 

v   Suppress=1 - Suppresses the Job Settings Dialog 

v   Suppress submission errors=1 - Suppresses errors found during submission. 

v   Pause jobs if submission fails=0 - Optionally may set this to 1 to cause failed 

jobs to be retained on the WTS  Windows spool for resubmission by the 

administrator.

Client Desktop Programs 

The default installation of the following programs should be modified. The 

following instructions indicate how to remove items. Instead of removing them, 

they may be moved to the equivalent folder under the Administrator userid or 

another userid. 

1.   Select Notification in Startup - If Select Notifications are not being used, 

remove the Select Notification Startup from all users by deleting 

C:\Documents and Settings\All Users\Start Menu\Programs\Startup\
Infoprint Select Notification. 

2.   Select Menu - The following should also be removed to prevent problems: 

a.   C:\Documents and Settings\All Users\Start Menu\Programs\Infoprint 

Select\Activate Job Settings Dialog 

b.   [Optional] C:\Documents and Settings\All Users\Start 

Menu\Programs\Infoprint Select\Change the Notification port 

c.   [Optional] C:\Documents and Settings\All Users\Start 

Menu\Programs\Infoprint Select\Infoprint Select Notification

Working  with Select notifications 

By default when you submit a job using InfoPrint Select, a notification profile is 

sent with the job. If you have the Select message windows running when you 

submit a print job using InfoPrint Select, notifications are requested. If the Select 

message window is not running, notifications are not requested. When notifications 

are requested, they are delivered by e-mail. InfoPrint Select does not use the 

 

112  InfoPrint  Manager  for  Windows:  Getting  Started



standard e-mail port for notifications to avoid conflict with other SMTP servers. If 

you have a conflict with the port that Select is using for notification, you can 

choose another port by following: Start → Programs → Infoprint Select → Infoprint 

Select Notification → Infoprint Manager Message Port, and entering another port. 

The InfoPrint Select Notification message window usually starts automatically 

when Windows first loads, but if you need to start the Notification message 

Window at another time, go to Start → Programs → Infoprint Select → Infoprint 

Select Notification. 

To turn off the Notification message window, click the X in the upper right corner 

of the screen and then click OK on the warning message. 

Note: If you receive a communication error when using the Select Message 

Window with Windows XP with Service Pack 2 or Windows 2003 with Service 

Pack 1, you may have to include ipnotify.exe on the Exceptions tab of the 

Windows Firewall dialog. 

Setting up your own InfoPrint Select notification profile 

The Select notification profile overrides any notification settings that you configure 

in a default job. If you do not want to use the Select notification profile, use the 

appropriate procedure for your operating system: 

v   Windows XP 

1.   On the Windows system that InfoPrint Select is installed on, right click on 

My Computer and select Properties. 

2.   Select the Advanced tab, and click the Environment Variables button. 

3.   Click one of the variables listed under System Variables to signal that you 

want to create a system variable. The variable and its value will appear in 

the fields at the bottom of the dialog. 

4.   Clear the Variable and Value fields. 

5.   In the Variable field, type: pdnotify and in the Value field type: 

override_select. 

6.   Click Set. 

7.   Verify that pdnotify appears in the list of System Variables and not in the 

User Variables. If it appears in the list of User variables, delete it and start 

again from step 3. 

8.   Click OK. 

9.   Restart your system to make the changes take effect.
v    Windows 2000 

 1.   On the Windows system that InfoPrint Select is installed on, right click on 

My Computer and select Properties. 

 2.   In the System Properties window, click the Advanced tab. 

 3.   On the Advanced tab, click Environment Variables. 

 4.   In the System variables box on the Environment Variables dialog, click 

New. 

 5.   In the Variable Name field, type pdnotify and in the Variable Value field, 

type override_select. 

 6.   Click OK. 
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7.   Verify that pdnotify appears in the list of System variables and not in the 

User variables. If it appears in the list of User variables, delete it and start 

again from step 4. 

 8.   Click OK in the Environment Variables dialog. 

 9.   Click OK in the System Properties window. 

10.   Restart your system to make the changes take effect.
v    Windows Vista 

 1.   On the Windows system that InfoPrint Select is installed on, right click on 

My Computer and select Properties. 

 2.   In the System Properties window, click the Advanced system settings tab. 

 3.   On the Advanced tab, click Environment Variables. 

 4.   In the System variables box on the Environment Variables dialog, click 

New. 

 5.   In the Variable Name field, type pdnotify and in the Variable Value field, 

type override_select. 

 6.   Click OK. 

 7.   Verify that pdnotify appears in the list of System variables and not in the 

User variables. If it appears in the list of User variables, delete it and start 

again from step 4. 

 8.   Click OK in the Environment Variables dialog. 

 9.   Click OK in the System Properties window. 

10.   Restart your system to make the changes take effect.

Creating InfoPrint Select printers 

This section describes how to configure InfoPrint Select clients to allow print job 

submission from Windows applications to destinations managed by an InfoPrint 

Manager server. This section includes the following topics: 

v   “Creating InfoPrint Select printers on Windows 2000 systems” on page 117 

–   “Adding your first InfoPrint Select printer on Windows 2000 systems” on 

page 117 

–   “Adding an additional InfoPrint Select printer on Windows 2000 systems” on 

page 118
v    “Creating InfoPrint Select printers on Windows XP systems” on page 119 

–   “Adding your first InfoPrint Select printer on Windows XP systems” on page 

119 

–   “Adding an additional InfoPrint Select printer on Windows XP systems” on 

page 121
v    “Creating InfoPrint Select printers on Windows Vista Business or Enterprise 

systems” on page 121 

–   “Adding your first InfoPrint Select printer on Windows Vista Business or 

Enterprise systems” on page 122 

–   “Adding an additional InfoPrint Select printer on Windows Vista Business or 

Enterprise systems” on page 123

Using the generic Adobe PostScript driver and PPDs with 

InfoPrint Select 

This is not supported on Windows Vista. 
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The InfoPrint Manager PPDs and the Windows printer creation wizard require the 

adobeps5.dll file to be located in the PPD install directory. When the adobeps5.dll 

file isn’t in the PPD directory, InfoPrint Manager issues a message Can’t find the 

adobepst.dll file and opens a browser Window. If the adobeps5.dll file is not in 

the PPD install directory, you need to do one of two things: 

v   Search your computer to see if this file is located some place else on your 

computer. If it is, copy it into the PPD install directory. 

Note: On some Windows systems, this file is a hidden or system file. For 

example, on Windows XP Professional: Go to Advanced Options and check 

Search hidden/system files. 

v   If this file is not located on your computer, you need to: 

1.   Ensure that you have installed InfoPrint Select or the InfoPrint Manager 

Windows server. 

2.   Access the Adobe® web site and download the generic Adobe PostScript 

driver to the PPD install directory. 

3.   Choose InfoPrint Select or InfoPrint Port Monitor as appropriate.

Collecting required information 

Before you can print to an InfoPrint Manager destination from a Windows 

application, you must add an InfoPrint Select printer to your Windows 

environment. Collect the following information before you begin: 

v   The host name or IP address of the InfoPrint Manager server. 

v   The port number that the InfoPrint Manager server uses to communicate with 

client systems. The default is 6874. 

You can find this port number in the Service Configuration dialog in the 

Management Console. 

v   The names of destinations to use. 

v   The names of the drivers to associate with each destination. 

v   Where the driver files are located (on a CD-ROM, on a network server, or on 

your local system). 

v   The name of the server where your actual or logical destination resides (this 

value is optional).

Verify that the InfoPrint Manager server destinations have been configured 

correctly. Refer to “Configuring your InfoPrint Manager server to work with 

InfoPrint Select” on page 110 for more information. 

Choosing the Right PPD 

If you plan to use InfoPrint Select to print PostScript jobs to an AIX DSS 

(InfoPrint Manager for AIX only), BSD DSS, or Passthrough DSS (InfoPrint 

Manager for Windows only) printer, be sure to use the PostScript printer 

driver that came with your printer when you create an InfoPrint Select 

printer on your desktop. These drivers include PostScript Printer 

Definitions (PPDs) that are specific to your printer. If you submit jobs to 

either the AIX, BSD, or Passthrough DSS printers, do not use the printer 

drivers and PPDs that are provided with InfoPrint Select. They contain 

specific attributes that apply only to PSF DSS printers. 

 If you plan to submit jobs to a PSF DSS, use the printer drivers and PPDs 

that are provided on the InfoPrint Manager Common Client CD-ROM. By 

default, these PPDs are installed in the C:\Program Files\IBM\Infoprint 

Manager\PPDs for PSF folder, with files in the format IBMprinter.PPD 
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(where printer is the specific printer type) for most systems. They contain 

specific attributes that apply only to PSF DSS printers. 

Drivers and finishing 

If you are submitting an AFP job to an IPDS printer, you can use the AFP 

driver that is described in Chapter 26, “Installing and configuring the AFP 

driver,” on page 163. 

 The automatic data stream transforms that PSF printers use do not always 

support finishing (stapling). Some PostScript drivers, however, will support 

some finishing options. The finishing options that are supported include 

saddle and edge stitch, as well as corner stitch in MO:DCA™ (Mixed Object 

Document Content Architecture™), using both landscape and portrait 

modes. 

 If you are using InfoPrint Select to submit PCL or PostScript jobs to a PSF 

printer (destination), you may discover that you cannot specify finishing 

options when you submit a job, even if the print driver you use supports 

those options. It is recommended that you either use a different method to 

submit those print jobs or that you submit them to an InfoPrint printer that 

does not transform the data stream (such as a Passthrough printer on 

InfoPrint Manager for Windows or an AIX printer on InfoPrint Manager 

for AIX). 

 If you cannot use a different submission method and cannot submit your 

jobs to a different type of InfoPrint printer, the only way to request 

finishing options on PCL and PostScript jobs submitted to a PSF 

destination is to specify the finishing attributes for the job. You have 

several options: 

v   You can create an attributes file for Select to use that contains the 

finishing attributes for your job. Then when you submit your job, you 

designate the file containing your finishing attributes as your attributes 

file (see “Specifying InfoPrint attributes” on page 124 for more 

information). 

v   You can also specify the finishing options separately under the Other tab 

in the Select Job Settings dialog using the attributes entry (see 

“Specifying InfoPrint attributes” on page 124 for more information). 

v   You can use a default job. 

A default job is a list of attributes that is applied to every job that a 

particular logical destination receives. You can use the InfoPrint Manager 

Administration GUI to modify the default job for the logical destination 

that InfoPrint Select sends jobs to so that it requests the appropriate 

finishing options. However, this method is not recommended for two 

reasons: 

1.   Every job that you send to that logical destination will be finished 

the same way. For example, if you set the Finishing options attribute 

of the default job to staple-top-left, every job that is submitted to 

that printer will be stapled. 

2.   A logical destination can only have one default job, and a default job 

can only have one finishing option set. If you want to use different 

finishing options, you must create multiple logical destinations, each 

with different options set on the default jobs. Then, you must create 

a different printer on your desktop to submit jobs to each logical 

destination.

Note: Actual destinations do not have default jobs.
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Creating InfoPrint Select printers on Windows 2000 systems 

This section includes: 

v   “Adding your first InfoPrint Select printer on Windows 2000 systems” 

v   “Adding an additional InfoPrint Select printer on Windows 2000 systems” on 

page 118

Adding your first InfoPrint Select printer on Windows 2000 

systems 

Before adding an InfoPrint Select printer to your Windows 2000 system, you must 

perform these steps: 

v   Collect the information described in “Collecting required information” on page 

115. 

v   Configure the server as described in “Configuring your InfoPrint Manager 

server to work with InfoPrint Select” on page 110.

Follow these steps to add an InfoPrint Select printer to your Windows 2000 system: 

 1.   From the Windows desktop, click Start → Settings → Printers → Add Printer. 

 2.   The Add Printer Wizard window displays. Click Next. 

 3.   In the Local or Network Printer dialog, select the Local printer button and 

ensure that the Automatically detect and install my Plug and Play Printer 

button is not selected. Click Next. 

 4.   In the Select the Printer Port dialog, select the Use the following port check 

box, then scroll down the list of ports until you find the Infoprint port and 

select it. Click Next. 

 5.   Click Have Disk. 

a.   Click Browse. 

b.   Navigate to the directory C:\Program Files\IBM\Infoprint 

Manager\PPDs for PSF. This directory holds the required ibmprint.inf 

file. Highlight this file. 

c.   Click Open. 

d.   Click OK to close the Install from Disk window.
 6.   On the next dialog, select the manufacturer and model of your printer and 

click Next. 

 7.   If the driver for your printer is already installed, the Use Existing Driver 

dialog appears. Click Next. 

 8.   The Name your Printer dialog appears. Enter a name for the printer in the 

field provided. This is the name by which the printer will be known to your 

Windows applications and the Windows desktop. Click Next. 

 9.   Select the Do not share this printer radio button and click Next. 

10.   When you are asked Would you like to print a test page? select No and click 

Next. 

11.   Click Finish. 

12.   From the Windows desktop, click the Windows Start button and select 

Settings → Printers. 

13.   On the menu bar of the Printers window, click File and select Server 

Properties. 

14.   In the Print Server Properties window, click the Ports tab. 
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15.   Highlight the Infoprint Select port that you want to configure and click 

Configure Port. 

16.   In the Infoprint Port Configuration window, ensure that the Print Server 

field is showing Infoprint Manager. 

17.   In the Host Name field, type the host name of your InfoPrint Manager server. 

18.   In the Host Port field, type the port number that your InfoPrint Manager 

server uses to communicate with client systems. The default port is 6874. 

Note: You can find this port number in the Service Configuration dialog in 

the Management Console. 

19.   In the Server name field, specify the name of the InfoPrint Manager server 

(pdserver) where your destination resides. If you are unsure of the correct 

InfoPrint Manager server name, specify the default value of * to list all the 

printers on all the InfoPrint Manager servers. Specifying the server name 

greatly reduces the number of printers listed, which reduces the amount of 

time it takes to configure a port. 

Note: If you know the name of the printer you wish to use, type it in the 

Printer name field and go to step 22 of this procedure. If you do not know the 

name of the printer, leave this value blank and you will receive a list of 

printers from which to choose. 

20.   Click Refresh Printer Selection List. 

21.   Select the appropriate printer from the list. 

22.   Click OK. 

23.   Click Close.

When Files Needed dialog appears: A Files Needed dialog may open at this point. 

In all likelihood, the file you need (pscript.dll) is already present on your system. 

If the Files Needed dialog does appear, follow these steps: 

1.   Click Browse. 

2.   Navigate to the C:\winnt\system32 directory (assuming that your operating 

system is installed on the c: drive), and select the file that is needed. 

3.   Click Open. 

4.   Click OK. 

5.   If the pscript.dll file is not found in this directory, you must load it from the 

operating system CD-ROM. To do this, follow these steps: 

a.   Insert the Windows 2000 operating system CD-ROM. 

b.   Click Browse on the Files Needed dialog. 

c.   Navigate to the d:\I386\pscript.dll_ file (where d: is your CD-ROM 

drive). 

d.   Click Open and then OK to complete the configuration.

If  you want to add additional InfoPrint Select printers to your environment, follow 

the procedure described in “Adding an additional InfoPrint Select printer on 

Windows 2000 systems.” 

Adding an additional InfoPrint Select printer on Windows 2000 

systems 

Before adding an InfoPrint Select printer to your Windows 2000 system, you must 

first perform these steps: 
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v   Collect the information described in “Collecting required information” on page 

115. 

v   Configure the server as described in “Configuring your InfoPrint Manager 

server to work with InfoPrint Select” on page 110.

To  print to an additional InfoPrint Select printer, you must add an additional 

InfoPrint Select port. Otherwise the configuration is similar to that described in 

“Adding your first InfoPrint Select printer on Windows 2000 systems” on page 117. 

To add an additional InfoPrint printer to your Windows 2000 system, follow these 

steps: 

1.   From the Windows desktop, click Start → Settings → Printers → Add Printer. 

2.   The Add Printer Wizard window displays. Click Next. 

3.   In the Local or Network Printer dialog, select Local printer and clear the 

Automatically detect and install my Plug and Play Printer checkbox. Click 

Next. 

4.   Click Create a new port and highlight Infoprint Select from the pull-down list. 

Click Next. 

5.   In the dialog that opens, type a name for the new port, such as InfoPrint-2, and 

click OK. (Use a name that no other port uses.) 

6.   Continue by starting with step 5 of the procedure documented in “Adding 

your first InfoPrint Select printer on Windows 2000 systems” on page 117, 

configuring the new port you just added.

Creating InfoPrint Select printers on Windows XP systems 

This section includes: 

v   “Adding your first InfoPrint Select printer on Windows XP systems” 

v   “Adding an additional InfoPrint Select printer on Windows XP systems” on page 

121

Adding your first InfoPrint Select printer on Windows XP 

systems 

Before adding an InfoPrint Select printer to your Windows XP system, you must 

perform these steps: 

v   Collect the information described in “Collecting required information” on page 

115. 

v   Configure the server as described in “Configuring your InfoPrint Manager 

server to work with InfoPrint Select” on page 110.

Follow these steps to add an InfoPrint Select printer to your Windows XP system: 

 1.   From the Windows desktop, click Start → Settings → Printers and Faxes. 

 2.   The Add Printer Wizard window displays. Click Next. 

 3.   In the Local or Network Printer dialog, select the Local printer button and 

ensure that the Automatically detect and install my Plug and Play Printer 

button is not selected. Click Next. 

 4.   In the Select the Printer Port dialog, select the Use the following port check 

box, then scroll down the list of ports until you find the port and select it. 

Click Next. 

 5.   Click Have Disk. 

a.   Click Browse. 
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Note: If you are using a printer driver other than those provided with 

InfoPrint Manager or Select, specify that printer driver now. 

b.   Navigate to the directory C:\Program Files\IBM\Infoprint 

Manager\PPDs for PSF. This directory holds the required ibmprint.inf 

file. Highlight this file. 

c.   Click Open. 

d.   Click OK to close the Install from Disk window.
 6.   Select the manufacturer and model of your printer and click Next. 

 7.   If the driver for your printer is already installed, the Use Existing Driver 

dialog appears. Click Next. 

 8.   The Name your Printer dialog appears. Enter a name for the printer in the 

field provided. This is the name by which the printer will be known to your 

Windows applications and the Windows desktop. Click Next. 

 9.   Select the Do not share this printer radio button and click Next. 

10.   When you are asked Would you like to print a test page? select No and click 

Next. 

11.   Click Finish. 

12.   On the menu bar of the Printers and Faxes window, click File and select 

Server Properties. 

13.   In the Print Server Properties window, click the Ports tab. 

14.   Highlight the Infoprint Select port that you want to configure and click 

Configure Port. 

15.   In the Infoprint Port Configuration window, ensure that the Print Server 

field shows Infoprint Manager. 

16.   In the Host Name field, type the host name of your InfoPrint Manager server. 

17.   In the Host Port field, type the port number that your InfoPrint Manager 

server uses to communicate with client systems. The default port is 6874. 

Note: You can find this port number in the Service Configuration dialog in 

the Management Console. 

18.   In the Server name field, specify the name of the Manager server (pdserver) 

where your destination resides. If you are unsure of the correct Manager 

server name, specify the default value of * to list all the printers on all the 

Manager servers. Specifying the server name greatly reduces the number of 

printers listed, which reduces the amount of time it takes to configure a port. 

Note: If you know the name of the printer you wish to use, type it in the 

Printer name field and go to step 21 of this procedure. If you do not know the 

name of the printer, leave this value blank and you will receive a list of 

printers from which to choose. 

19.   Click Refresh Printer Selection List. 

20.   Select the appropriate printer from the list. 

21.   Click OK. 

22.   Click Close.

When Files Needed dialog appears: A Files Needed dialog may open at this point. 

In all likelihood, the file you need (pscript.dll) is already present on your system. 

If the Files Needed dialog does appear, follow these steps: 

1.   Click Browse. 
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2.   Navigate to the c:\windows\system32 directory (assuming that your operating 

system is installed on the c: drive), and select the file that is needed. 

3.   Click Open. 

4.   Click OK. 

5.   If the pscript.dll file is not found in this directory, you must load it from the 

operating system CD-ROM. To do this, follow these steps: 

a.   Insert the Windows XP operating system CD-ROM. 

b.   Click Browse on the Files Needed dialog. 

c.   Navigate to the d:\I386\Pscript.dll_ file (where d: is your CD-ROM 

drive). 

d.   Click Open and then OK to complete the configuration.

If  you want to add additional InfoPrint Select printers to your environment, follow 

the procedure described in “Adding an additional InfoPrint Select printer on 

Windows XP systems.” 

Adding an additional InfoPrint Select printer on Windows XP 

systems 

Before adding an InfoPrint Select printer to your Windows XP system, you must 

perform these steps: 

v   Collect the information described in “Collecting required information” on page 

115. 

v   Configure the server as described in “Configuring your InfoPrint Manager 

server to work with InfoPrint Select” on page 110.

To  print to an additional InfoPrint Select printer, you must add an additional 

InfoPrint Select port. Otherwise the configuration is similar to that described in 

“Adding your first InfoPrint Select printer on Windows XP systems” on page 119. 

To add an additional InfoPrint printer to your Windows XP system, follow these 

steps: 

1.   From the Windows desktop, click Start → Settings → Printers and Faxes → Add 

Printer. 

2.   Select Add a printer. The Add Printer Wizard window displays. Click Next. 

3.   In the Local or Network Printer dialog, select Local printer and clear the 

Automatically detect and install my Plug and Play Printer checkbox. Click 

Next. 

4.   Click Add port and highlight Infoprint Select from the pull-down list. Click 

Next. 

5.   In the dialog that opens, type a name for the new port, such as InfoPrint-2, and 

click OK. (Use a name that no other port uses.) 

6.   Continue by starting with step 5 of the procedure documented in “Adding 

your first InfoPrint Select printer on Windows XP systems” on page 119, 

configuring the new port you just added.

Creating InfoPrint Select printers on Windows Vista  Business 

or Enterprise systems 

This section includes: 

v   “Adding your first InfoPrint Select printer on Windows Vista Business or 

Enterprise systems” on page 122 
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v   “Adding an additional InfoPrint Select printer on Windows Vista Business or 

Enterprise systems” on page 123

Adding your first InfoPrint Select printer on Windows Vista 

Business or Enterprise systems 

Before adding an InfoPrint Select printer to your Windows Vista Business or 

Enterprise system, you must perform these steps: 

v   Collect the information described in “Collecting required information” on page 

115. 

v   Configure the server as described in “Configuring your InfoPrint Manager 

server to work with InfoPrint Select” on page 110.

Follow these steps to add an InfoPrint Select printer to your Windows Vista 

Business or Enterprise system: 

 1.   From the Windows desktop, click Start → Settings → Printers. 

 2.   Select Add a printer. The Add Printer window displays. Select Add a local 

printer. 

 3.   On the Choose a printer port page, select the Use an existing port option 

button, then scroll down the list of ports until you find the port and select it. 

Click Next. 

 4.   Click Have Disk. 

a.   Click Browse. 

Note: If you are using a printer driver other than those provided with 

InfoPrint Manager or Select, specify that printer driver now. 

b.   Click Open. 

c.   Click OK to close the Install From Disk window.
 5.   Select the manufacturer and model of your printer and click Next. 

 6.   If the driver for your printer is already installed, the Use Existing Driver 

dialog appears. Click Next. 

 7.   The Type a printer name dialog appears. Enter a name for the printer in the 

field provided. This is the name by which the printer will be known to your 

Windows applications and the Windows desktop. Click Next. 

 8.   Click Finish. 

 9.   On the menu bar of the Printers window, click Organize and select 

Properties. 

10.   In the Print Properties window, click the Ports tab. 

11.   Highlight the Infoprint Select port that you want to configure and click 

Configure Port. 

12.   In the Infoprint Port Configuration window, ensure that the Print Server 

field shows Infoprint Manager. 

13.   In the Host Name field, type the host name of your InfoPrint Manager server. 

14.   In the Host Port field, type the port number that your InfoPrint Manager 

server uses to communicate with client systems. The default port is 6874. 

Note: You can find this port number in the Service Configuration dialog in 

the Management Console. 

15.   In the Server name field, specify the name of the InfoPrint Manager server 

(pdserver) where your destination resides. If you are unsure of the correct 

InfoPrint Manager server name, specify the default value of * to list all the 
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printers on all the InfoPrint Manager servers. Specifying the server name 

greatly reduces the number of printers listed, which reduces the amount of 

time it takes to configure a port. 

Note: If you know the name of the printer you wish to use, type it in the 

Printer name field and go to step 18 of this procedure. If you do not know the 

name of the printer, leave this value blank and you will receive a list of 

printers from which to choose. 

16.   Click Refresh Printer Selection List. 

17.   Select the appropriate printer from the list. 

18.   Click OK. 

19.   Click Close.

If you want to add additional InfoPrint Select printers to your environment, follow 

the procedure described in “Adding an additional InfoPrint Select printer on 

Windows Vista Business or Enterprise systems.” 

Adding an additional InfoPrint Select printer on Windows Vista 

Business or Enterprise systems 

Before adding an InfoPrint Select printer to your Windows Vista Business or 

Enterprise system, you must perform these steps: 

v   Collect the information described in “Collecting required information” on page 

115. 

v   Configure the server as described in “Configuring your InfoPrint Manager 

server to work with InfoPrint Select” on page 110.

To  print to an additional InfoPrint Select printer, you must add an additional 

InfoPrint Select port. Otherwise the configuration is similar to that described in 

“Adding your first InfoPrint Select printer on Windows Vista Business or 

Enterprise systems” on page 122. 

To add an additional InfoPrint printer to your Windows Vista Business or 

Enterprise system, follow these steps: 

1.   From the Windows desktop, click Start → Settings → Printers. 

2.   Select Add a printer. The Add Printer window displays. Select Add a local 

printer. 

3.   Click Create a new port and highlight Infoprint Select from the pull-down list. 

Click Next. 

4.   In the dialog that opens, type a name for the new port, such as InfoPrint-2, and 

click OK. (Use a name that no other port uses.) 

5.   Continue by starting with step 4 on page 122 of the procedure documented in 

“Adding your first InfoPrint Select printer on Windows Vista Business or 

Enterprise systems” on page 122, configuring the new port you just added.

Printing from applications 

The following must be kept in mind when printing from applications with 

InfoPrint Select: 

Printing Considerations 

InfoPrint Select works with the print facility of each application, so 
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printing from every program is a little different. A typical application may 

allow you to specify a printer other than the default, the number of copies, 

or a range of pages. 

 If the printer selected (or your default printer) is an InfoPrint Manager 

Select printer, your job is sent to the InfoPrint server.

Checking printer status 

If you want to check the status of your printer before committing a print job, 

follow the appropriate procedure below for your version of Windows: 

v   Windows 2000, click Start → Settings → Printers 

v   Windows XP, click Start → Settings → Printers and Faxes 

v   Window Vista Business or Enterprise, click Start → Settings → Printers 

Select the printer that you want to check. Right click on your selection and choose 

View IPM Printer Status. The Enabled and Status columns reflect the current state 

of actual and logical destinations that could be used to process the job. If there is a 

backup printer defined for your printer, it will be listed in the Backup Printer 

column. A backup printer is a backup actual destination. If you want to add a 

backup actual destination, your administrator can set the backup-destinations 

attribute for the printer that you want to backup. See the InfoPrint Manager 

Reference for more information. 

Specifying InfoPrint attributes 

The enhanced InfoPrint Select client allows you to send InfoPrint attributes with 

your print jobs. Once you activate the attributes dialog (see “Selecting enhanced or 

standard InfoPrint Select” on page 109), the Job Settings window appears when 

you submit a job. By clicking on the Scheduling tab, you can modify the default 

scheduling values on the InfoPrint server from your Select client. By clicking on 

the Other tab, you can: 

v   Specify an attribute file that you have created with particular values that will be 

passed onto the InfoPrint server (for example, C:\combo.att). 

v   Specify an individual attribute that will be passed onto the InfoPrint server ( for 

example, job-name=Job1). 

v   Suppress job submission error messages that allows you to disable submission 

error message boxes. This enables unattended operation. 

v   Re-spool jobs if submission fails that allows you to automatically re-spool 

failed job submissions. Re-spooled jobs will be placed in the windows print 

queue in a paused state. The reason for the paused state will be shown in the 

″Comments″ column of the printer dialog if the user has administrator 

privileges. To resubmit the print job you need to highlight the job in the printer 

dialog, then Restart and Resume the job. This allows the Windows printing 

mechanism to resend the data from the beginning.

The  combo.att file cited above is a sample file which contains the following 

content: 

printer-models-requested    = InfoPrint4000 

printer-locations-requested = ’Building 025’ 

job-priority                = 25 

job-retention-period        = 01:30 
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For more information about additional attributes and the syntax for specifying 

them, see both the InfoPrint Select online help and the InfoPrint Manager: Reference 

manual. 

Notes:  

1.   Before specifying any InfoPrint attributes, refer to the InfoPrint Manager: 

Reference for specific information and syntax rules. 

2.   The InfoPrint Select Other tab does not contain a syntax checker, so verify that 

the format of attributes, specified in either an attributes file or as individual 

attributes, are in the correct format. If there are syntax errors, you will receive 

the same messages provided for syntax errors on commands sent from a 

command line. 

3.   If you specify the same InfoPrint attribute from different locations with 

different values, please note that the following hierarchy is how InfoPrint 

Manager determines what to send with the job: 

a.   Values specified in the Attributes field on the Other tab. 

b.   Values specified in the Attributes file field on the Other tab. 

c.   Any values specified on either the General, Scheduling, or Messages tab.

Viewing  and canceling jobs 

After you have submitted your job, InfoPrint Select allows you to access the 

InfoPrint server queues to view their status and hold, cancel, or release jobs. Use 

the following procedure: 

1.   From the Start menu on your Windows client, access the Settings → Printers 

window. 

2.   From the Printers window, right-click on the printer and select View IPM 

Queue. 

3.   From the printer_name InfoPrint Manager Jobs window, you can hold, cancel, 

or release jobs in the queue on the InfoPrint server.

Commands you can use with Select 

Typically, InfoPrint Select is used to allow users to print to InfoPrint Manager 

destinations from existing Windows applications (usually through the Print option 

on the File menu). In addition, you can use several InfoPrint commands that can 

be issued at a Command Prompt on the client system. 

Note: If you are using the InfoPrint commands and want to receive notifications, 

you can install the Notification Client from the Infoprint Manager Common Clients 

CD-ROM, LCD4–1917. 

Information about security and how users can be authorized to InfoPrint Manager 

is found in the topic “Managing Security” in the InfoPrint Manager for Windows: 

Procedures manual. 

InfoPrint Manager allows authorized users (normally all users) to use the 

following InfoPrint commands: 

pdls Lists selected attribute values for a job, destination, or other InfoPrint 

object 

pdpr Submits a job to a logical or actual destination 
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pdq Queries the status of selected jobs, of all jobs submitted to a logical 

destination, or of all jobs assigned to an actual destination

InfoPrint Manager allows authorized users (the job owner is usually authorized) to 

use the following InfoPrint commands: 

pdmod 

Modifies the attributes of submitted jobs or of the documents in them 

pdrm Deletes jobs

InfoPrint Manager allows only authorized users to use the following InfoPrint 

commands: 

pdaccount 

Collects summary accounting information for a specified time period in a 

comma delimited format about actual destinations on one or more servers. 

This information can be filed and imported into a spread sheet to calculate 

the cost of consumables, the usage rate of printers, the cost for each user, 

and so forth. 

pdcreate 

Creates logical destinations, queues, actual destinations, default jobs, 

default documents, media, auxiliary sheets, and resource contexts. 

pdclean 

Removes all jobs from a server, logical destination, queue, or actual 

destination. 

pddelete 

Deletes servers, logical destinations, queues, actual destinations, default 

jobs, default documents, media, auxiliary sheets, resource contexts, and 

jobs. 

pddisable 

Prevents destinations from accepting jobs and logs from logging. 

pdenable 

Enables destinations to accept jobs and logs to log. 

pdpause 

Pauses a job, actual destination, queue, or all the queues and actual 

destinations in a server. 

pdpromote 

Advances a job to the head of the queue. 

pdreorder 

Reassigns a job to an actual destination or to the unassigned jobs area in 

the same server or in another server, and allows you to schedule it 

immediately before or after another job. 

pdresubmit 

Resubmits a job, all the jobs submitted to a logical destination, or all the 

jobs in a queue to another logical destination. 

pdresume 

Enables paused objects to resume operation. 

pdset Sets or changes the values of attributes describing InfoPrint objects. 

pdshutdown 

Stops servers or actual destinations. 
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pdspace 

Backspaces or forward spaces a PSF physical printer. 

pddeviceop 

Perform device operation on device associated with specified actual 

destination.

Note: For more information about InfoPrint commands and attributes, refer to 

InfoPrint Manager: Reference or to the man pages. Command man pages have the 

same name as the command. 

Querying destination attributes 

To determine whether the logical destination london is ready to receive jobs, enter: 

pdls -c destination -r "destination-state" london 

Submitting a job 

To submit the file myjob.ps to the logical destination london and request two-sided 

printing, enter: 

pdpr -d london -x "sides=2" myjob.ps 

Note: The InfoPrint Manager: Reference lists all the attributes and values that you 

can specify on the pdpr command. 

Querying jobs 

To query all the jobs that you submitted to logical destination london, enter: 

pdq -d london 

InfoPrint returns information similar to the following: 

                                        Intervening Destination Destination 

Job ID               Name      State    Jobs        Requested   Assigned 

--- ---------------- --------- -------- ----------- ----------- ----------- 

13  Serv1:1104221000 report.ps printing 0           london       caxton 

14  Serv1:1104221023 myjob.ps  pending  8           london       morris 

Specifying the destination name 

If you want to print from the command line to a single destination without having 

to specify the -p flag or its argument with each job, you can define the destination 

name on your system by doing the following: 

1.   Open a Command Prompt window and edit the autoexec.bat file. 

2.   Add the following line to the file: 

SET PDPRINTER=destinationname 

3.   Save your changes and close the autoexec.bat file. 

4.   Restart the Windows system to make this change effective.
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Chapter  18.  Windows  gateway  printer  

A Windows gateway printer is a Windows shared printer that you create on your 

InfoPrint Manager server system. This allows users anywhere in the network to 

submit print jobs through InfoPrint Manager. Users must follow the instructions in 

“Adding a Windows gateway printer to a workstation” to add the Windows 

gateway printer to their desktops. Use the Management Console to create and 

administer a Windows gateway printer. The Management Console help includes 

instructions. 

Note: When InfoPrint Manager is uninstalled, all Windows Gateway printers are 

deleted. Therefore, you must have your users manually delete the Windows 

Gateway printer from their desktops after the uninstall. 

Adding a Windows gateway printer to a workstation 

To add a Windows gateway printer to a workstation, instruct your users to follow 

these steps: 

1.   Locate the share name of the Windows gateway printer. 

2.   Follow the standard procedure for adding a network printer to your desktop. 

This procedure depends on the operating system that you use. For example, on 

Windows systems, use the Add Printer Wizard to create a printer that will be 

managed by network print server. When you are prompted for the name of the 

printer to connect to, enter the share name of the Windows gateway printer. 

3.   Once the connection to the Windows gateway printer is created, you can print 

to it just as you would print to any other printer.

Note:  

1.   This procedure assumes that you have already created the Windows gateway 

printer on the InfoPrint Manager server system. 

2.   When the InfoPrint Manager server is uninstalled, any Windows gateway 

printers that exist on the server are deleted. However, connections to those 

Windows gateway printers that have been added to workstations are still 

present; they are still displayed in the Printers window, and you can still try to 

print to them from applications. Because the Windows gateway printer on the 

InfoPrint Manager server no longer exists, those print jobs will fail. If you try 

to print to one of these Windows gateway printer, you will get an 

application-dependent message that does not identify this problem. To resolve 

this problem, delete the Windows gateway printer from your desktop and 

create a new one once your print system administrator has created a new one.
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Chapter  19.  IPP  gateway  printer  

InfoPrint Manager provides an Internet Printing Protocol (IPP) gateway. The IPP 

gateway allows users anywhere in the network who have IPP client software 

installed to submit print jobs through InfoPrint Manager, even to printers that are 

not IPP-enabled. Users must follow the instructions provided with the IPP client to 

add a printer to their desktops. Use the Management Console to enable the IPP 

gateway. 

An Internet Printing Protocol (IPP) gateway printer is a printer that you create on 

a client workstation using IPP client software, such as the Windows 2000 IPP 

client. Users submit print jobs to that printer, and they are sent to InfoPrint 

Manager through the InfoPrint IPP gateway. The IPP gateway can then send the 

job on to any InfoPrint printer, even those that are not IPP-enabled. 

Adding an IPP gateway printer to a workstation 

Instruct your end users to follow the steps below in order to add a printer that 

uses the IPP gateway to their desktops. This procedure assumes that IPP client 

software is installed on the workstation. If the IPP client software is not installed, 

the Printer Working Group (the organization that is leading the development of 

IPP) provides a list of IPP client software that you can use to find an appropriate 

client at: 

http://www.pwg.org/ipp/IPP-Products.html 

1.   Locate the address of the printer that you want to print to. 

2.   Follow the instructions provided with your IPP client software for adding a 

printer to your desktop.

After you have added the printer to your desktop, you can print to it just as you 

would print to any other printer. 
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Chapter  20.  Using  the  InfoPrint  AIX  client  

The InfoPrint AIX client is installed on all InfoPrint AIX servers with the InfoPrint 

Manager for AIX Base Server. To install the InfoPrint AIX client on any AIX 

servers that do not have InfoPrint Manager for AIX, you can use either the 

Infoprint Manager Common Clients CD-ROM or the Infoprint Manager for AIX 

Base Server CD-ROM. This client can be used to send commands to InfoPrint 

Manager for either AIX or Windows servers. The InfoPrint AIX client supports files 

greater than 2 GB in size. 

The InfoPrint AIX client allows you to enter InfoPrint commands on the AIX 

command line. It also allows you to enter enq, lp, lpr, and qprt commands. It has 

no graphical user interface. 

Note: Consult the installation procedures on either the InfoPrint Manager for AIX 

site or the InfoPrint Manager for Windows site, both at http://www.infoprint.com, 

for the latest information on installing the InfoPrint AIX client. 

Installing the InfoPrint AIX client 

Attention:  The InfoPrint AIX client and the InfoPrint server are available in the 

following languages: 

v   English 

v   French 

v   German 

v   Italian 

v   Japanese 

v   Spanish 

v   Korean

You should associate the AIX client with an InfoPrint server running in your 

language. 

To install the InfoPrint AIX client on an AIX system where you have not installed 

the InfoPrint server, follow these steps: 

1.   Log onto AIX as root. 

2.   Insert the Infoprint Manager Common Clients, LCD4-1917, into the drive. 

3.   If this is the first time you are installing software on this AIX system, create the 

/cdrom file system. 

a.   Start the System Management Interface Tool (SMIT). 

v   To start the AIX windows version of SMIT, enter the following command: 

smit cdrfs 

v   To start the ASCII version of SMIT, enter the following command: 

smitty cdrfs 

The CDROM File Systems panel is displayed. 
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b.   Select Add a CDROM File System. 

 

c.   In the DEVICE name field, enter the identifier of your CD-ROM drive. 

d.   In the MOUNT POINT field, enter /cdrom. 

e.   Select OK (AIX windows version) or press Enter (ASCII version). 

f.   Select Cancel (AIX windows version) or press F10 (ASCII version) to exit 

from SMIT.
4.   To mount the CD-ROM, enter: 

mount /cdrom 

5.   Enter the following command to install the AIX client: 

/cdrom/setup -c  -n ServerName 

   -p PortNumber -P DestinationName -l locale 

where: 

ServerName 

is the name of the host where the InfoPrint server you want to 

communicate with (PDHOST) is running. 

PortNumber 

is the number of the port for the InfoPrint server, usually 6874 

(PD_SOCKET). Remember to select one that is running in your 

language. 

DestinationName 

is the default logical destination that the AIX client submits jobs to. The 

-P DestinationName flag is optional. 

locale is the locale of the AIX client. The default is en_US (U. S. English). The 

-l locale flag is optional.
6.   When the command completes processing, you should shutdown and restart 

your AIX server so that all changes can take effect.

                               CDROM File Systems 

Move  cursor to desired item and press Enter. 

  Add  a CDROM File System 

  Change / Show Characteristics of a CDROM File System 

  Remove a CDROM File System 

1=Help               F2=Refresh             F3=Cancel                F8=Image 

F9=Shell             F10=Exit               Enter=Do

 

Figure 11. SMIT CDROM  File Systems panel

                            Add a CDROM File System 

Type  or select values in entry fields. 

Press  Enter AFTER making all desired changes. 

                                                           ^Entry Fields| 

* DEVICE Name                                                               + 

* MOUNT Point                                           ^| 

  Mount AUTOMATICALLY at system restart?                 no                 + 

1=Help               F2=Refresh             F3=Cancel                F4=List 

F5=Reset             F6=Command             F7=Edit                  F8=Image 

F9=Shell             F10=Exit               Enter=Do

 

Figure 12. SMIT Add a CDROM  File System panel
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Commands you can use from the InfoPrint AIX client 

Information about security and how users can be authorized to InfoPrint Manager 

is found in the topic “Managing Security” in the InfoPrint Manager for Windows: 

Procedures manual. 

InfoPrint Manager allows authorized users (normally all users) to use the 

following InfoPrint commands: 

pdls Lists selected attribute values for a job, destination, or other InfoPrint 

object 

pdpr Submits a job to a logical or actual destination 

pdq Queries the status of selected jobs, of all jobs submitted to a logical 

destination, or of all jobs assigned to an actual destination

InfoPrint Manager allows authorized users (the job owner is usually authorized) to 

use the following InfoPrint commands: 

pdmod 

Modifies the attributes of submitted jobs or of the documents in them 

pdrm Deletes jobs

InfoPrint Manager allows only authorized users to use the following InfoPrint 

commands: 

pdaccount 

Collects summary accounting information for a specified time period in a 

comma delimited format about actual destinations on one or more servers. 

This information can be filed and imported into a spread sheet to calculate 

the cost of consumables, the usage rate of printers, the cost for each user, 

and so forth. 

pdcreate 

Creates logical destinations, queues, actual destinations, default jobs, 

default documents, media, auxiliary sheets, and resource contexts. 

pdclean 

Removes all jobs from a server, logical destination, queue, or actual 

destination. 

pddelete 

Deletes servers, logical destinations, queues, actual destinations, default 

jobs, default documents, media, auxiliary sheets, resource contexts, and 

jobs. 

pddeviceop 

Performs a device operation on a device associated with a specified actual 

destination. 

pddisable 

Prevents destinations from accepting jobs and logs from logging. 

pdenable 

Enables destinations to accept jobs and logs to log. 

pdpause 

Pauses a job, actual destination, queue, or all the queues and actual 

destinations in a server. 
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pdpromote 

Advances a job to the head of the queue. 

pdreorder 

Reassigns a job to an actual destination or to the unassigned jobs area in 

the same server or in another server, and allows you to schedule it 

immediately before or after another job. 

pdresubmit 

Resubmits a job, all the jobs submitted to a logical destination, or all the 

jobs in a queue to another logical destination. 

pdresume 

Enables paused objects to resume operation. 

pdset Sets or changes the values of attributes describing InfoPrint objects. 

pdshutdown 

Stops servers or actual destinations. 

pdspace 

Backspaces or forward spaces a PSF physical printer.

Note: For more information about InfoPrint commands and attributes, refer to 

InfoPrint Manager: Reference or to the man pages. Command man pages have the 

same name as the command. 

Examples using the InfoPrint AIX client 

The InfoPrint Manager: Reference and the command man pages show several 

examples of each command that you can issue from the InfoPrint AIX client. This 

section contains examples using the commands to perform some common tasks. 

Filtering destinations 

To find a destination near you that can print two-sided PostScript jobs, enter: 

pdls -c destination -f "destination-realization==actual 

   && document-format-supported==postscript && sides-supported==2" 

   -r "destination-location" \*: 

The -f flag specifies that you want to either filter on or list only actual destinations 

that support PostScript format and two-sided printing. The -r flag specifies that 

you want to request where the actual destinations reside. The asterisk means that 

you want to check every server. The blank after the colon means that you want to 

check every destination in every server. The backslash prevents the shell from 

interpreting the asterisk as a special character. 

InfoPrint returns information similar to the following: 

caxton:  destination-location = 3rd floor E 

elzevir: destination-location = 

morris:  destination-location = 1st floor W 

You decide to print your job on morris. To determine a logical destination that 

routes jobs to morris, enter: 

pdls -c destination -f "destination-associated-destinations==morris" \*: 
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Querying destination attributes 

To determine whether morris is ready to receive jobs, enter: 

pdls -c destination -r "destination-state" morris 

Submitting a print job 

To submit the file myjob to the logical destination london, requesting two-sided 

printing on the actual destination morris, enter: 

pdpr -d london -x "destination-name-requested=morris sides=2" myjob 

Querying jobs 

To query all the jobs that you submitted to logical destination london, enter: 

pdq -d london 

InfoPrint returns information similar to the following: 

                                     Intervening Destination Destination 

Job ID               Name   State    Jobs        Requested   Assigned 

--- ---------------- ------ -------- ----------- ----------- ----------- 

13  Serv1:1104221000 report printing 0           london       caxton 

14  Serv1:1104221023 myjob  pending  8           london       morris 

Modifying job attributes 

After submitting myjob, you decide that you want to print two copies and that you 

want to retain it for one hour after it prints. When you queried your jobs 

submitted to london, you saw that the local job ID is 14 and that the job is still 

pending, so it can still be modified. Enter: 

pdmod -n 2 -x "job-retention-period=1:00" 14 

Modifying destination attributes 

You want to restrict the actual destination Printer3 so that it does not accept very 

large jobs. To do this: 

1.   Before you can modify the attributes of a destination, you must disable it. 

Enter: 

pddisable Printer3 

2.   To specify a new maximum job size of 5 MB, enter: 

pdset -c destination -x "job-size-range-ready=0:5000000" Printer3 

3.   To reenable the actual destination, enter: 

pdenable Printer3 

Shutting down an actual destination 

The printer device represented by the actual destination caxton is out of order. To 

shut down caxton until the printer device can be repaired and to associate a 

message with caxton, enter: 

pdshutdown -c destination -m "Service called Tuesday at 3PM" caxton 
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Chapter  21.  Using  the  InfoPrint  HP-UX  client  

The InfoPrint Manager HP-UX client enables users of HP-UX 11.0 and above to 

issue InfoPrint commands over a TCP/IP-connected network to an InfoPrint 

Manager for AIX or an InfoPrint Manager for Windows server. Using a UNIX® 

command line or shell script, you can query server, printer, and print job status; 

change the state of a server, printer, or print job; create, delete, or reorder a print 

job on the server. The HP-UX client does not support files larger than 2 GB in size. 

To install the HP-UX client on an HP-UX server, you can use the Infoprint 

Manager Common Clients, LCD4-1917. 

Access to the InfoPrint Manager server and to the InfoPrint Manager commands is 

controlled on the system where the server is installed. For information about 

providing access, refer to InfoPrint Manager for Windows: Procedures. 

Note: Consult the installation procedures on either the InfoPrint Manager for AIX 

site or the InfoPrint Manager for Windows site, both at 

http://www.infoprint.com 

for the latest information on installing the InfoPrint Manager HP-UX client. 

Installing the InfoPrint Manager HP-UX client 

Attention:  The HP-UX client and the InfoPrint server are available in the 

following languages: 

v   English 

v   French 

v   German 

v   Italian 

v   Japanese 

v   Spanish 

v   Korean

To use a non-English version of InfoPrint Manager, your AIX system must have 

installed the file sets for that language. You should associate the HP-UX client with 

an InfoPrint server running in your language. 

To install the InfoPrint Manager HP-UX client, follow these steps: 

 1.   Log onto the HP-UX system as root. 

 2.   Create a directory called /usr/lpp/pd/bin on the HP-UX client system. This 

directory must have approximately two megabytes of available storage. 

 3.   Copy the pdcommand.HP-UX.11 file from the Infoprint Manager Common 

Clients, LCD4-1917, to the /usr/lpp/pd/bin directory. 

 4.   Enter echo $NLSPATH to determine the value of this environment variable. If 

the NLSPATH environment variable does not exist . . . 

 5.   Run locale to determine the value of the LC_MESSAGES environment 

variable. Make a note of this value. 
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6.   Copy the ipr.cat file from the Infoprint Manager Common Clients, 

LCD4-1917, to the /usr/lib/nls/msg/locale directory, where locale is the value 

that you saved in step 4. 

 7.   Change to the /usr/lpp/pd/bin directory. 

 8.   Type the following commands: 

chmod 755 pdcommand 

mv pdcommand.HP-UX11 pdcommand 

 9.   Create links to the pdcommand for each supported command that you wish 

to make available. See “Commands you can use from the InfoPrint HP-UX 

client” on page 141 for the names of the supported commands. 

For example, to support the pdls command, which lists information about 

InfoPrint objects, type the following command: 

ln -s pdcommand pdls 

10.   Create a shell script in the language of your choice or manually set the 

following environment variables: 

PDHOST 

The name of the host where the InfoPrint server resides. 

PD_SOCKET 

The TCP/IP socket number of the port for the InfoPrint server. The 

default socket is 6874 . Use 6874 unless your system has been 

specifically set up differently, or you have more than one InfoPrint 

Manager server running on the host. 

PDPRINTER 

The default logical destination in the InfoPrint Manager server. The 

commands will use this value if you do not specify a logical 

destination (the -P DestinationName flag) on the command line. 

PATH Add the /usr/lpp/pd/bin directory to the value of this variable. It must 

be the first directory in the path; otherwise, a conflict with the HPDPS 

daemon exists. 

NLSPATH 

The path for the message catalog.
The following example shows a Korn shell script to set the environment 

variables: 

export PDHOST="hostname-of-infoprint-server" 

export PD_SOCKET="6874" 

export PDPRINTER="name-of-default-logical-destination" 

export PATH=/usr/lpp/pd/bin:$PATH 

export NLSPATH=/usr/lib/nls/msg/%L/%N: 

11.   Test the system: 

a.   Open a command line window. 

b.   Set the environment variables as directed in Step 10, either manually or 

using a shell script. 

c.   Issue one of the chosen commands, followed by the -h flag to display the 

syntax of that command and verify the installation. 

For example: 

pdls -h 

d.   Arrange for all users of the HP-UX client to set the environment variables 

as directed in Step 10, whenever they log in. You can use either of these 

methods: 
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v   Set the environment variables in the default shell configuration file, 

either individually or by invoking the shell script. 

v   Tell each user to set the environment variables in his or her own shell 

configuration file, either individually or by invoking the shell script.

Commands you can use from the InfoPrint HP-UX client 

Information about security and how users can be authorized to InfoPrint Manager 

is found in the topic “Managing Security” in the InfoPrint Manager for Windows: 

Procedures manual. 

InfoPrint Manager allows authorized users (normally all users) to use the 

following InfoPrint commands: 

pdls Lists selected attribute values for a job, destination, or other InfoPrint 

object 

pdpr Submits a job to a logical or actual destination 

pdq Queries the status of selected jobs, of all jobs submitted to a logical 

destination, or of all jobs assigned to an actual destination

InfoPrint Manager allows authorized users (the job owner is usually authorized) to 

use the following InfoPrint commands: 

pdmod 

Modifies the attributes of submitted jobs or of the documents in them 

pdrm Deletes jobs

InfoPrint Manager allows only authorized users to use the following InfoPrint 

commands: 

pdaccount 

Collects summary accounting information for a specified time period in a 

comma delimited format about actual destinations on one or more servers. 

This information can be filed and imported into a spread sheet to calculate 

the cost of consumables, the usage rate of printers, the cost for each user, 

and so forth. 

pdcreate 

Creates logical destinations, queues, actual destinations, default jobs, 

default documents, media, auxiliary sheets, and resource contexts. 

pdclean 

Removes all jobs from a server, logical destination, queue, or actual 

destination. 

pddelete 

Deletes servers, logical destinations, queues, actual destinations, default 

jobs, default documents, media, auxiliary sheets, resource contexts, and 

jobs. 

pddisable 

Prevents destinations from accepting jobs and logs from logging. 

pdenable 

Enables destinations to accept jobs and logs to log. 
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pdpause 

Pauses a job, actual destination, queue, or all the queues and actual 

destinations in a server. 

pdpromote 

Advances a job to the head of the queue. 

pdreorder 

Reassigns a job to an actual destination or to the unassigned jobs area in 

the same server or in another server, and allows you to schedule it 

immediately before or after another job. 

pdresubmit 

Resubmits a job, all the jobs submitted to a logical destination, or all the 

jobs in a queue to another logical destination. 

pdresume 

Enables paused objects to resume operation. 

pdset Sets or changes the values of attributes describing InfoPrint objects. 

pdshutdown 

Stops servers or actual destinations. 

pdspace 

Backspaces or forward spaces a PSF physical printer.

Note: For more information about InfoPrint commands and attributes, refer to 

InfoPrint Manager: Reference or to the man pages. Command man pages have the 

same name as the command. 

Examples using the InfoPrint HP-UX client 

The InfoPrint Manager: Reference and the command man pages show several 

examples of each command that you can issue from the InfoPrint HP-UX client. 

This section contains examples using the commands to perform some common 

tasks. 

Filtering destinations 

To find a destination near you that can print two-sided PostScript jobs, enter: 

pdls -c destination -f "destination-realization==actual 

   && document-format-supported==postscript && sides-supported==2" 

   -r "destination-location" \*: 

The -f flag specifies that you want to either filter on or list only actual destinations 

that support PostScript format and two-sided printing. The -r flag specifies that 

you want to request where the actual destinations reside. The asterisk means that 

you want to check every server. The blank after the colon means that you want to 

check every destination in every server. The backslash prevents the shell from 

interpreting the asterisk as a special character. 

InfoPrint returns information similar to the following: 

caxton:  destination-location = 3rd floor E 

elzevir: destination-location = 

morris:  destination-location = 1st floor W 

You decide to print your job on morris. To determine a logical destination that 

routes jobs to morris, enter: 
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pdls -c destination -f "destination-associated-destinations==morris" \*: 

Querying server status 

To query the status of the InfoPrint server, enter: 

pdls -c server 

Querying device status 

To query the status of all printers on the InfoPrint server whose hostname is 

pauper, enter: 

pdls -c printer pauper 

Querying a print job 

To submit the file myjob to the logical destination london, requesting two-sided 

printing on the actual destination morris, enter: 

pdpr -d london -x "destination-name-requested=morris sides=2" myjob 

Submitting a print job 

To submit the file newjob to the logical destination boston , requesting single-sided 

printing on the actual destination printer1, enter: 

pdpr -d boston -x "destination-name-requested=printer1 sides=1" newjob 

Querying jobs 

To list the jobs associated with logical destination ld1 on the server newyork, 

showing detailed information (-r verbose) and not filtering for particular criteria, 

such as the job submitter (-F), enter: 

pdq -p newyork:ld1 -r verbose -F 

Modifying the job name 

To change the job name attribute of one of the jobs that was listed in “Querying 

jobs,” enter: 

pdmod -x "job-name=NewJobName" newyork:job_ID 

Removing a job 

To remove one of the jobs that was listed in “Querying jobs,” enter: 

pdrm newyork:job_ID 
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Chapter  22.  Using  the  InfoPrint  Manager  Sun  Solaris  client  

The InfoPrint Manager Sun Solaris client enables users of Sun Solaris 2.5.1 and 

above to issue InfoPrint commands over a TCP/IP-connected network to an 

InfoPrint Manager for AIX or an InfoPrint Manager for Windows server. Using a 

UNIX command line or shell script, you can query server, printer, and print job 

status; change the state of a server, printer, or print job; create, delete, or reorder a 

print job on the server. The Sun Solaris client does not support files larger than 2 

GB in size. 

To install the InfoPrint Manager Sun Solaris client, you can use the Infoprint 

Manager Common Clients, LCD4-1917. 

Access to the InfoPrint Manager server and to the InfoPrint Manager commands is 

controlled on the system where the server is installed. For information about 

providing access, refer to InfoPrint Manager for Windows: Procedures. 

Note: Consult the installation procedures on either the InfoPrint Manager for AIX 

site or the InfoPrint Manager for Windows site, both at http://www.infoprint.com, 

for the latest information on installing the InfoPrint Manager Sun Solaris client. 

Installing the InfoPrint Manager Sun Solaris client 

Attention:  The Sun Solaris client and the InfoPrint server are available in the 

following languages: 

v   English 

v   French 

v   German 

v   Italian 

v   Japanese 

v   Spanish 

v   Korean

You should associate the Sun Solaris client with an InfoPrint server running in 

your language. 

To install the InfoPrint Manager Sun Solaris client, follow these steps: 

 1.   Log on to the Sun Solaris client system as root. 

 2.   Create a directory called /usr/lpp/pd/bin on the Sun Solaris client system. This 

directory must have approximately one megabyte of available storage. 

 3.   Copy the pdcommand.solaris.251 file from the Infoprint Manager Common 

Clients CD-ROM, LCD4-1917, to the /usr/lpp/pd/bin directory. 

 4.   Enter locale to determine the value of the LC_MESSAGES environment 

variable. Make a note of this value, for example, en_US. 

 5.   Copy the ipr.cat file from the Infoprint Manager Common Clients CD-ROM, 

LCD4-1917, to the /usr/lib/locale/<locale> directory, where <locale> is the 

value that you noted in the last step. For example, /usr/lib/locale/en_US/. 

 6.   Change to the /usr/lpp/pd/bin directory. 

 7.   Type the following command: 
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mv pdcommand.solaris.251 pdcommand 

 8.   Create links to the pdcommand for each supported command that you wish 

to make available. See “Commands you can use from the InfoPrint Sun Solaris 

client” on page 147 for the names of the supported commands. 

For example, to support the pdls command, which lists information about 

InfoPrint objects, type the following command: 

ln -s pdcommand pdls 

 9.   Create a shell script in the language of your choice or manually set the 

following environment variables: 

PDHOST 

The name of the host where the InfoPrint server resides. 

PD_SOCKET 

The TCP/IP socket number of the port for the InfoPrint server. The 

default socket is 6874. Use 6874 unless your system has been 

specifically set up differently or you have more than one InfoPrint 

Manager server running on the host. 

PDPRINTER 

The default logical destination in the InfoPrint Manager server. The 

commands will use this value if you do not specify a logical 

destination (the -P DestinationName flag) on the command line. 

PATH Add the /usr/lpp/pd/bin directory to the value of this variable. 

NLSPATH 

The path for the message catalog.
The following example shows a Korn shell script to set the environment 

variables: 

export PDHOST="hostname-of-InfoPrint-server" 

export PD_SOCKET="6874" 

export PDPRINTER="name-of-default-logical-destination" 

export PATH=/usr/lpp/pd/bin:$PATH 

export NLSPATH=/usr/lib/locale/%L/%N:$NLSPATH 

10.   Test the system: 

a.   Open a command line window. 

b.   Set the environment variables as directed in Step 9, either manually or 

using a shell script. 

c.   Issue one of the chosen commands, followed by the -h flag to display the 

syntax of that command and verify the installation. 

For example: 

pdls -h 

d.   Arrange for all users of the Sun Solaris client to set the environment 

variables as directed in Step 9, whenever they log in. You can use either of 

these methods: 

v   Set the environment variables in the default shell configuration file, 

either individually or by invoking the shell script. 

v   Tell each user to set the environment variables in his or her own shell 

configuration file, either individually or by invoking the shell script.
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Commands you can use from the InfoPrint Sun Solaris client 

Information about security and how users can be authorized to InfoPrint Manager 

is found in the topic “Managing Security” in the InfoPrint Manager for Windows: 

Procedures manual. 

InfoPrint Manager allows authorized users (normally all users) to use the 

following InfoPrint commands: 

pdls Lists selected attribute values for a job, destination, or other InfoPrint 

object 

pdpr Submits a job to a logical or actual destination 

pdq Queries the status of selected jobs, of all jobs submitted to a logical 

destination, or of all jobs assigned to an actual destination

InfoPrint Manager allows authorized users (the job owner is usually authorized) to 

use the following InfoPrint commands: 

pdmod 

Modifies the attributes of submitted jobs or of the documents in them 

pdrm Deletes jobs

InfoPrint Manager allows only authorized users to use the following InfoPrint 

commands: 

pdaccount 

Collects summary accounting information for a specified time period in a 

comma delimited format about actual destinations on one or more servers. 

This information can be filed and imported into a spread sheet to calculate 

the cost of consumables, the usage rate of printers, the cost for each user, 

and so forth. 

pdcreate 

Creates logical destinations, queues, actual destinations, default jobs, 

default documents, media, auxiliary sheets, and resource contexts. 

pdclean 

Removes all jobs from a server, logical destination, queue, or actual 

destination. 

pddelete 

Deletes servers, logical destinations, queues, actual destinations, default 

jobs, default documents, media, auxiliary sheets, resource contexts, and 

jobs. 

pddisable 

Prevents destinations from accepting jobs and logs from logging. 

pdenable 

Enables destinations to accept jobs and logs to log. 

pdpause 

Pauses a job, actual destination, queue, or all the queues and actual 

destinations in a server. 

pdpromote 

Advances a job to the head of the queue. 
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pdreorder 

Reassigns a job to an actual destination or to the unassigned jobs area in 

the same server or in another server, and allows you to schedule it 

immediately before or after another job. 

pdresubmit 

Resubmits a job, all the jobs submitted to a logical destination, or all the 

jobs in a queue to another logical destination. 

pdresume 

Enables paused objects to resume operation. 

pdset Sets or changes the values of attributes describing InfoPrint objects. 

pdshutdown 

Stops servers or actual destinations. 

pdspace 

Backspaces or forward spaces a PSF physical printer.

Note: For more information about InfoPrint commands and attributes, refer to 

InfoPrint Manager: Reference or to the man pages. Command man pages have the 

same name as the command. 

Examples using the InfoPrint Sun Solaris client 

The InfoPrint Manager: Reference and the command man pages show several 

examples of each command that you can issue from the InfoPrint Sun Solaris 

client. This section contains examples using the commands to perform some 

common tasks. 

Filtering destinations 

To find a destination near you that can print two-sided PostScript jobs, enter: 

pdls -c destination -f "destination-realization==actual 

   && document-format-supported==postscript && sides-supported==2" 

   -r "destination-location" \*: 

The -f flag specifies that you want to either filter on or list only actual destinations 

that support PostScript format and two-sided printing. The -r flag specifies that 

you want to request where the actual destinations reside. The asterisk means that 

you want to check every server. The blank after the colon means that you want to 

check every destination in every server. The backslash prevents the shell from 

interpreting the asterisk as a special character. 

InfoPrint returns information similar to the following: 

caxton:  destination-location = 3rd floor E 

elzevir: destination-location = 

morris:  destination-location = 1st floor W 

You decide to print your job on morris. To determine a logical destination that 

routes jobs to morris, enter: 

pdls -c destination -f "destination-associated-destinations==morris" \*: 
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Querying server status 

To query the status of the InfoPrint server, enter: 

pdls -c server 

Querying device status 

To query the status of all printers on the InfoPrint server whose hostname is 

pauper, enter: 

pdls -c printer pauper 

Querying a print job 

To submit the file myjob to the logical destination london, requesting two-sided 

printing on the actual destination morris, enter: 

pdpr -d london -x "destination-name-requested=morris sides=2" myjob 

Submitting a print job 

To submit the file newjob to the logical destination boston , requesting single-sided 

printing on the actual destination printer1, enter: 

pdpr -d boston -x "destination-name-requested=printer1 sides=1" newjob 

Querying jobs 

To list the jobs associated with logical destination ld1 on the server newyork, 

showing detailed information (-r verbose) and not filtering for particular criteria, 

such as the job submitter (-F), enter: 

pdq -p newyork:ld1 -r verbose -F 

Modifying the job name 

To change the job name attribute of one of the jobs that was listed in “Querying 

jobs,” enter: 

pdmod -x "job-name=NewJobName" newyork:job_ID 

Removing a job 

To remove one of the jobs that was listed in “Querying jobs,” enter: 

pdrm newyork:job_ID 
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Chapter  23.  Using  the  InfoPrint  Manager  Linux  client  

The InfoPrint Manager Linux client enables users of Linux on Intel-based machines 

to issue InfoPrint commands over a TCP/IP-connected network to an InfoPrint 

Manager for AIX or an InfoPrint Manager for Windows server. Using a UNIX 

command line or shell script, you can issue a variety of commands to the InfoPrint 

server. The Linux client requires Red Hat 7.3 or above. The Linux client will 

support files greater than 2 GB in size. 

Installing the InfoPrint Linux client 

To install the InfoPrint Manager Linux client, follow these steps: 

1.   Log into the Linux system as root. 

2.   If you are installing from the Infoprint Manager Common Clients CD, 

LCD4-1917: 

a.   Insert the CD-ROM into the drive. 

b.   Mount the file system by typing: 

mount /mnt/cdrom 

c.   Type: 

cd /mnt/cdrom/linux 

d.   Install the Linux Client package by typing: 

rpm -i ipr-cmd-1.0-0.i386.rpm 

e.   Unmount the file system. 

f.   Remove the CD-ROM.
3.   If you are installing from the Web: 

a.   Download the Linux Client package. 

b.   Install the Linux client package by typing: 

rpm -i ipr-cmd-1.0-0.i386.rpm 

4.   The following environment variables must be set for the InfoPrint Manager 

client to work. The install process puts two shell configuration files 

(ipr-cmd.csh and ipr-cmd.sh) in the /etc/profile.d directory to set them. Edit 

these files and provide values for: 

PDHOST 

The name of the host where the InfoPrint Manager server resides. 

PD_SOCKET 

The TCP/IP socket number of the port for the InfoPrint Manager 

server. The default socket is 6874 . Use 6874 unless your system has 

been specifically set up differently or you have more than one InfoPrint 

Manager server running on the host. 

PDPRINTER (optional) 

The default logical destination in the InfoPrint Manager server that you 

want to use. The commands use this value if you do not specify a 

logical destination on the command line.

Note: Users can override these settings with their own settings. 

5.   Test the system: 
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a.   Log off and log back on to pickup the changes. 

b.   Issue one of the commands, followed by the -h flag to display the syntax of 

that command and verify the installation. 

For example: 

pdls -h 

Commands you can use from the InfoPrint Linux client 

Information about security and how users can be authorized to InfoPrint Manager 

is found in the topic “Managing Security” in the InfoPrint Manager for Windows: 

Procedures manual. 

InfoPrint Manager allows authorized users (normally all users) to use the 

following InfoPrint commands: 

pdls Lists selected attribute values for a job, destination, or other InfoPrint 

object 

pdpr Submits a job to a logical or actual destination 

pdq Queries the status of selected jobs, of all jobs submitted to a logical 

destination, or of all jobs assigned to an actual destination

InfoPrint Manager allows authorized users (the job owner is usually authorized) to 

use the following InfoPrint commands: 

pdmod 

Modifies the attributes of submitted jobs or of the documents in them 

pdrm Deletes jobs

InfoPrint Manager allows only authorized users to use the following InfoPrint 

commands: 

pdaccount 

Collects summary accounting information for a specified time period in a 

comma delimited format about actual destinations on one or more servers. 

This information can be filed and imported into a spread sheet to calculate 

the cost of consumables, the usage rate of printers, the cost for each user, 

and so forth. 

pdcreate 

Creates logical destinations, queues, actual destinations, default jobs, 

default documents, media, auxiliary sheets, and resource contexts. 

pdclean 

Removes all jobs from a server, logical destination, queue, or actual 

destination. 

pddelete 

Deletes servers, logical destinations, queues, actual destinations, default 

jobs, default documents, media, auxiliary sheets, resource contexts, and 

jobs. 

pddisable 

Prevents destinations from accepting jobs and logs from logging. 

pdenable 

Enables destinations to accept jobs and logs to log. 
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pdpause 

Pauses a job, actual destination, queue, or all the queues and actual 

destinations in a server. 

pdpromote 

Advances a job to the head of the queue. 

pdreorder 

Reassigns a job to an actual destination or to the unassigned jobs area in 

the same server or in another server, and allows you to schedule it 

immediately before or after another job. 

pdresubmit 

Resubmits a job, all the jobs submitted to a logical destination, or all the 

jobs in a queue to another logical destination. 

pdresume 

Enables paused objects to resume operation. 

pdset Sets or changes the values of attributes describing InfoPrint objects. 

pdshutdown 

Stops servers or actual destinations. 

pdspace 

Backspaces or forward spaces a PSF physical printer.

Note: For more information about InfoPrint commands and attributes, refer to 

InfoPrint Manager: Reference or to the man pages. Command man pages have the 

same name as the command. 

Security Considerations 

Access to the InfoPrint Manager server and to the InfoPrint Manager commands is 

controlled on the system where the server is installed. If you are using InfoPrint 

Manager for AIX and your InfoPrint Manager server uses DCE security, you can 

only use the pdpr, pdls, and pdq commands. Otherwise, for information about 

providing access, refer to the following books: 

v   InfoPrint Manager for AIX: Procedures, G544-5815 

v   InfoPrint Manager for Windows: Procedures, G544-5814

National Language Support Considerations 

InfoPrint Manager servers are available in the following languages: 

v   English 

v   French 

v   German 

v   Italian 

v   Japanese 

v   Spanish 

v   Korean

You should associate (using PDHOST and PD_SOCKET) the Linux client with an 

InfoPrint Manager server running in your language. If you are running in a 

language not listed in this section, associate the Linux client with an InfoPrint 

server running in English. 
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Examples using the InfoPrint Linux client 

The InfoPrint Manager: Reference contains several examples of each command that 

you can issue from the InfoPrint Linux client. This section contains examples using 

the commands to perform some common tasks. 

Filtering destinations 

To find a destination near you that can print two-sided PostScript jobs, enter: 

pdls -c destination -f "destination-realization==actual && 

   document-format-supported==postscript && sides-supported==2" 

   -r "destination-location" *: 

The -f flag specifies that you want to either filter on or list only actual destinations 

that support PostScript format and two-sided printing. 

The -r flag specifies that you want to request where the actual destinations reside. 

The asterisk means that you want to check every server. 

The blank after the colon means that you want to check every destination in every 

server. 

InfoPrint returns information similar to the following: 

caxton:  destination-location = 3rd floor E 

elzevir: destination-location = 

morris:  destination-location = 1st floor W 

You decide to print your job on morris. To determine a logical destination that 

routes jobs to morris, enter: 

pdls -c destination -f "destination-associated-destinations==morris" && 

destination-realization==logical *: 

Querying destination attributes 

To determine whether morris is ready to receive jobs, enter: 

pdls -c destination morris 

The enabled and destination-state values indicate whether morris is ready to 

receive jobs. 

Submitting a print job 

To submit the file myjob to the logical destination london, requesting two-sided 

printing on the actual destination morris, enter: 

pdpr -d london -x "destination-name-requested=morris sides=2" myjob 

Querying jobs 

To list all the jobs that you submitted to logical destination london, enter: 

pdq -d london 
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InfoPrint Manager returns information similar to the following: 

 Job 

ID Name  

Intervening 

State 

Destination 

Jobs 

Destination 

Requested 

Destination 

Assigned 

13 Serv1:1104221000 printing 0 london caxton 

14 Serv1:1104221023 pending 8 london morris
  

Modifying job attributes 

After submitting myjob, you decide that you want to print two copies and that you 

want to retain it for one hour after it prints. When you queried the jobs submitted 

to london, you saw that the local Job ID is 14 and that the job is still pending, so it 

can be modified. To change the number of copies to two and add a retention 

period of one hour, enter: 

pdmod -n 2 -x “job-retention-period=1:00” 14 

Modifying destination attributes 

To restrict the Printer3 actual destination so that it does not accept very large jobs, 

complete the following: 

1.   Before you can modify the attributes of the Printer3 actual destination, you 

must disable it by entering the following: 

pddisable Printer3 

2.   To specify a new maximum job size of 5 meg for Printer3, enter: 

pdset -c destination -x “job-size-range-ready=0:500000” Printer3 

3.   To reenable the actual destination, enter: 

pdenable Printer3 

Shutting down an actual destination 

The printer device represented by the actual destination caxton is out of order. To 

shut down caxton until the printer device can be repaired and to associate a 

message with caxton, enter: 

pdshutdown -c destination -m “Service called Tuesday at 3PM” caxton 

Uninstalling the Linux client 

1.   Log in as root. 

2.   Type: 

rpm -e ipr-cmd-1.0-0 
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Chapter  24.  InfoPrint  Manager  hot  folders  

An InfoPrint Manager hot folder is a directory that is associated with a logical 

destination. When you copy or move a file to the hot folder, InfoPrint Manager 

automatically submits the file to that logical destination. The default job and 

document attributes that are set for that logical destination are applied to jobs 

submitted through the hot folder. 

If all of the systems that will be submitting jobs to hot folders are Windows 

systems, you can use standard Windows folder sharing to make the hot folder 

accessible to both the InfoPrint Manager server and to users. If you will be 

submitting jobs to hot folders from other systems (such as AIX), you will have to 

install and configure separate software to transfer the files (such as AIX 

FastConnect for Windows). The procedures below assume that jobs will be 

submitted only from other Windows systems. 

Note: Make sure you know what kinds of files the InfoPrint Manager destination 

will accept. The files that you put in the hot folder should already be print data 

streams (such as PCL or PostScript), not the standard ″working″ files that many 

desktop programs create. For example, if you are writing a report using word 

processing software, you cannot simply save the file and copy that file to the hot 

folder to be printed. You need to convert it into a print data stream first. One way 

to do that conversion is to create a printer on your desktop that uses a PostScript 

or PCL driver and the FILE: port. If you send a job to that printer, the output 

won’t be printed; it will be saved in a file (called my_report.ps, for example). Then, 

you can copy the new file into the hot folder to be sent to InfoPrint Manager. 

Configuring your system to work with hot folders 

1.   Decide what Windows system you want to create the hot folder on. Make sure 

that the InfoPrint Manager server and all users who will use it can access that 

system. 

Notes:  

a.   It is strongly recommended that you create your hot folder on the same 

system that your InfoPrint Manager server is installed on for these reasons: 

v   Performance will be better because the files have to be transferred over 

the network only once. 

v   The polling traffic created by the InfoPrint Manager server process when 

it is looking for new files may cause performance degradation of the 

remote server hosting the directory, the InfoPrint Manager system, or the 

network connection between them. 

v   If you need to restart the system that the InfoPrint Manager server is 

installed on, the InfoPrint Manager server will automatically have access 

to the hot folder when it restarts. If the hot folder is on a different 

system, you must log on to the InfoPrint Manager server system to 

re-establish the connection.
b.   If you plan to have more than one hot folder, you can create all of them in 

the same parent directory. That way, users can access all of them through a 

single mapped drive.
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2.   Use the regular Windows process to create a directory (add a folder to an 

existing directory). Name the folder something distinctive, so you know that it 

is a hot folder, and possibly, what logical destination it submits jobs to or what 

department should submit jobs to it. 

3.   Set up sharing on the folder so that the InfoPrint Manager server and users 

who will submit jobs to it have write access to it. 

4.   Open the InfoPrint Manager Administration GUI. 

5.   Find or create the logical destination that you want the hot folder to submit 

jobs to and select it. 

6.   In the Properties notebook for the logical destination, click the General tab and 

find the Hot folder location field. Type the directory path that the InfoPrint 

Manager server system will use to access the hot folder. 

If the hot folder is in a different partition or on a different hard drive than your 

InfoPrint Manager server, this path will include the drive letter for that 

partition or drive and the directory path to the hot folder. For example, 

d:\hotfolders\copy_postscript_here. Refer to the InfoPrint Manager 

Administration GUI online help for further instructions. 

Note: A hot folder can be associated with only one logical destination, and a 

logical destination can be associated with only one hot folder. 

7.   Set the default document and default job attributes for the logical destination. 

Unless the job submitter overrides them, these attribute values will be used for 

all jobs submitted through the hot folder. Refer to the InfoPrint Manager 

Administration GUI online help for instructions.

When you tell users how to submit jobs to the hot folder, be sure to tell them what 

types of files the InfoPrint Manager destination can accept and how to generate 

those files. 

Mapping a network drive 

On the end user system, use the standard Windows method to map a network 

drive (available in Windows Explorer) to the InfoPrint Manager hot folder. If there 

are multiple hot folders within the same directory, you only have to map one 

network drive to the parent directory; you will be able to access all of the 

subdirectories through it. 

Submitting jobs through a hot folder 

To submit a job through a hot folder, simply copy or move the print file to the hot 

folder. 

Note: If you experience problems with hot folders submitting incomplete jobs to 

the InfoPrint Manager server, use “Specifying hot folder poll method” on page 159 

when you have multiple-document jobs or single-document jobs with Network File 

System shares, else use the method described in “Submitting multiple-document 

jobs” on page 160.

Attention:  If you want to save the file, copy it. Files are deleted from the hot 

folder after submission.
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Specifying job attributes 

By default, jobs submitted through a hot folder use the attribute values in the 

default document and default job associated with the logical destination; and also 

by default, hot folder jobs are submitted to InfoPrint Manager with job 

notifications turned off. If you want to receive notifications about jobs that you 

submit through hot folders, you must specify a notification-profile with an explicit 

delivery-address in the .att file. If you want to specify other attributes or use 

different values for existing attributes, complete these steps. 

1.   Either on your system or in the hot folder itself, create a text file to use as your 

attributes file. Name the attributes file filename.att, where filename is the same as 

the file name of the print file. For example, if the print file is report.pdf, the 

attributes file is report.pdf.att. 

2.   In the attributes file, specify the InfoPrint attributes and values that you want 

to use for this job. For example, if you want to print three single-sided copies 

of report.pdf, report.pdf.att looks like this: 

copy-count = 3 

sides = 1 

Note: The attributes file is in the same format as a –X file passed to a pdpr 

command.
For information about job and document attributes, refer to InfoPrint Manager: 

Reference. 

3.   If you created the attributes file on your system, copy or move the file to the 

hot folder. The InfoPrint Manager logical destination recognizes the .att file 

extension as an attributes file and knows not to try to print it. 

4.   Copy or move the print file to the hot folder. The InfoPrint Manager logical 

destination sees the print file and looks for an attributes file with the same file 

name. Both of the files are taken and your attributes are used.

Specifying hot folder poll method 

There are two hot folder poll methods. By default, the file access monitoring 

method is used when jobs are submitted through a hot folder. This method is used 

for single or multiple-document jobs. If you have hot folders with large single or 

multiple-document jobs, or both, copied over the network in a Network File Share 

folder, you need to use the file size monitoring method. This method will check 

the file size during the poll interval before submitting the job to InfoPrint manager. 

The default method will not work for files being copied over the network in a NFS 

folder. 

You can specify the hot folder poll method with this procedure: 

1.   Open the InfoPrint Manager Administration GUI. 

2.   Find the logical destination that you want the hot folder to submit jobs to and 

select it. 

3.   In the Properties notebook for the logical destination, click Hot folder poll 

method and select the hot folder poll method suitable for you. If you use the 

File size monitoring method, key in the poll interval value in the Hot folder 

poll interval field. The default value is 30. 

4.   Copy the documents you want to print into the hot job folder.

Note: If you copy multiple files in a single operation on a Windows system, 

the order of document submission will be in alphabetical order. If the print 
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order matters, rename the files according to the intended submission order or 

use the “Submitting multiple-document jobs” method.

Staging jobs 

You can stage jobs to InfoPrint Manager with this procedure: 

1.   Make a copy of the print file on your local system. 

You will end up with 2 files: report.pdf and copy of report.pdf. 

2.   Rename the copy of the print file so that it has the same name as the original 

print file and the extension .stg. 

Rename copy of report.pdf to report.pdf.stg. 

3.   Copy the new file to the hot folder. 

Copy report.pdf.stg and paste it in the hot folder. 

Note: The InfoPrint Manager logical destination ignores files with the .stg 

extension. 

4.   Change the extension back to the original extension when you want the job to 

print. 

Rename report.pdf.stg back to report.pdf. InfoPrint Manager will pick up the 

renamed file and send it to print.

Submitting multiple-document jobs 

You can use staging to print jobs that contain multiple documents. In this case, you 

stage an entire directory. The InfoPrint Manager logical destination prints the 

documents as one job, in the order that you copied the files into the directory. 

1.   Navigate to the hot folder (using Windows Explorer, for example). 

2.   In the hot folder directory, create a new folder named jobname.stg, where 

jobname is any name you choose. 

Note: The InfoPrint Manager logical destination ignores directories with the 

.stg extension. 

3.   Copy the documents you want to print into the subdirectory in the same order 

that you want to print them. 

Note: If you copy multiple files in a single operation, they may not be copied 

in the same order that you selected them. If the print order matters, copy the 

files one at a time. 

4.   If you want to override the default attributes, create an attributes file called 

jobname.att, where jobname is the same as the subdirectory name, and copy it 

into the hot folder. 

5.   Rename the subdirectory from jobname.stg to jobname. The InfoPrint Manager 

logical destination then accepts all of the files in the subdirectory as a single 

job.
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Chapter  25.  Submitting  print  jobs  through  the  InfoPrint  

Manager  LPD  

The InfoPrint Manager Line Printer Daemon (LPD) is a utility that allows you to 

submit print jobs from other operating systems using a Line Printer (LPR) client. 

The InfoPrint Manager LPD replaces the LPD that is supplied with the Windows 

operating system (TCP/IP Print Services), however, it submits the files it receives 

directly to an InfoPrint destination, not to a Windows printer. It also supports the 

-o options that are available with some LPR clients (-o options allow you to specify 

advanced InfoPrint print options such as formdefs and pagedefs). 

Only one LPD can run on your InfoPrint Manager server system at a time. If you 

have TCP/IP Print Services installed, InfoPrint Manager disables it and enables the 

InfoPrint Manager LPD. If you would prefer to use TCP/IP Print Services, use the 

Management Console to change the service configuration. Refer to the 

Management Console help for further instructions. 

Important: If you have a different LPD installed, InfoPrint Manager does not 

disable it, but installs and starts the InfoPrint Manager LPD. You must stop one of 

the LPDs before you try to submit a print job using an LPR client. 

To submit print jobs to the InfoPrint Manager LPD, you can use any LPR client. 

However, if you want to be able to specify advanced InfoPrint options on the –o 

flag, you should use the lprafp sample code package. lprafp is an LPR client that 

is available as a free download from the InfoPrint Solutions Company Web site. 

The package includes executable forms of the lprafp client for the Windows and 

AIX (version 5.1 and above) platforms. You can compile this code to use it on other 

platforms as well. InfoPrint Solutions Company does not provide support for the 

package. 

Note: The Microsoft LPR client supports a –o flag, but it is not the same as the 

InfoPrint –o. Any values you pass to InfoPrint Manager using the Microsoft –o flag 

will be lost. In addition, some LPR clients provide print control functions, such as 

landscape print. The InfoPrint Manager LPD does not support these options. 

Install and configure lprafp for Windows from the Web  

For Windows operating system clients, the lprafp sample code package is available 

for free download from the InfoPrint Solutions Company Web site at 

http://www.infoprint.com. Use this procedure to locate and install the package: 

 1.   Navigate to http://www.infoprint.com in your Web browser. 

 2.   Click Support & downloads. 

 3.   Click Support and maintenance. 

 4.   Select InfoPrint Manager for Windows in the Software Support list. 

 5.   On the InfoPrint Manager for Windows Home page, click Downloads. 

 6.   On the Downloads page, click InfoPrint Manager for Windows NT® and 

Windows 2000 downloads. 

 7.   Choose lprafp - LPR sample code package and click FTP. 

 8.   Save the lprafp.zip file to your machine. 

 9.   Use a zip utility to unzip the package. 
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10.   Open the readme.txt file and follow the instructions for installing the package 

on a Windows system.

Preparing to submit print jobs 

When you submit jobs to the InfoPrint Manager LPD, it uses a mapping file to 

match the keywords you specify on the -o option with InfoPrint attributes. A 

sample mapping file comes with InfoPrint Manager for Windows; before you 

submit any print jobs to the InfoPrint Manager LPD, you should modify this file to 

meet your needs. 

To modify the mapping file do the following. 

1.   Open the file <install path>\var\pd\lpd\lpdmap.txt (where <install path> is 

the directory where InfoPrint Manager is installed) in a text editor such as 

Notepad. 

2.   Read all of the instructions in the mapping file before you make any changes. 

3.   Edit the mappings as necessary and save the file using the same name.

Because all LPR clients use different keywords, it is impossible to list them all. The 

mappings listed are ″best guess″ mappings and may not generate the results you 

need. The best way to see what values you need to add or change is to 

uncomment the line that reads: 

* DEBUG 

and save the file. (To uncomment the line, delete the *.) Submit a print job through 

the LPD and check the output. If the job fails or if it prints incorrectly, check the 

error messages in the server log in the Management Console. Use them to help 

determine which keywords are missing or mapped incorrectly. When you are 

finished, be sure to open the mapping file and comment the DEBUG line out 

again. 

Submitting print jobs 

When you submit print jobs using the LPR client, all you need to specify is the 

InfoPrint Manager server and the name of an InfoPrint destination (logical or 

actual). The InfoPrint Manager LPD submits the job to the InfoPrint print spool. 
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Chapter  26.  Installing  and  configuring  the  AFP  driver  

The InfoPrint AFP Driver software allows you to produce Advanced Function 

Presentation (AFP) output from desktop applications so you can use the powerful 

features of AFP in a wider range of environments. Used in conjunction with 

InfoPrint Select or a Windows gateway printer, the AFP Driver provides a high 

degree of control over the appearance of your printed documents. This section 

contains procedures for unpacking and installing the InfoPrint AFP Driver on a 

Windows system. 

English versions of the AFP drivers for all Windows platforms are provided on the 

Infoprint Manager for Windows Common Clients CD-ROM. You can also 

download English and other language versions of the AFP driver from the 

InfoPrint Solutions Company Web site at http://www.infoprint.com. Translated 

drivers may not be identical to the English version because they are updated on a 

different schedule. 

Use the procedures below to unpack and install the AFP drivers on your Windows 

system. 

Notes:  

1.   For the most current AFP Driver in English and other languages, go to the 

InfoPrint Solutions Company Web site at http://www.infoprint.com/. 

2.   The AFP Driver for Windows 2000 is known to produce unpredictable results 

when used with InfoPrint Manager for Windows. Therefore, it is highly 

recommended that you not install the AFP Driver for Windows 2000. 

3.   If you plan to use this driver to submit print jobs using InfoPrint Select, install 

this driver on the same system that InfoPrint Select is installed on. If you plan 

to use this driver to submit print jobs using a Windows gateway printer, install 

the driver on the system that your InfoPrint Manager server is installed on.

Installing the AFP driver files 

1.   Insert the Common Clients CD-ROM, LCD4-1917, that came with your 

InfoPrint Manager package into your CD-ROM drive. The install program starts 

automatically. 

2.   Click the Install Infoprint Products button and then select the AFP Print 

Driver button. 

3.   Select the appropriate operating system and language. 

Note: If you are installing the AFP driver files as part of a service update, 

language information is obtained automatically, and you are not asked to 

specify a language. 

4.   The License Agreement displays. Click the Accept button, then click Next. 

5.   Follow the instructions to unpack the files into the desired directory. We 

recommend that you place the driver files in an easy to find directory, such as 

c:\afpdriver.
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Configuring the AFP driver 

Once the files have been installed, you must complete the process of configuring 

the AFP driver by creating a printer that uses the driver. If you are installing the 

driver on a client workstation that has InfoPrint Select installed on it, refer to the 

InfoPrint Select readme file for instructions on creating a Select printer that uses 

this driver. If you are installing this driver on the system that your InfoPrint 

Manager server is installed on, follow the appropriate procedure below. 

Notes:  

1.   The Windows printers that result from these procedures do not send print jobs 

to actual printer devices; they generate files. If you want to create a Windows 

printer that sends jobs to one of your printer devices, change the procedure as 

necessary. 

2.   Once you complete this procedure, you can delete the printer that you created. 

The driver will still be installed.

Setting up the InfoPrint AFP Driver on a Windows 2000 or 

2003 system 

 1.   Click the Windows Start button and select Settings → Printers. 

 2.   In the Printers window, double-click the Add printer icon to start the Add 

Printer Wizard. 

 3.   On the first panel of the wizard, click Next. 

 4.   In the Local or Network printer dialog, select Local and click Next. 

 5.   In the Select Printer Port dialog, select FILE: and click Next. 

 6.   In the next dialog, click Have disk without selecting a printer or a 

manufacturer. 

 7.   In the Install from disk dialog, type the path to the directory that you copied 

the AFP driver files into (for example, c:\afpdriver) and click OK. 

 8.   Select the printer that you plan to use this driver with from the list and click 

Next. 

Note: If your printer does not appear in the list, select Infoprint AFP nnn, 

where nnn is the resolution of your printer. 

 9.   In the next dialog, accept the name of the printer and do not set it to be your 

default printer. Click Next. 

10.   Leave the printer Not shared and click Next. 

11.   Do not print a test page and click Next. 

12.   Click Finish. 

13.   If a dialog displays telling you that the driver doesn’t have a digital signature, 

simply select Yes to finish installing the driver.

Setting up the InfoPrint AFP Driver on a Windows XP system 

 1.   Click the Windows Start button and select Settings → Printers and Faxes. 

 2.   In the Printers window, click the Add a printer selection to start the Add 

Printer Wizard. 

 3.   On the first panel of the wizard, click Next. 

 4.   In the Local or Network printer dialog, select Local and click Next. 

 5.   In the Select Printer Port dialog, select FILE: and click Next. 
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6.   In the next dialog, click Have disk without selecting a printer or a 

manufacturer. 

 7.   In the Install from disk dialog, type the path to the directory that you copied 

the AFP driver files into (for example, c:\afpdriver) and click OK. 

 8.   Select the printer that you plan to use this driver with from the list and click 

Next. 

Note: If your printer does not appear in the list, select Infoprint AFP nnn, 

where nnn is the resolution of your printer. 

 9.   In the next dialog, accept the name of the printer and do not set it to be your 

default printer. Click Next. 

10.   Leave the printer Not shared and click Next. 

11.   Do not print a test page and click Next. 

12.   Click Finish. 

13.   If a dialog displays telling you that the driver has not passed Windows Logo 

testing, simply select Continue Anyway to finish installing the driver.

Setting up the InfoPrint AFP Driver on a Windows Vista  

Business or Enterprise system 

 1.   From the Windows desktop, click Start → Settings → Printers. 

 2.   In the Printers window, click the Add a printer selection to open the Add 

Printer window. 

 3.   Select Add a local printer. 

 4.   In the Choose a Printer Port dialog, select FILE: and click Next. 

 5.   In the next dialog, click Have Disk without selecting a printer or a 

manufacturer. 

 6.   In the Install from disk dialog, type the path to the directory that you copied 

the AFP driver files into (for example, c:\afpdriver) and click OK. 

 7.   Select the printer that you plan to use this driver with from the list and click 

Next. 

Note: If your printer does not appear in the list, select Infoprint AFP nnn, 

where nnn is the resolution of your printer. 

 8.   In the next dialog, accept the name of the printer and do not set it to be your 

default printer. Click Next. 

 9.   Click Finish. 

10.   If a dialog displays telling you that the driver has not passed Windows Logo 

testing, simply select Continue Anyway to finish installing the driver.
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Appendix.  Accessibility  

Accessibility features help a user who has a physical disability, such as restricted 

mobility or limited vision, use software products successfully. The major 

accessibility features in the InfoPrint Manager for Windows let users: 

v   Use assistive technologies such as screen-readers and screen magnifier software. 

v   Operate specific or equivalent features using only the keyboard. 

v   Customize display attributes such as color, contrast, and font size.

Using assistive technologies 

Assistive technology products, such as screen-readers, function with the user 

interfaces found in the InfoPrint Manager for Windows. Consult the assistive 

technology documentation for specific information when using it to access the 

InfoPrint Manager for Windows. 

Keyboard navigation of the user interface 

The InfoPrint Manager for Windows user interface complies with the accessibility 

guidelines for HTML. Users can use keyboard shortcuts or function keys (PF keys) 

to access the InfoPrint Manager for Windows user interface. For example, 

Alt+Shift+F2 lets you skip to the main content. Refer to your browser 

documentation for keyboard shortcuts and default settings for the PF keys and for 

explanations about how to modify their functions. 
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Notices  

This information was developed for products and services offered in the U.S.A. 

InfoPrint Solutions Company may not offer the products, services, or features 

discussed in this document in other countries. Consult your local InfoPrint 

Solutions Company representative for information on the products and services 

currently available in your area. Any reference to an InfoPrint Solutions Company 

product, program, or service is not intended to state or imply that only that 

InfoPrint Solutions Company product, program, or service may be used. Any 

functionally equivalent product, program, or service that does not infringe any 

InfoPrint Solutions Company intellectual property rights may be used instead. 

However, it is the user’s responsibility to evaluate and verify the operation of any 

non-InfoPrint Solutions Company product, program, or service. 

InfoPrint Solutions Company may have patents or pending patent applications 

covering subject matter described in this document. The furnishing of this 

document does not give you any license to these patents. You can send license 

inquiries, in writing, to: 

InfoPrint Solutions Company, LLC 

6300 Diagonal Hwy 002J 

Boulder, CO 80301-9270 

U.S.A. 

For license inquiries regarding double-byte (DBCS) information, contact the 

InfoPrint Solutions Company Intellectual Property Department in your country or 

send inquiries, in writing, to: 

InfoPrint Solutions Company, LLC 

6300 Diagonal Hwy 002J 

Boulder, CO 80301-9270 

U.S.A. 

The following paragraph does not apply to the United Kingdom or any other 

country where such provisions are inconsistent with local law: INFOPRINT 

SOLUTIONS COMPANY PROVIDES THIS PUBLICATION ″AS IS″ WITHOUT 

WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT 

NOT LIMITED TO, THE IMPLIED WARRANTIES OF NON-INFRINGEMENT, 

MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Some states 

do not allow disclaimer of express or implied warranties in certain transactions, 

therefore, this statement may not apply to you. 

This information could include technical inaccuracies or typographical errors. 

Changes are periodically made to the information herein; these changes will be 

incorporated in new editions of the publication. InfoPrint Solutions Company may 

make improvements and/or changes in the product(s) described in this publication 

at any time without notice. 

Any references in this information to non-InfoPrint Solutions Company Web sites 

are provided for convenience only and do not in any manner serve as an 
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endorsement of those Web sites. The materials at those Web sites are not part of 

the materials for this InfoPrint Solutions Company product and use of those Web 

sites is at your own risk. 

InfoPrint Solutions Company may use or distribute any of the information you 

supply in any way it believes appropriate without incurring any obligation to you. 

Licensees of this program who wish to have information about it for the purpose 

of enabling: (i) the exchange of information between independently created 

programs and other programs (including this one) and (ii) the mutual use of the 

information which has been exchanged, should contact: 

InfoPrint Solutions Company, LLC 

6300 Diagonal Hwy 002J 

Boulder, CO 80301-9270 

U.S.A. 

Such information may be available, subject to appropriate terms and conditions, 

including in some cases, payment of a fee. 

The licensed program described in this document and all licensed material 

available for it are provided by InfoPrint Solutions Company under terms of the 

InfoPrint Solutions Company Customer Agreement, InfoPrint Solutions Company 

International Program License Agreement or any equivalent agreement between us. 

Any performance data contained herein was determined in a controlled 

environment. Therefore, the results obtained in other operating environments may 

vary significantly. Some measurements may have been made on development-level 

systems and there is no guarantee that these measurements will be the same on 

generally available systems. Furthermore, some measurement may have been 

estimated through extrapolation. Actual results may vary. Users of this document 

should verify the applicable data for their specific environment. 

Information concerning non-InfoPrint Solutions Company products was obtained 

from the suppliers of those products, their published announcements or other 

publicly available sources. InfoPrint Solutions Company has not tested those 

products and cannot confirm the accuracy of performance, compatibility or any 

other claims related to non-InfoPrint Solutions Company products. Questions on 

the capabilities of non-InfoPrint Solutions Company products should be addressed 

to the suppliers of those products. 

All statements regarding InfoPrint Solutions Company’s future direction or intent 

are subject to change or withdrawal without notice, and represent goals and 

objectives only. 

All InfoPrint Solutions Company prices shown are InfoPrint Solutions Company’s 

suggested retail prices, are current and are subject to change without notice. Dealer 

prices may vary. 

This information is for planning purposes only. The information herein is subject to 

change before the products described become available. 

This information contains examples of data and reports used in daily business 

operations. To illustrate them as completely as possible, the examples include the 
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names of individuals, companies, brands, and products. All of these names are 

fictitious and any similarity to the names and addresses used by an actual business 

enterprise is entirely coincidental. 

COPYRIGHT LICENSE: 

This information contains sample application programs in source language, which 

illustrates programming techniques on various operating platforms. You may copy, 

modify, and distribute these sample programs in any form without payment to 

InfoPrint Solutions Company, for the purposes of developing, using, marketing or 

distributing application programs conforming to the application programming 

interface for the operating platform for which the sample programs are written. 

These examples have not been thoroughly tested under all conditions. InfoPrint 

Solutions Company, therefore, cannot guarantee or imply reliability, serviceability, 

or function of these programs. 

If you are viewing this information softcopy, the photographs and color 

illustrations may not appear. 

References in this document to InfoPrint Solutions Company products, product 

features, programs or services do not imply that InfoPrint Solutions Company 

intends to make such products, product features, programs or services available in 

all countries in which InfoPrint Solutions Company operates or does business. 

Trademarks  

These terms are trademarks or registered trademarks of Ricoh Co., Ltd., in the 

United States, other countries, or both: 

v   Advanced Function Printing 

v   AFCCU 

v   AFP 

v   BCOCA 

v   InfoPrint 

v   Infoprint 

v   Intelligent Printer Data Stream 

v   IPDS 

v   Mixed Object Document Content Architecture 

v   MO:DCA 

v   Ricoh 

These terms are trademarks or registered trademarks of International Business 

Machines Corporation in the United States, other countries, or both: 

v   AIX 

v   DFS 

v   HACMP 

v   IBM 

v   iSeries 

v   MVS 

v   Notes 

v   OS/2 

v   OS/390 
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v   POWER 

v   Print Services Facility 

v   S/370 

v   S/390 

v   SecureWay 

v   System/370 

v   z/OS 

Adobe, the Adobe logo, PostScript, and the PostScript logo are either registered 

trademarks or trademarks of Adobe Systems Incorporated in the United States 

and/or other countries. 

Java and all Java-based trademarks are trademarks of Sun Microsystems, Inc. in the 

United States, other countries, or both. 

Linux is a registered trademark of Linus Torvalds in the United States, other 

countries, or both. 

Microsoft, Windows, Windows NT, and the Windows logo are trademarks of 

Microsoft Corporation in the United States, other countries, or both. 

UNIX is a registered trademark of The Open Group in the United States and other 

countries. 

Other company, product, or service names may be trademarks or service marks of 

others. 
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Glossary  

This glossary provides definitions of specialized 

terms used by InfoPrint. This glossary does not 

define terms that are defined in non-technical 

dictionaries or that have no special meaning in 

information processing. 

Sources and References 

This glossary includes definitions from the 

following sources: 

v   Definitions reprinted from a published section 

of the International Organization for 

Standardization’s (ISO) Vocabulary—Information 

Processing or from a published section of the 

ISO Vocabulary—Office Machines are identified 

by the symbol (I) following the definition. 

v   Definitions reprinted from working documents, 

draft proposals, or draft international standards 

of ISO Technical Committee 97, Subcommittee 1 

(Vocabulary) are identified by (T), indicating 

that final agreement has not yet been reached 

among its participating members. 

v   Definitions reprinted from Introduction to OSF 

DCE, by Open Systems Foundation, published 

by Prentice-Hall, are identified by (OSF). 

v   Definitions from Portable Operating System 

Interface (POSIX) System Administration 

Interface/Printing Standards Project are identified 

by (P). 

v   Definitions from Information 

technology—Document printing application 

(DPA)—Part 1: Abstract-service definition and 

procedures are identified by (D). 

v   Definitions from AIX Version 4.1 Topic Index and 

Glossary are identified by (X). 

v   Definitions from IBM Dictionary of Computing. 

v   Definitions that are specific to certain products 

are so labeled, for example, “In InfoPrint”, or 

“In DCE”.

This glossary uses the following cross-references: 

Contrast with 

This refers to a term that has an opposed 

or substantively different meaning. 

Synonym for 

This indicates that the term has the same 

meaning as a preferred term, which is 

defined in its proper place in the glossary. 

Synonymous with 

This is a backward reference from a 

defined term to all other terms that have 

the same meaning. 

See This refers you to multiple-word terms 

that have the same last word. 

See also 

This refers you to terms that have a 

related, but not synonymous, meaning.

Special Characters 

.Guidefaults file 

A file created by InfoPrint in the home 

directory of a person using the InfoPrint 

GUI. InfoPrint uses this file to save and 

reference information about the servers 

you are monitoring and the windows you 

are working in.

A 

Access Control List (ACL) 

In computer security, a collection of all 

access rights for one object. 

 In DCE, a list associated with each object 

in the namespace that specifies the access 

authorization level for each user or user 

group. 

ACL Access Control List. 

acl editor 

A command line interface that allows you 

to view, add, update, and delete access 

authorization records in an ACL. 

action In the InfoPrint GUI, an icon that 

represents an operation that you can 

perform on an InfoPrint object. You drag 

and drop the action onto an object to 

initiate the operation for that object. For 

example, using the Enable action to 

enable a disabled actual destination. 

actual destination 

In InfoPrint, an object that represents the 

output device that performs the printing 

or transmission function. See email 
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destination, fax destination; see also physical 

printer,  printer device; contrast with logical 

destination. 

additive color system 

A system that reproduces an image by 

mixing (adding) appropriate quantities of 

red, green, and blue light (the additive 

primary colors) to create all other colors 

of light, either direct or transmitted. 

When the additive primaries are 

superimposed on one another, they create 

white light. Contrast with subtractive color 

system. 

administrator 

In InfoPrint, the person who creates and 

manages one or more components of a 

printing system, such as servers and 

actual destinations. By default, InfoPrint 

gives administrators authorization to 

perform some InfoPrint operations and to 

access certain information that is not 

available to the operators or job 

submitters. 

Adobe Acrobat 

An Adobe software program that 

provides instant access to documents in 

their original format, independent of 

computer platform. With the Adobe 

Reader, you can view, navigate, print, and 

present any Portable Document Format 

(.pdf) file. 

Adobe PageMaker 

A desktop publishing program that 

produces PostScript documents. 

Adobe PostScript Raster to Image Transform 

(RIP) See raster image processor (RIP). 

ADSM/6000 

Advanced Distributed Storage Manager. 

Advanced Distributed Storage Manager 

(ADSM/6000) 

A program that provides storage 

management for archived files. 

Advanced Function Common Control Unit 

(AFCCU™) 

An IBM RISC-based control unit with 

code common to all printers that use the 

AFCCU. 

Advanced Function Presentation (AFP) 

A set of licensed programs, together with 

user applications, that use the 

all-points-addressable concept to print 

data on a wide variety of printers or to 

display data on a wide variety of display 

devices. AFP includes creating, 

formatting, archiving, retrieving, viewing, 

distributing, and printing information. 

Advanced Function Presentation data stream 

(AFP data stream) 

The printer data stream used for printing 

AFP data. The AFP data stream includes 

composed text, page segments, electronic 

overlays, form definitions, and fonts 

downloaded from the operating system to 

the printer. 

 A presentation data stream that is 

processed in AFP environments. The AFP 

data stream includes MO:DCA-P-based 

data streams. 

Advanced Interactive Executive (AIX) 

An operating system used with RS/6000 

computers. The AIX operating system is 

IBM’s implementation of the UNIX 

operating system. 

AFCCU 

Advanced Function Common Control 

Unit. 

AFP Advanced Function Presentation. 

AFP data stream 

Advanced Function Presentation data 

stream. 

ainbe The printer input/output backend 

program used by the PSF DSS to send 

jobs to printer devices. Depending on the 

incoming data stream of the job, the PSF 

DSS might have transformed the data 

stream of the job prior to the backend 

program sending it to the printer device. 

AIX Advanced Interactive Executive. 

AIX-attached printer 

A printer device, attached to an RS/6000 

through the network or through a serial 

or parallel port, that receives jobs from an 

AIX print queue. 

 In InfoPrint, a PSF physical printer that 

represents an AIX-attached printer device. 

See also channel-attached printer, 

direct-attached printer, TCP/IP-attached 

printer, upload-SNA-attached printer, 

upload-TCP/IP-attached printer. 

AIX destination support system 

In InfoPrint, the destination support 
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system that communicates with the 

standard AIX print backend (piobe), or 

with certain variations of the rembak 

print backend, to print jobs. 

AIX physical printer 

In InfoPrint, the object representing a 

printer device that uses the AIX 

destination support system. 

aliasing 

In a digitized image, the creation of 

diagonal lines by combining short 

horizontal and vertical line segments that 

approximate the path of the desired line. 

all-points-addressability (APA) 

The capability to address, reference, and 

position text, overlays, and images at any 

defined point of the printable area of the 

paper or display medium. 

alphameric 

Synonym for alphanumeric. 

alphanumeric 

Pertaining to a character set containing 

letters, digits, and other symbols such as 

punctuation marks. Synonymous with 

alphameric. 

AMPV 

Average monthly print volume. 

analog 

Pertaining to a continuous variable 

sampling of information between two 

points that achieves an even, smooth 

transition of photographic material. 

analog color proof 

An off-press color proof made from 

separation films. 

anti-aliasing 

The rendering of hard-edged objects so 

that they blend smoothly into the 

background. PhotoShop offers 

anti-aliasing when rasterizing an EPS file. 

 Removing the jagged “stairstep” quality 

in diagonal lines produced on a computer 

screen by aliasing. This removal is 

effected by creating less densely shaded 

fields parallel to the diagonal line. 

APA All-points-addressability. 

API Application Program Interface. 

Application Program Interface (API) 

The call interface between a client 

program and the procedures that 

implement the printing system, as defined 

by the specification. Clients use the API to 

access servers. (P) 

architecture 

The set of rules and conventions that 

govern the creation and control of data 

types such as text, image, graphics, font, 

fax, color, audio, bar code, and 

multimedia. 

archiving 

The transfer of digital information from 

an online system onto magnetic tape, 

floppy disk, compact disc, or other media 

for offline storage. The original copy is 

deleted from the online system. See also 

retrieval. 

array inkjet 

An ordered collection of multiple print 

heads used in an inkjet printer. 

ASCII American National Standard Code for 

Information Exchange. The standard code, 

using a coded character set consisting of 

7–bit coded characters (8 bits including a 

parity check). The ASCII code is used for 

information exchange among data 

processing systems, data communications 

systems, and associated equipment. The 

ASCII character set includes control 

charactes and graphic characters. 

asynchronous 

Pertaining to two or more processes that 

do not depend upon the occurrence of 

specific events, such as common timing 

signals. (T) 

 In InfoPrint, occurring without a regular 

or predictable time relationship to a 

specified action. Contrast with 

synchronous. 

attachment type 

Defines the method by which a printer 

device is attached to the AIX system from 

which it receives data. See AIX-attached 

printer, channel-attached printer, 

direct-attached printer, TCP/IP-attached 

printer, upload-SNA-attached printer, and 

upload-TCP/IP-attached printer. 

attribute 

A defined characteristic of an object, such 

as the number of copies required of a job, 

or the document formats accepted by an 

actual destination. 
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attribute name 

A string that identifies an attribute. 

Typically, in InfoPrint attribute names 

consist of two or more words separated 

by hyphens. 

attribute value 

The element of an attribute that specifies 

the characteristics relating to the attribute. 

authorization 

In computer security, verification of the 

eligibility of a user to access an object. 

authorized user 

A person with the appropriate 

permissions to access an object or to issue 

a command. 

automatic recovery 

A function of printer logic that permits 

the printer to reprint a job if the job is 

misprinted or damaged or if a component 

has failed. 

auxiliary sheet 

In InfoPrint, an object that represents a 

particular sheet of paper, blank or 

otherwise, that can precede a job, separate 

documents within a job, or follow a job. 

auxiliary-sheet selections 

A particular combination of start, 

separator, and end sheets that print with 

jobs on a particular printer device.

B 

backend 

In AIX, the program that is invoked by 

the qdaemon process to run a print or 

batch job. Synonymous with backend 

program. 

backend program 

Synonym for backend. 

backlog 

In InfoPrint, the amount of time 

calculated by InfoPrint that is required to 

print all of the jobs currently in a queue. 

backspace 

In InfoPrint, the action used to back up 

and reprint pages in a job. 

bar code 

A code representing characters by sets of 

parallel bars of varying thickness and 

separation that are read optically by 

transverse scanning. 

 

An array of parallel rectangular bars and 

spaces that together represent data 

elements or characters in a particular 

symbology. The bars and spaces are 

arranged in a predetermined pattern 

following unambiguous rules defined by 

the symbology. 

BCOCA™ 

Bar code object content architecture. 

Bezier curves 

A method of defining curves using anchor 

points, control handles, and tangent lines. 

The PostScript path passes through 

anchor points. Its approach direction is 

along the tangent lines that are controlled 

by the control handles. Many personal 

computer programs use this drawing 

method. Type 1 PostScript fonts are 

defined using Bezier curves. 

binding 

The cover and materials that hold a book 

together. See edition binding, perfect 

binding, spiral binding, wire-o binding. 

 The process of applying the binding to a 

book. 

 In InfoPrint, assigning a job to an actual 

destination. See early binding, late binding. 

 In DCE, pointers stored in a DCE cell that 

are used to connect clients to servers. 

bitmapped 

Pertaining to an image formed by a 

rectangular grid of pixels. Each pixel is 

assigned a value to denote its color. 

One-bit images are black and white; 8–bit 

images have 256 colors (or grays); 24–bit 

images have full color. CMYK images 

have 32–bits per pixel to encode 256 

levels in each of four channels. Bitmapped 

images are also called raster images. 

bleed An extra amount of printed image that 

extends beyond the trim edge of the 

sheet. Bleed ensures that no white gap 

appears at the edge of the sheet. 

boot To prepare a computer for operating by 

loading an operating system. 

BSD Berkeley Software Distribution. 

BSD destination support system 

In InfoPrint, the destination support 

system that generates a print command 

string that the shell runs to print jobs. 
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BSD physical printer 

In InfoPrint, the object representing a 

printer device that uses the BSD 

destination support system. 

burn In platemaking, an exposure. Burn is 

named because of the extremely bright 

ultraviolet lamps used to transfer images 

from film to plate. 

 In photography, to lengthen the final 

exposure time to increase the final density 

of print.

C 

cathode ray tube (CRT) 

A vacuum tube in which a beam of 

electrons can be moved to draw lines or 

form characters or symbols on its 

luminescent (phosphor-coated) screen. 

CRTs are the heart of all modern 

computer display screens. Black and 

white displays have only one phosphor 

scanned by one electron beam, while 

color displays have RGB phosphors 

scanned by three beams. 

CDE Common Desktop Environment. 

cell Synonym for DCE cell. 

Cell Directory Service 

A DCE component that manages a 

database of information about resources 

within a cell. 

child See parent/child relationship. 

choke In color printing, an area whose 

dimensions have been reduced to avoid 

overlapping another color. Contrast with 

spread. 

class Synonym for object class. 

clean In InfoPrint, an action used to remove all 

the jobs from specified servers, actual 

destinations, or queues, or to remove all 

the jobs submitted to specified logical 

destinations. 

CLI Command Line Interface. 

client In InfoPrint, the component of the print 

system that assembles a print request and 

submits the request to a server. The client 

generates the local ID numbers for each 

job, submits the jobs to the servers, and 

keeps track of where each user’s jobs 

have been submitted. 

CMY  Cyan, magenta, yellow. 

CMYK 

Cyan, magenta, yellow, black. 

collator 

In some printers a special-purpose hard 

drive disk array used to store RIPped files 

and later transfer them to the LED print 

heads for imaging. 

color balance 

The relative levels of cyan, magenta, and 

yellow channels in an image to produce 

accurate color rendition of an original 

image. 

color correction 

The adjustment of the color balance in an 

image to produce accurate color rendition 

of an original image. Color correction is 

used for two- or three-spot-color jobs. 

color key 

A color proof similar to Cromalin, but 

typically not laminated and not 

necessarily accurate in color. Color keys 

are used to verify that breaks or color 

assignments and traps have been made 

accurately. 

Command Line Interface (CLI) 

A type of user interface where commands 

are specified on the command line. 

Contrast with Graphical User Interface. 

Common Desktop Environment (CDE) 

A graphical user interface running on a 

UNIX operating system. 

complex attribute 

In InfoPrint, an attribute that can have 

multiple values with each value 

containing multiple components. 

constant data 

Data that does not change between copies 

of a document and that is merged with 

variable data to produce personalized 

documents. For example, a form letter 

(constant data) can be merged with a 

customer’s name and address (variable 

data). 

contextual help 

A type of online help that provides 

specific information about each selectable 

object, menu choice, notebook tab, field, 

control, and pushbutton in a window. 
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control strip 

A strip of information that can be 

attached to a print job and used to 

measure registration and density. 

Cromalin 

The Dupont color proofing system. Four 

layers (CMYK) of light-sensitive material 

are exposed through final halftone 

negative films, then laminated together on 

an opaque backing to produce a color- 

and trap-accurate final proof showing 

actual halftone dot structure. Cromalin is 

sometimes called an analog proof. 

crop To remove unwanted areas of an image, 

usually indicated by crop marks on the 

original. 

CRT Cathode ray tube. 

CTS Cutter-trimmer-stacker. 

cutter-trimmer-stacker (CTS) 

A post-processing device attached to a 

printer device and used for paper 

handling. 

cyan, magenta, yellow (CMY) 

The subtractive primary colors. 

cyan, magenta, yellow, black (CMYK) 

The four basic colors used in offset 

printing, as opposed to the three basic 

colors of light: red, green, and blue. 

Magenta, yellow, and cyan are the 

subtractive primaries. Black is added to 

provide better density and to produce a 

true black.

D 

daemon 

A program that runs unattended to 

perform a standard service. Some 

daemons are triggered automatically to 

perform their tasks; others operate 

periodically. Daemon processes generally 

provide a service that must be available at 

all times to more than one task or user, 

such as sending data to a printer. 

DAT Digital audio tape. 

data stream 

All information (data and control 

commands) sent over a data link. 

 A continuous stream of data that has a 

defined format. 

 

In InfoPrint, pertaining to the incoming 

format of the job and the output format 

required by the printer device. InfoPrint 

transforms the incoming format into the 

output format, as required. See also 

document format. 

DB2*/6000 

DataBase 2/6000. 

DCE Distributed Computing Environment. 

DCE authority 

The permission granted by DCE to access 

an object. 

DCE cell 

The basic unit of operation and 

administration in DCE. A group of DCE 

machines that work together and are 

administered as a unit. A cell represents a 

group of users, systems, and resources 

that typically have a common purpose 

and share common DCE services. 

DCE login ID 

The identifier of a person logging into 

DCE. DCE uses this ID to determine a 

user’s authenticity and authorization 

levels for accessing and modifying data in 

the DCE cell. 

DCE ticket 

The time-limited DCE authority granted 

whenever a user logs into DCE. When the 

DCE ticket expires, the user must log into 

DCE again in order to access objects 

protected by DCE. 

deadline 

In InfoPrint, a queuing technique where 

the next job assigned to the first position 

in the queue is the one whose deadline is 

closest. Contrast with FIFO 

(first-in-first-out), job-priority, 

longest-job-first, and shortest-job-first. 

default document 

In InfoPrint, an object that represents 

default attribute values for a document 

within a job. Synonymous with initial 

value document. 

default job 

In InfoPrint, an object that represents 

default attribute values for a job. 

Synonymous with initial value job. 

default object 

In InfoPrint, a general term that refers 
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either to a default document or a default job. 

Synonymous with initial value object. 

default value 

A value stored in the system that is used 

when no other value is specified. 

delete In InfoPrint, an action used to delete 

default objects, jobs, logical destinations, 

actual destinations, or queues from the 

server. 

desktop publishing 

Performing print-related activities on a 

personal computer, including but not 

limited to layout, design, photo 

manipulation, creating fonts, editing text, 

color separation, scanning, and animation. 

destination 

See actual destination, logical destination. 

destination support system (DSS) 

In InfoPrint, the programs that an actual 

destination uses to communicate with the 

output device. Synonymous with device 

support system. See AIX destination support 

system, BSD destination support system, 

email destination support system, Generalized 

Fax destination support system, and PSF 

destination support system. 

device An individual piece of equipment 

(hardware) that attaches to a computer, 

such as a printer device. 

device address 

The identification of an input or output 

device by its channel and unit number. 

device driver 

A file that communicates with a specific 

device such as a printer, disk drive, or 

display. An application that sends output 

to a device controls the actions of the 

device through the device driver. See 

printer driver. 

device support system (DSS) 

Synonym for destination support system. 

DFS™ Distributed File Service. 

digital Pertaining to data represented by digits, 

sometimes with special characters and the 

space character. 

digital audio tape (DAT) 

A high-capacity, low-cost bulk storage 

system used for archiving, copying (for 

backup purposes), and transferring large 

files. Typical DAT units store 1.3 GB on 

inexpensive cassette tapes. 

digital color proof 

An off-press color proof made from a 

color printer attached to a computer. 

digital printing 

A filmless and plateless printing process 

in which digital data for each page is 

transferred directly to a light-sensitive 

drum and then to paper for a final image. 

direct-attached printer 

A printer device, attached to an RS/6000 

through the network or through a serial 

or parallel port. 

 In InfoPrint, a PSF physical printer that 

represents a direct-attached printer device. 

See also AIX-attached printer, 

channel-attached printer, TCP/IP-attached 

printer, upload-SNA-attached printer, and 

upload-TCP/IP-attached printer. 

disable 

In InfoPrint, an action used to stop the 

acceptance of jobs on destinations, 

queues, or servers, or to stop writing 

information to logs. 

Distributed Computing Environment (DCE) 

A software system from the Open 

Software Foundation (OSF). DCE provides 

the services that allow a distributed 

application to interact with a collection of 

possibly heterogeneous computers, 

operating systems, and networks as if 

they were a single system. 

Distributed File System (DFS) 

A DCE component consisting of a single, 

integrated file system that is shared 

among all DCE users and host computers 

in a DCE cell. DFS allows users to access 

and share files stored in a network, 

without having to know the physical 

location of the files. It also prevents users 

from simultaneously modifying the same 

information. 

distributed print system 

A computer system with the ability to 

interchange print data and controls 

among different computing environments 

with the intent of printing the data on a 

different system from the one where the 

print request was generated. For example, 

in host-to-LAN distributed printing, data 
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that resides on the host is printed on 

printers attached to a local area network. 

dithering 

A technique of filling the gap between 

two pixels with another pixel having an 

average value of the two to minimize the 

difference or to add detail in order to 

smooth the result. 

document 

In InfoPrint, an object representing a 

grouping of data within a job. A job can 

contain one or more documents. The 

documents in a job can differ from each 

other in some ways. For example, they 

can contain different data and can have 

different document formats. A document 

within a job can contain printable data or 

a resource that is not printable by itself. 

See file-reference document, printable 

document, and resource document. 

document element 

A portion of a document at least a single 

page in size. 

document format 

In InfoPrint, a document format describes 

the type of the data and control characters 

in the document, such as line data or 

PostScript. The format of the data 

determines which printer devices are 

capable of printing the document and 

whether InfoPrint must transform the 

format. 

document identifier 

A string that identifies a document within 

a job. It consists of a job ID followed by a 

period (.) and a document sequence 

number. For example, 12.2. Document 

sequence numbers are integers starting at 

1. 

Document Printing Application (DPA) 

An ISO/IEC 10175 standard that 

addresses those aspects of document 

processing that enable users in a 

distributed open systems environment to 

send electronic documents to shared, 

possibly geographically-dispersed 

printers. InfoPrint supports the DPA 

standard. 

document transfer method 

In InfoPrint, the transfer method describes 

how documents are transferred to, or 

acquired by, servers. See pipe-pull and 

with-request. 

document type 

In InfoPrint, the document type describes 

the kind of data in the document. A 

printable document can only contain 

printable data. A resource document can 

only contain data such as fonts or form 

definitions that are not printable. A file 

reference document can only contain names 

of files entered on separate lines. 

dot The individual elements of a halftone. 

dot gain 

An increase in the size of a halftone dot 

during printing, caused by ink spreading. 

Generally, this value is known precisely, 

and the scanning and filming production 

process is calibrated to compensate for it. 

The Cromalin proofing system simulates 

this effect. 

dots per inch (dpi) 

A measure of data density per unit 

distance. Typical values for desktop 

publishing range from 200 to 300 dpi. 

DPA Document Printing Application. 

dpi Dots per inch. 

drag and drop 

In graphical user interfaces, a procedure 

by which you perform actions and tasks. 

Using the mouse, you drag (move) an 

action or object icon to a new position 

where you want the action or task to 

occur. 

DSS Destination support system. 

dummy 

A rough paste-up or hand-drawn 

representation of the anticipated finished 

product. A dummy is used for basic 

design and pagination. 

duplex printing 

Printing on both sides of the paper. 

Contrast with simplex printing (1). 

 Printing on both sides of the paper, 

placing output images on the media in a 

head-to-head format, so that the top of 

one image is at the same edge as the top 

of the next image. Contrast with tumble 

duplex printing; see also simplex printing 

(2).
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E 

early binding 

In InfoPrint, assigning a job to an actual 

destination as soon as it is accepted. Early 

binding permits InfoPrint to estimate the 

time when the job will be completed. 

Contrast with late binding. 

edition binding 

A type of book binding in which printed 

sheets are folded into 16- or 32-page 

signatures. Four-page endleaves are 

pasted on the outside of the first and last 

signature. The signatures are then collated 

by machine and sewn together using 

special sewing machines. Contrast with 

perfect binding, spiral binding, and wire-o 

binding. 

electronic document 

A document stored in a computer instead 

of printed on paper. 

electronic mail 

Correspondence in the form of messages 

transmitted between workstations over a 

network. Synonymous with email. 

electrophotographic 

Pertaining to a type of printer technology 

that creates an image on paper by 

uniformly charging the photoconductor, 

creating an electrostatic image on the 

photoconductor, attracting negatively 

charged toner to the discharged areas of 

the photoconductor, and transferring and 

fusing the toner to paper. 

em In composition, a unit of measurement 

exactly as wide and as high as the point 

size of the font being set. The name is 

derived from the fact that the letter M in 

early typefaces was usually cast on a 

square body. 

email Electronic mail. 

email destination 

In InfoPrint, an actual destination 

representing an electronic mailing system. 

email destination support system 

In InfoPrint, the destination support 

system that supports email destinations. 

embellishments 

Variable data added to all copies of 

assembled pages to make the unit appear 

like a whole; for example, headers, 

footers, a table of contents, and chapter 

separations. 

en In composition, exactly one-half an em. 

enable 

In InfoPrint, the action that makes a 

destination, queue, or server able to 

accept jobs, or a log able to accept 

information. 

end sheet 

The sheet of paper, blank or otherwise, 

that can follow a job. See also auxiliary 

sheet. 

Enhanced X-Windows 

A tool designed to permit multiple 

application processes to operate within 

multiple windows displayed on a virtual 

terminal. See X-Windows. 

environment variable 

Any one of a number of variables that 

describe the way an operating system 

runs and the devices it recognizes. 

error log 

A data set or file in a product or system 

where error information is stored for later 

access. 

estimate 

The professional cost analysis made by a 

print shop in response to a customer’s 

request for a price quotation on a print 

job. 

event In InfoPrint, an occurrence in the printing 

system during an operation; for example, 

the completion of a command. 

event log 

In InfoPrint, a collection of messages 

about events that have occurred. 

event notification 

The notification that is sent by InfoPrint 

for an event. 

extensions 

An IBM program-provided software 

component that enables users to 

incorporate variable data into fixed-text 

documents to produce personalized or 

customized documents.
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F 

fax destination 

In InfoPrint, an actual destination 

representing a fax device. 

FIFO (first-in-first-out) 

In InfoPrint, a queuing technique where 

the next job assigned to the first position 

in the queue is the job that has been in 

the queue for the longest time. InfoPrint 

processes jobs in the order in which they 

are received. Contrast with deadline, 

job-priority, longest-job-first, and 

shortest-job-first. 

file-reference document 

In InfoPrint, a file containing the names 

of other files, each entered on a separate 

line. Job submitters can specify this file 

for printing when they specify a 

document type of file-reference; InfoPrint 

prints each file listed in the reference 

document. 

File Transfer Protocol (FTP) 

In TCP/IP, the application protocol that 

makes it possible to transfer data to and 

from host computers and to use foreign 

hosts indirectly. 

finisher 

A hardware device attached to a printer 

that performs such operations as folding 

or stapling the printed pages. 

finishing 

In a print shop, the final operations on a 

printed product, such as stapling, 

trimming, drilling, folding, embossing, 

varnishing, gluing, shrink wrapping, 

perforating, laminating, collating, and so 

on. 

flag A modifier of a command that specifies 

the action of the command. A dash 

usually precedes a flag. Synonymous with 

option. See also keyword. 

FOCA Font object content architecture. 

folder In the InfoPrint GUI, an object that 

represents a container for a collection of 

similar objects. For example, the Retained 

Jobs folder contains retained jobs. 

font A family of characters of a given size and 

style; for example, 9-point Helvetica. 

 

One size and one typeface in a particular 

type family, including letters, numerals, 

punctuation marks, special characters, 

and ligatures. 

 A paired character set and code page that 

can be used together for printing a string 

of text characters. A double-byte font can 

consist of multiple pairs of character sets 

and code pages. 

form definition 

A resource object used by InfoPrint that 

defines the characteristics of the form or 

printed media, which include: overlays to 

be used, the paper source (for cut-sheet 

printers), duplex printing, text 

suppression, and the position of 

composed-text data on the form. 

forward space 

In InfoPrint, the action used to move 

ahead and skip the printing of a specified 

number of pages in a job. 

FPO Low-quality (sometimes photographic) 

images placed in a dummy to represent 

final images. Desktop publishing software 

produces images as display-screen 

resolution FPOs. 

front panel 

In the CDE, a workspace area containing 

controls that represent various tasks you 

can perform and workspace switches. 

FTP File Transfer Protocol.

G 

GCR Gray component replacement. 

Generalized Fax destination support system 

In InfoPrint, the destination support 

system that supports generalized fax 

destinations. 

GIF Graphics Interchange Format. 

global change 

In the InfoPrint GUI, an action used to 

make changes to one or more attributes of 

several objects at once. You can also 

perform the same action on several 

objects of the same object class at the 

same time; for example, disabling two or 

more actual destinations at the same time. 

global character 

A character or set of characters used to 

specify an unknown number or set of 
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characters in a search string. In InfoPrint, 

a global character is represented by an 

asterisk (*). 

global ID 

Global job identifier. 

global job identifier 

An unambiguous job identifier. In 

InfoPrint, it is represented as the name of 

the server managing the job followed by a 

colon (:) and a generated integer. This ID 

uniquely identifies the job within the 

InfoPrint server. 

glyph An image, usually of a character, in a 

font. 

GOCA 

Graphics object content architecture. 

graphic character 

A visual representation of a character, 

other than a control character, that is 

normally produced by writing, printing, 

or displaying. 

Graphical User Interface (GUI) 

A type of user interface that takes 

advantage of a high-resolution monitor 

and includes a combination of graphics to 

implement an object-action paradigm, the 

use of pointing devices, menu bars, 

overlapping windows, and icons. Contrast 

with Command Line Interface. 

Graphics Interchange Format (GIF) 

A compressed graphics format widely 

used on the Internet. 

gray component replacement (GCR) 

Synonym for under color removal (UCR). 

gray scale 

A strip of standard gray tones, ranging 

from white to black, placed at the side of 

the original copy during photography to 

measure the tonal range and contrast 

obtained. 

GUI Graphical User Interface. 

gutter The blank area or inner margin from the 

printing area to the binding.

H 

halftone 

A printing method that simulates 

continuous-tone shading using dots of 

varying sizes laid out on a rectangular 

grid. Larger dots simulate darker tones 

and smaller dots simulate lighter tones. 

Typical grid spacings are 85 lines per inch 

(lpi) (newspaper), 133 lpi (low end), 150 

lpi (midrange), and 175+ lpi (high 

quality). 

help In the InfoPrint GUI, an action used to 

display the online help for a specific 

template, object, action, button, control, or 

area in an application window. 

 The name of a button used to access the 

online help. 

hold An indication determined by the job-hold 

attribute that is used to keep a job in the 

queue and prevent InfoPrint from 

scheduling it. 

hostname 

The name given to an AIX system. 

hot folder 

A workstation directory where users copy 

jobs to submit them to print. 

hypertext 

A way of presenting information online 

with connections between one piece of 

information and another. These 

connections are called hypertext links. See 

also hypertext link. 

hypertext link 

A connection between one piece of 

information and another. Selecting a link 

displays the target piece of information.

I 

icon A graphic symbol displayed on a screen 

that a user can select to invoke a function 

or software application. 

image Toned and untoned pels arranged in a 

pattern. 

image data 

Rectangular arrays of raster information 

that define an image. 

imagesetter 

A high resolution (1270–3600+ dpi) 

printer that uses an Argon (green) laser to 

write to film using digital imput. 

Imagesetting is the step before Cromalin 

proofing and platemaking. 

imposition 

The process of arranging pages on a press 

sheet to ensure the correct order during 

final cutting, folding, and binding. 
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Electronic imposition builds press sheets 

automatically during the RIP and outputs 

film formatted for immediate use in 

platemaking. 

InfoPrint 

A solution of software and hardware 

products that can supplement or replace 

the offset presses and copiers in print 

shops with high-quality, non-impact, 

black and white or process color printers. 

InfoPrint takes documents from creation 

to the published, kitted, and shipped 

product. 

 In InfoPrint software publications, 

InfoPrint Manager for AIX or any of its 

components. 

InfoPrint Manager for AIX 

The software component of InfoPrint. 

InfoPrint Manager for AIX handles the 

scheduling, archiving, retrieving, and 

assembly of a print job and its related 

resource files. It also tracks the finishing 

and packaging of the printed product. 

 InfoPrint Manager for AIX is based on 

Palladium technology developed at 

MIT/Project Athena. It conforms to the 

ISO DPA and POSIX standards. 

InfoPrint Network 

The local area network running TCP/IP 

protocol that InfoPrint uses to 

communicate among servers, clients, and 

output devices. 

InfoPrint Select 

The component of InfoPrint Manager for 

AIX that allows users to submit jobs from 

an OS/2 or Windows workstation. 

InfoPrint Submit Express 

The component of InfoPrint Manager that 

allows users to submit jobs with a job 

ticket from a Windows or Macintosh 

workstation. 

InfoPrint 20 

A black and white, large-format, cut-sheet, 

workgroup laser printer with optional 

duplexing and 600-dpi resolution. 

InfoPrint 60 

A duplex, black and white, cut-sheet 

printer with 600-dpi resolution. 

InfoPrint 62 

A non-impact, continuous-forms printer 

that runs at a maximum of 62 

impressions-per-minute (depending on 

forms size), and is factory set to run at 

either 240 or 300 dpi on a maximum 

paper size of 370.8 mm (14.6 in.). 

InfoPrint 4000 

A duplex, black and white, 

continuous-forms printer with 600-dpi 

resolution. 

initial value document 

Synonym for default document. 

initial value job 

Synonym for default job. 

initial value object 

Synonym for default object. 

initially settable attribute 

An attribute whose value can be 

established when an object is created but 

cannot be subsequently set or modified. 

See also resettable attribute; contrast with 

non-settable attribute. 

input focus 

The area of a window where user 

interaction is possible from either the 

keyboard or the mouse. 

input tray 

For a printer device, the container that 

holds the medium upon which the printer 

prints its output. 

Intelligent Printer Data Stream (IPDS) 

An all-points-addressable data stream that 

enables users to position text, images, and 

graphics at any defined point on a 

printed page. 

 Information that the host sends to IPDS 

printers. This information generally 

contains basic formatting, error recovery, 

and character data and enables the 

printers to make decisions. 

 An architected host-to-printer data stream 

that contains both data (text, image, 

graphics, and bar codes) and controls 

defining how the data is to be presented. 

IPDS provides a device-independent 

interface for controlling and managing 

all-points-addressable (APA) printers. 

International Organization for Standardization 

(ISO) An organization of national standards 

bodies from various countries established 

to promote development standards to 

facilitate international exchange of goods 
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and services, and develop cooperation in 

intellectual, scientific, technological, and 

economic activity. 

Internet 

A wide area network connecting 

thousands of disparate networks in 

industry, education, government, and 

research. The Internet network uses 

TCP/IP as the protocol for transmitting 

information. 

Internet Protocol 

The set of rules that determines how to 

route data from its source to its 

destination in an internet environment. 

intervening jobs 

In InfoPrint, the number of jobs in a 

queue that are scheduled to print before 

the job in question. 

IOCA Image object content architecture. 

IP address 

The Internet Protocol address of the 

server in a dotted decimal format where 

each node is an integer. (For example, 

9.99.9.143). 

IPDS Intelligent Printer Data Stream. 

ISO International Organization for 

Standardization.

J 

job In InfoPrint, an object that represents a 

request to print or transmit one or more 

documents together in a single session. A 

job includes the data to be printed or 

transmitted and resources such as fonts, 

images, and overlays. Depending on how 

it was submitted, it can also include a job 

ticket. Synonymous with job bundle and 

print job. 

job bundle 

Synonym for job. 

job data 

The page descriptions, merge data, and 

embellishments that compose a document 

in a job, either directly or by reference. 

job ID 

A local or a global identifier that 

identifies a job to a job submitter, 

administrator, operator, or InfoPrint. See 

local job identifier, global job identifier. 

job-priority 

In InfoPrint, a queuing technique where 

the next job assigned to the first position 

in the queue is the one with the highest 

priority. Contrast with deadline, FIFO 

(first-in-first-out), longest-job-first, and 

shortest-job-first. 

job submitter 

In InfoPrint, the person who submits jobs 

for printing. Often, this person is an 

application programmer who maintains 

applications that generate data to be 

printed. 

job ticket 

The customer’s hardcopy or electronic 

instructions listing all the variables 

describing a print job, either directly or 

by reference. The print shop can add 

specifications to the job ticket and can 

print the job ticket. 

Joint Photographic Experts Group (JPEG) 

A compressed graphics format widely 

used on the Internet. 

JPEG Joint Photographic Experts Group.

K 

kerning 

In typesetting, adjusting the relative 

spacing of two characters to improve their 

appearance and readability. Kerning pairs 

are specific sets of characters with built-in 

relative spacing. Some typefaces have as 

many as 100 kerning pairs. 

keyword 

A name or symbol that identifies a 

parameter. 

 Part of a command operand that consists 

of a specific character string, such as 

DSNAME=. 

kitting 

In a print shop, packaging the completed 

published work with attendant binders, 

tabs, diskettes, and other equipment or 

information, before shipping the finished 

product.

L 

LAN Local Area Network. 

laser (light amplification by stimulated emission 

of radiation) 

In InfoPrint printers, a device that emits a 
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beam of coherent light that forms the 

image on the photoconductor that is 

subsequently transferred to the paper. 

late binding 

In InfoPrint, waiting to assign a job to an 

actual destination until it is about to be 

processed. Late binding permits InfoPrint 

to route a job to the first suitable actual 

destination that becomes available. 

Contrast with early binding. 

LED Light-emitting diode. 

light-emitting diode (LED) 

The imaging device element for 

electrophotographic print units. 

lines per inch (lpi) 

A measure of the density of the grid used 

to space halftone dots. Typical grid 

spacings are 85 lpi (newspaper), 133 lpi 

(low end), 150 lpi (midrange), and 175+ 

lpi (high quality). 

Local Area Network (LAN) 

A computer network at one location that 

consisting of devices connected to one 

another and communicating. This 

network can also be connected to a larger 

network. 

local ID 

Local job identifier. 

local job identifier 

In InfoPrint, a job identifier automatically 

generated by the server, identifying the 

job to the person who submitted it. 

InfoPrint maps a local job ID to a global 

job ID. 

locale The human language and character set of 

information presented to a user. 

 In InfoPrint, the language InfoPrint uses 

when sending notification and error 

messages or displaying the InfoPrint 

graphical user interfaces. 

log A collection of messages or message 

segments added to a file for accounting or 

data collection purposes. 

 To record messages in a file. 

logical destination 

In InfoPrint, an object to which users 

submit their jobs. The logical destination 

routes jobs to one or more actual 

destinations representing output devices 

such as printers, electronic mail systems, 

or fax machines. See also logical printer; 

contrast with actual destination. 

logical printer 

In InfoPrint, a type of logical destination. 

The logical printer routes jobs to one or 

more physical printers representing 

printing devices. 

logical unit (LU) 

A type of network accessible unit that 

enables end users to gain access to 

network resources and communicate with 

each other. 

logical unit (LU) 6.2 

A type of logical unit that supports 

general communication between 

programs in a distributed processing 

environment. LU 6.2 is characterized by 

(a) a peer relationship between session 

partners, (b) efficient utilization of a 

session for multiple transactions, (c) 

comprehensive end-to-end error 

processing, and (d) a generic application 

program interface (API) consisting of 

structured verbs that are mapped into a 

product implementation. 

longest-job-first 

In InfoPrint, a queuing technique where 

the next job assigned to the first position 

in the queue is the longest job in the 

queue. Contrast with deadline, FIFO 

(first-in-first-out), job-priority, and 

shortest-job-first. 

lpi Lines per inch. 

LU Logical unit.

M 

magnetic ink character recognition (MICR) 

Identification of characters printed with 

ink that contains particles of magnetic 

material. 

mainframe processor 

A functional unit that interprets and 

executes instructions in a large computer 

to which other computers are connected 

so that they can share the facilities the 

mainframe provides. 

makeready 

All the setup work involved in preparing 

a press for a print run. 

manage 

In the InfoPrint GUI, the action used to 
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put an object into a mode where its icon 

reflects changes of status. 

mechanical 

A camera-ready layout. The mechanical 

can consist of multiple sheets or overlays 

for each spot or process color used. Final 

images, if not stripped in later, should be 

at final size, cropped and screened to the 

correct line frequency. 

medium 

In InfoPrint, an object representing the 

physical material upon which a job is 

printed. 

merge data 

Data that is unique to each copy of a 

document and that customizes the 

document; for example, serial numbers or 

mailing information. Merge  data is 

typically a small percentage of the total 

data in the document. 

message catalog 

A file of all the possible messages than 

can display during the processing of an 

application. 

MICR Magnetic ink character recognition. 

Mixed Object Document Content Architecture 

(MO:DCA) 

An architected, device-independent data 

stream for interchanging documents. 

MO:DCA-P 

Mixed Object Document Content 

Architecture Presentation. 

modify 

In InfoPrint, an action used to modify the 

values of attributes within the object 

attributes notebook. 

moire Undesirable interference patterns caused 

by two overprinting halftone screens with 

incorrect halftone dot angles. 

monospaced 

In typesetting, pertaining to a typeface in 

which all the characters have equal 

widths. Monospaced typefaces are useful 

for tabulating figures. 

Multiple Virtual Storage (MVS) 

An operating system developed by IBM. 

The design of MVS incorporates an 

addressing architecture that provides a 

unique address space to each job in the 

system. 

MVS  Multiple Virtual Storage.

N 

N_UP Pertaining to the number of forms placed 

together in a layout. Typical layouts are 

2_UP, 4_UP, 8_UP, 16_UP, and so on. 

N_UP printing is done to use the 

maximum area of the print sheet. 

name service 

The DCE service that administers the 

namespace and provides the network 

binding information that a client requires 

to access the server. 

namespace 

A global name repository available to all 

utilities and API procedures. The 

namespace contains mappings of object 

names to other related objects. For 

example, the namespace provides the 

mapping of a logical destination to the 

server in which it resides. 

Network File System (NFS) 

A protocol developed by Sun 

Microsystems that uses Internet Protocol 

to allow a set of cooperating computers to 

access each other’s file systems as if they 

were local. 

newline options 

The different ways in which the printer 

determines how lines are delimited in a 

document data stream. 

NFS Network File System. 

non-process-runout (NPRO) 

A printer function that moves the last 

printed sheet to the stacker of the printer 

device. 

non-settable attribute 

An attribute that is neither initially 

settable nor resettable. The values for 

these attributes are controlled by 

InfoPrint. Contrast with initially settable 

attribute and resettable attribute. 

notification 

The act of reporting the occurrence of 

events. 

 In InfoPrint, notification of events appears 

as messages in event logs or messages 

sent to administrators, operators, and job 

submitters. In the InfoPrint GUI, 

notification of events also appears as 

changes to the appearance of icons. 
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notification-profile 

In InfoPrint, an attribute associated with 

an object that contains information 

designating the people to whom InfoPrint 

sends notification about events for that 

object, which event information it sends, 

and how it sends the information. 

NPRO Non-process-runout.

O 

object A collection of attributes that represent a 

physical or logical entity in the print 

system. For example, a specific printer 

device is represented by an actual 

destination (physical printer) object. An 

object is identified by its object name. 

Objects are grouped into classes. See also 

object class. 

object class 

A group of objects that share a common 

definition and therefore share common 

properties, operations, and behavior as 

defined by their attributes. For example, 

all InfoPrint queue objects are in the same 

object class and each queue has the same 

set of queue attributes. However, the 

values for those attributes can differ for 

each queue within the queue object class. 

Object Identifier (OID) 

In architecture, a notation that assigns a 

globally unambiguous identifier to an 

object or a document component. The 

notation is defined in international 

standard ISO.IEC 8824(E). 

object name 

The alphanumeric term that identifies an 

object. 

object state 

The state of an object indicates its 

availability and readiness for performing 

its functions. An object can be in one of a 

number of states such as ready, busy, or 

unknown. 

OCR Optical character recognition. 

octet A byte that consists of eight binary digits 

(bits). 

offset stacking 

In certain printer devices, a function that 

allows the printer to offset the printed 

output pages for easy separation of the 

jobs. 

OID Object Identifier. 

open destinations window 

In the InfoPrint GUI, the action used to 

open a new application window 

displaying the logical and actual 

destinations associated with a queue. 

Open Prepress Interface (OPI) 

An industry standard for replacing 

low-resolution images in review 

documents with high-resolution images 

needed for high-quality final output. 

Open Software Foundation (OSF) 

A nonprofit research and development 

organization created by a consortium of 

companies that work together to develop 

software in the open systems market. OSF 

developed the Distributed Computing 

Environment (DCE). 

OpenType font (OTF) 

An extension of the TrueType font format 

that adds: 

v   Support for PostScript outlines 

v   Better support for international 

character sets 

v   Broader support for advanced 

typographic control

open window 

In the InfoPrint GUI, the action used to 

open a new application window 

representing one or more objects 

displayed in the currently open 

application window. 

operation 

An action performed on one or more data 

items. 

operator 

In InfoPrint, the person responsible for 

printer devices. Also, this person 

performs a subset of tasks for InfoPrint 

queues and actual destinations and 

performs some job-related tasks. 

OPI Open Prepress Interface. 

optical character recognition (OCR) 

Conversion of scanned text to editable 

ASCII characters. 

option A modifier of a command that specifies 

the action of the command. A dash 

usually precedes an option. Synonymous 

with flag. See also keyword. 
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orphan logical destination 

In the InfoPrint GUI, an object that 

represents a logical destination that is not 

associated with an existing queue. 

orphan logical printer 

In the InfoPrint GUI, an object that 

represents a logical printer that is not 

associated with an existing queue. 

OSF Open Software Foundation. 

overlay 

A collection of constant data, such as 

lines, shading, text, boxes, or logos, that is 

electronically composed in the host 

processor and stored in a library, and that 

can be merged with variable data during 

printing. 

OTF OpenType font.

P 

PAC Privilege Attribute Certificate. 

page definition 

A resource that contains the formatting 

controls for line data. 

 In InfoPrint, a resource that defines the 

rules of transforming line data into 

composed pages and text controls. 

page segment 

A resource that contains composed text 

and images, which are prepared before 

formatting and included during printing. 

Palladium 

A distributed print system developed at 

MIT/Project Athena with participation 

from Digital Equipment Corporation 

(DEC), International Business Machines 

(IBM), and Hewlett-Packard (HP). It is a 

reference implementation for the OSI 

Document Printing Architecture (DPA) 

standard, ISO/IEC 10175. Palladium was 

selected in 1990 as the DCE distributed 

printing technology. InfoPrint was 

designed using Palladium concepts. 

pane In the Work Area of the InfoPrint 

Manager Administration GUI, an area 

containing a group of objects of a specific 

type, such as an actual destinations pane. 

parent/child relationship 

In InfoPrint, servers, queues, and 

destinations are related to one another in 

a parent/child relationship. For example, 

a server is the parent of all the queues 

that reside in that server, and these 

queues are its children. 

pass through 

In InfoPrint, referring to options 

submitted with a job that are used by the 

device driver, but not InfoPrint. InfoPrint 

does not process or validate this 

information; it passes it along to the 

device driver. See printer driver. 

path The route used to locate files; the storage 

location of a file. A fully qualified path 

lists the drive identifier (if any), directory 

name, subdirectory name (if any), and file 

name with the associated extension. 

pause In InfoPrint, the action used to 

temporarily halt the printing or 

transmission of jobs on actual destinations 

or the distribution of jobs from servers or 

queues. 

pdcrcds 

In InfoPrint, a utility used to create 

directories within the DCE namespace. 

pdcreate 

In InfoPrint, the command used to create 

a new object and set its attributes to 

specified values. 

PDF Portable Document Format. 

 Printer description file. 

pdmsg 

In InfoPrint, a utility used to display 

information about a message. 

pdpr In InfoPrint, the command used to create 

and submit a job, consisting of one or 

more documents, to a server for printing 

or transmission. 

perfect binding 

A type of book binding in which the 

pages are held together with flexible 

adhesive. Contrast with edition binding, 

spiral binding, and wire-o binding. 

permissions 

In AIX, codes that determine who can 

access a file and what operations they can 

perform on the file. 

physical printer 

In InfoPrint, a type of actual destination 

that represents a printer device. See also 

printer device. 

 

Glossary 191



piobe The standard printer input/output 

backend program used by AIX for 

printing. See also ainbe. 

pipe-pull 

In InfoPrint, a document transfer method 

where InfoPrint saves the documents in a 

file and transfers the address of the file to 

the server. InfoPrint transfers the file to 

the server upon the request from the 

server. This is an efficient transfer method 

for large jobs and is the default transfer 

method at job submission. Contrast with 

with-request. 

plex A document or actual destination 

attribute used to define the placement of 

output images on the page. See the plex 

values simplex and tumble. 

plug-ins 

A component of Adobe PageMaker that 

enables users to incorporate variable data 

into fixed-text documents to produce 

personalized or customized documents. 

Portable Document Format (PDF) 

An Adobe PostScript data format that can 

be viewed or printed. 

Portable Operating System Interface for 

Computer Environments (POSIX) 

An Institute of Electrical and Electronics 

Engineers (IEEE) standard for computer 

operating systems. 

POSIX 

Portable Operating System Interface for 

Computer Environments. 

PostScript 

Adobe’s page description language. 

PostScript has become a standard for 

graphic design and layout software. 

PostScript files can contain both vector 

and raster data. Fonts are described using 

PostScript coding. Many desktop 

publishing systems produce PostScript 

data as their output data stream. 

PostScript printer description (PPD) 

A file that contains options for printing 

PostScript data on various printer devices. 

PPD PostScript printer description. 

preflight 

To assess all resources for a job before the 

actual print run. 

prepress 

Work done in the print shop before 

printing a job, such as preparing data and 

art, page imposition, color retouching, 

electronic editing, and page layout. 

print database 

The set of files on disk that provide a 

permanent repository for the attributes of 

all print objects, such as logical 

destinations, queues, and actual 

destinations. 

print job 

Synonym for job. 

Print Quality Enhancement (PQE) 

A printer facility that provides edge 

smoothing along diagonal lines, fine 

fidelity protection, and independent 

boldness control. 

Print Services Facility (PSF) 

Any of several programs, including PSF 

for AIX, PSF/MVS, PSF/VM, and 

PSF/VSE, that produce printer commands 

from the data sent to them. 

print system 

A group of one or more print servers and 

one or more printing devices, which 

might or might not be located in the same 

geographical area. The components of a 

print system are assumed to be 

interconnected in some manner, providing 

at least one network interface to print 

clients, and acting synergistically to 

supply the defined document print 

service. (D) 

printable document 

In InfoPrint, an object that represents text 

or data to be printed by a job. Contrast 

with resource document. 

printer description file (PDF) 

A file that contains options for printing 

PostScript data on a specific printer 

device. 

printer device 

The physical output device that performs 

the printing function. See also physical 

printer. 

printer driver 

A file that describes the physical 

characteristics of a printer or other 

peripheral device. This file is used to 

convert graphics and text into 
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device-specific data at the time of printing 

or plotting. Synonymous with device 

driver. 

priority 

In InfoPrint, a number assigned to a job 

that determines its precedence in being 

printed. Jobs with higher priority 

numbers are handled before jobs with 

lower priority numbers. 

Privilege Attribute Certificate (PAC) 

In DCE, a certified set of access privileges 

that can be presented by a user or 

administrator to establish access rights to 

objects. 

process color 

Color made up of CMYK links simulating 

a specified color. This is the traditional 

method of reproducing continuous tone 

color images (color separations). Because 

of the nature of color inks, certain inks do 

not reproduce well. 

processor 

In a computer, a functional unit that 

interprets and executes instructions. A 

processor consists of at least an 

instruction control unit and an arithmetic 

and logic unit. (T) 

promote 

In InfoPrint, the action used to move a job 

to the beginning of the queue so that it 

will print on the next available printer 

that can handle that job. 

protocol 

A set of semantic and syntactic rules that 

determines the behavior of functional 

units in achieving communication. 

PSF Print Services Facility. 

PSF destination support system 

In InfoPrint, the destination support 

system that communicates with PSF for 

AIX to print jobs. 

PSF physical printer 

In InfoPrint, the object representing a 

printer device that uses the PSF 

destination support system.

Q 

QuarkXpress 

A desktop publishing system produced by 

Quark, Incorporated. 

queue In InfoPrint, an object that manages a 

collection of jobs that are waiting to print. 

A queue receives jobs from one or more 

logical destinations and sends jobs to one 

or more actual destinations. 

 A line or list formed by items waiting for 

processing.

R 

raster A pattern of dots defined at varying data 

depths. Black and white images are 

one-bit (on/off); grayscale images are 

8-bit (256 levels); RGB images are 24-bit; 

CMYK images are 32-bit. 

raster image processor (RIP) 

A processor in which a PostScript data 

stream is converted into dot patterns that 

are transferred to the final print medium. 

InfoPrint uses an Adobe RIP to convert 

PostScript to IPDS for such printers as the 

InfoPrint 4000 and InfoPrint 60. 

rc.pd In InfoPrint, a utility used to start the 

InfoPrint servers listed in the 

/etc/pd.servers file. 

read-only 

In InfoPrint, describes an attribute value 

that cannot be set by the user but can 

change based on other activity. 

ready A state in which an object is ready and 

able to perform tasks. 

 An available resource, such as a value of 

the media-ready attribute. Contrast with 

supported. 

red, green, blue (RGB) 

The colors of CRT display phosphors. 

RGB images are for screen display only. 

They must be converted to CMYK images 

before printing. 

registration 

The accuracy of printing on paper relative 

to the edges of the paper. 

 The accuracy of printing a single color 

(cyan, magenta, or yellow) relative to 

black. 

 The accuracy of printing on one side of a 

page relative to printing on the reverse 

side of the page. 

Remote Procedure Call (RPC) 

A DCE component that manages 

communication between clients and 
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servers in a DCE environment. It allows 

requests from a client program to access a 

procedure anywhere in the network. 

reprographics 

The process of copying or duplicating 

documents or information. 

requested 

In InfoPrint, pertaining to the specific 

values of attributes requested by a job 

when it is submitted. The requested 

attribute values of a job are validated 

against supported attribute values for an 

actual destination to determine if the 

printer can handle that job. Contrast with 

supported. 

resettable attribute 

An attribute whose value can be set or 

modified after an object has been created, 

assuming the object is in an appropriate 

state to be modified. See also initially 

settable attribute; contrast with non-settable 

attribute. 

resource 

In AFP, a file containing a collection of 

printing instructions used when printing 

a job. Resources include fonts, overlays, 

form definitions, page definitions, and 

page segments. 

resource context 

In InfoPrint, an object that contains 

directory path information that helps the 

print system locate resources needed for 

printing a job. The resources include 

fonts, overlays, form definitions, page 

definitions, and page segments. 

resource document 

In InfoPrint, an object that represents a 

resource, such as graphics or fonts, used 

by a job to print a printable document. 

Contrast with printable document. 

resubmit 

In InfoPrint, an action used to reroute 

pending or retained jobs to a different 

logical destination than the one through 

which the job was originally submitted. 

resume 

In InfoPrint, the action used to resume the 

printing of paused jobs or resume the 

distribution of jobs from paused servers 

or queues. 

retained job 

In InfoPrint, an object that represents a 

job that is being stored in the print 

system for a specified amount of time, 

normally after the completion of printing 

the job. A retained job does not reside in a 

queue. 

retention 

The process of storing data after 

completion of a process for a certain 

length of time. 

retrieval 

The process of bringing digital archived 

data out of storage and into online 

memory for reuse. See also archiving. 

RGB Red, green, blue. 

RIP Raster image processor. 

 To convert data to dot patterns using a 

raster image processor. 

root user 

In the AIX environment, the system user 

with the most authority who can log in 

and execute restricted commands, shut 

down the system, and edit or delete 

protected files. Synonymous with 

superuser. 

RPC Remote Procedure Call. 

RS/6000 

A family of workstations and servers 

based on IBM’s POWER™ architecture. 

They are primarily designed for running 

multi-user numerical computing 

applications that use the AIX operating 

system.

S 

scanner 

A device that converts hardcopy source 

data into digital format (halftone dots) to 

avoid retyping the data. 

scheduler 

In InfoPrint, the scheduling method that 

the queue uses when assigning a job to an 

actual destination. 

separator sheet 

The sheet of paper, blank or otherwise, 

that separates documents within a job. 

See also auxiliary sheet. 

server In InfoPrint, the object that accepts 

configuration, management, and printing 
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requests, performs the requested 

operations, and sends responses back as a 

result of the operation. 

settable attribute 

See initially settable attribute, resettable 

attribute. 

severity 

An indication of how serious an error 

condition is. 

shell In the AIX operating system, a command 

interpreter that acts as an interface 

between the user and the operating 

system. In InfoPrint documentation, all 

shell examples use the Korn shell. 

shift-out, shift-in code 

Control characters used to indicate the 

beginning and end of a string of 

double-byte, ideographic characters. 

shortest-job-first 

In InfoPrint, a queuing technique where 

the next job assigned to the first position 

in the queue is the shortest job in the 

queue. Contrast with deadline, FIFO 

(first-in-first-out), job-priority, and 

longest-job-first. 

shut down 

In InfoPrint, the action used to halt all 

server or actual destination processes 

without deleting the server or actual 

destination. 

signature 

A group of pages that are printed, folded, 

cut, and bound together. Manual 

placement of pages in the signature is 

determined using a folding dummy. 

simplex 

In InfoPrint, the value of the document or 

actual destination plex attribute indicating 

that output images are placed on the 

media in a head-to-head format, so that 

the top of one image is at the same edge 

as the top of the next image. Depending 

on the value of the document or actual 

destination sides attribute, the document 

can be printed on one or both sides of the 

paper. Contrast with tumble; see also 

simplex printing and duplex printing. 

simplex printing 

Printing on only one side of the paper. 

Contrast with duplex printing (1).  

 

Printing on one or both sides of the 

paper, placing output images on the 

media in a head-to-head format, so that 

the top of one image is at the same edge 

as the top of the next image. Contrast 

with tumble duplex printing; see also duplex 

printing (2). 

SMIT System Management Interface Tool. 

SNA Systems Network Architecture. 

spiral binding 

A type of book binding in which wire or 

plastic coils are threaded through a series 

of holes or slots in the binding edge. 

Contrast with edition binding, perfect 

binding, and wire-o binding. 

spot color 

Individual colored inks formulated to 

exactly match a specified color. Spot color 

is used when CMYK process color is 

unable to produce a reasonable facsimile 

of the color or when vivid color is 

needed. Spot color is also used when 

fluorescent or metallic colors are needed. 

spread 

In color printing, an area whose 

dimensions have been enlarged to 

eliminate white space between it and 

another color. Contrast with choke. 

start sheet 

The sheet of paper, blank or otherwise, 

that can precede a job. See also auxiliary 

sheet. 

state Synonym for object state. 

stripping 

The process of mechanically assembling 

film into plate layouts. Page imposition 

takes place during stripping. 

subnet mask 

A bit template indicating which part of an 

IP address represents the network. A 1 in 

the subnet mask means that the 

corresponding bit in the IP address is part 

of the network address; a 0 means that it 

is not. For example, if the IP address is 

9.99.12.137 and the subnet mask is 

255.255.255.0, the network address is 

9.99.12.0. 

subnetwork 

Any group of nodes that have a set of 

common characteristics, such as the same 

network ID. 
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In the AIX operating system, one of a 

group of multiple logical divisions of 

another network, such as can be created 

by TCP/IP. 

subtractive color system 

A system that reproduces an image by 

mixing (adding) appropriate quantities of 

cyan, magenta, and yellow paints on 

white paper. These paints reflect certain 

colors and absorb—or subtract—others. 

Contrast with additive color system. 

superuser 

Synonym for root user. 

supported 

In InfoPrint, pertaining to the specific job 

attribute values that the actual destination 

can accept during job validation. InfoPrint 

validates the requested attribute values of 

the job against the supported attribute 

values of the actual destination to 

determine whether the actual destination 

can handle that job. Contrast with 

requested. 

synchronous 

Occurring with a regular or predictable 

time relationship to a specified action. 

Contrast with asynchronous. 

system administrator 

Synonym for administrator. 

System Management Interface Tool (SMIT) 

In the AIX operating system, an interface 

tool for installation, maintenance, 

configuration, and diagnostic tasks. SMIT 

allows you to perform tasks without 

entering any commands. 

Systems Network Architecture (SNA) 

The description of IBM’s logical structure, 

formats, protocols, and operational 

sequences for transmitting units through, 

and controlling the configuration and 

operation of, networks.

T 

table reference character (TRC) 

An optional control character in a print 

data set. The TRC identifies the font used 

to print the record and can be used to 

select a font during printing. 

Tagged Image File Format (TIFF) 

A digital format for storing scanned 

images. TIFF files are also referred to as 

raster format files (as opposed to vector 

format files). When used in desktop 

publishing, TIFF files produce only a 

low-resolution FPO image; the 

high-resolution data remains on the hard 

disk. 

task help 

A type of online help that provides a list 

of tasks that can be completed with a 

selected object. When you select a task, 

the help provides step-by-step 

information about how to complete the 

task. 

TCP/IP 

Transmission Control Protocol/Internet 

Protocol. 

TCP/IP-attached printer 

A printer device attached to an RS/6000 

through telecommunication lines using 

the TCP/IP protocol. 

 In InfoPrint, a PSF physical printer that 

represents a TCP/IP-attached printer 

device. See also AIX-attached printer, 

channel-attached printer, direct-attached 

printer, upload-SNA-attached printer, 

upload-TCP/IP-attached printer. 

template 

In the InfoPrint Manager Administration 

GUI, an object that represents a set of 

default attribute values that has been 

defined for creating a particular type of 

object, such as an actual destination. 

ticket See job ticket and DCE ticket. 

TIFF Tagged Image File Format. 

Transmission Control Protocol/Internet Protocol 

(TCP/IP) 

A set of communication rules used in the 

Internet and in any network that follows 

the U.S. Department of Defense standards 

for inter-network protocol. TCP provides 

a reliable host-to-host protocol between 

hosts in packet-switched communications 

networks and in interconnected systems 

of such networks. It assumes that the 

Internet Protocol (IP) is the underlying 

protocol. See also Internet Protocol. 

trapping 

In desktop publishing, the amount of 

overlap in overprinting colors. Trapping 

prevents white paper showing through 

gaps caused by normal errors in 
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registration. On sheet-fed presses, 

trapping is usually 0.25 point. See also 

choke and spread. 

TRC Table Reference Character. 

TrueType font (TTF) 

A font format based on scalable outline 

technology with flexible hinting. Glyph 

shapes are based on quadratic curves. The 

font is described with a set of tables 

contained in a TrueType Font File. 

TTF TrueType font. 

tumble 

In InfoPrint, the value of the document or 

actual destination plex attribute indicating 

that output images are placed on the 

media in a head-to-toe format, so that the 

top of one image is at the same edge as 

the bottom of the next image. The 

document must be printed on both sides 

of the paper. Contrast with simplex. 

tumble duplex printing 

Printing on both sides of the paper, 

placing output images on the media in a 

head-to-toe format, so that the top of one 

image is at the same edge as the bottom 

of the next image. Contrast with simplex 

printing (2),  duplex printing (2).

U 

UCR Under color removal. 

under color removal (UCR) 

Conversion of neutral color areas to black 

ink that reduces use of CMY inks, 

improves trapping, and reduces setup 

time. Generally, UCR is performed during 

image scanning, but some RIPs perform it 

during processing. Synonymous with gray 

component replacement (GCR). 

unmanage 

In the InfoPrint Manager Administration 

GUI, the action used to put an object into 

a mode where its icon does not reflect the 

changes of status for the object. 

upload printer 

See upload-SNA-attached printer, 

upload-TCP/IP-attached printer. 

upload-SNA-attached printer 

In InfoPrint, a PSF physical printer that 

represents a printer device attached 

through an MVS system and managed by 

PSF/MVS. InfoPrint communicates with 

the MVS  system through the SNA 

network. See also AIX-attached printer, 

channel-attached printer, direct-attached 

printer, TCP/IP-attached printer, 

upload-TCP/IP-attached printer. 

upload-TCP/IP-attached printer 

In InfoPrint, a PSF physical printer that 

represents a printer device attached 

through an MVS  system and managed by 

PSF/MVS. InfoPrint communicates with 

the MVS  system through the TCP/IP 

network. See also AIX-attached printer, 

channel-attached printer, direct-attached 

printer, TCP/IP-attached printer, and 

upload-SNA-attached printer.

V 

validate 

In InfoPrint, to compare the attribute 

values requested by a job with the 

supported attribute values of the actual 

destinations in the system and to 

determine whether there is an actual 

destination capable of printing or 

transmitting the job. 

value A specific characteristic of an attribute. 

variable 

A name used to represent a data item 

whose value can change while the 

program is running. 

variable data 

Data that can be changed between copies 

of a document. For example, a form letter 

(constant data) can be merged with 

variable data, such as a customer’s name 

and address to produce personalized 

documents. 

varnish 

A protective layer applied to a finished 

sheet, usually for photos, but sometimes 

used as a design element because of its 

reflective qualities. Varnishes can be 

tinted. 

vector An absolute coordinate point and line in 

space. PostScript files can contain vector 

artwork. Vector files are converted to 

rasters during the RIP process. 

velox A black and white photographic print 

made from a halftone negative, to be used 

as a proof copy. 
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vignette 

An image with soft, fade-away edges. 

Virtual Machine (VM) 

An IBM licensed product that manages 

the resources of a single computer so that 

multiple computing systems appear to 

exist. 

 A virtual data processing system that 

appears to be at the exclusive disposal of 

a particular user, but whose functions are 

accomplished by sharing the resources of 

a real data processing system. (T) 

Virtual Storage Extended (VSE) 

An IBM licensed program whose full 

name is the Virtual Storage 

Extended/Advanced Function. It is a 

software operating system controlling the 

execution of programs. 

Visual Systems Management (VSM) 

In AIX, a type of graphical user interface 

that allows system management through 

the direct manipulation of objects. 

VM Virtual Machine. 

VSE Virtual Storage Extended. 

VSM Visual Systems Management.

W 

web A roll of paper used in web or rotary 

printing. 

well In the InfoPrint Manager Administration 

GUI, an area within a pane that contains 

a group of objects related to the objects in 

the pane; for example, a queues well 

within a servers pane. 

what you see is what you get (WYSIWYG) 

Refers to the fact that the composite 

image displayed on the screen at a 

computer workstation has the appearance 

of the final printed image. 

window 

A rectangular area of the screen that you 

can move about, place on top of, or pull 

under other windows, or reduce to an 

icon. 

wire-o binding 

A continuous double series of wire loops 

run through punched slots along the 

binding side of a booklet. Contrast with 

edition binding, perfect binding, and spiral 

binding. 

with-request 

In InfoPrint, a document transfer method 

where the client transfers the documents 

directly to the server. Contrast with 

pipe-pull. 

workstation 

A terminal or microcomputer, usually one 

that is connected to a mainframe or to a 

network, at which a user can use 

applications. 

write access 

A level of authorization that grants the 

ability to modify data. 

WYSIWYG 

What you see is what you get.

X 

X-Windows 

A network-transparent windowing system 

developed by MIT.  It is the basis for 

Enhanced X-Windows, which runs on the 

AIX Operating System. 

xerography 

A dry printing process using 

corona-charged photoconductive surfaces 

to hold latent images that are developed 

with a dry toner and then transferred to 

paper and fused with heat. 

Xstation 

A terminal that is connected through a 

network to an RS/6000 system, from 

which a user can perform command-line 

functions and run X-Windows based 

applications. 

Xtensions 

A UNIX-provided software component 

that enables users to incorporate variable 

data into fixed-text documents to produce 

personalized or customized documents.
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